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Subject Name: Introduction to Computer Applications 

   

Course Objective:    

This is a basic paper for Business Administration students to familiarize with basic 

principles of computer system including computer arithmetic, hardware, operating 

system, software applications, internet and world-wide web and their applications in the 

relevant fields.   

Course Learning Outcomes :  

After completing the course, the student shall be able to:   

   

Course Outcome   Cognitive level   

CO1-Define the concept of Computer Fundamentals.   

Remember   

CO2- Describe the conversion of one base to another base Number 

System.   Understand   

CO3- Explain the needs of hardware and software required for 

a computation task.   Understand   

CO4 - Demonstrate the use of Operating system.   Understand   

CO5 -Demonstrate how a document to be prepared and formatted.   

Understand   
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NOTES

COMPUTER 
FUNDAMENTALS

1.1 LEARNING OBJECTIVE

After completing this chapter, you will be able to:
•	 Understand the concepts of Computer.

•	 Understand characteristics of Computer.

•	 Learn and understand the generation of computers. 

•	 Understand the general classifications of computers. 

•	 Understand the structure of Computer. 

•	 Understand the concept of Operating System.

•	 Understand Different types of Processors.

•	 Understand the use of computers in business.

1.2 INTRODUCTION

Today, almost all of us in the world make use of computers in one way or the other. It finds 
applications in various fields of engineering, medicine, commercial, research and others. 
Not only in these sophisticated areas, but also in our daily lives, computers have become 
indispensable. They are present everywhere, in all the dev ices that we use daily like cars, 
games, washing machines, microwaves etc. and in day-to-day computations like banking, 
reservations, electronic mails, internet and many more.

The word computer is derived from the word compute. Compute means to calculate. 
The computer was originally defined as a super-fast calculator. It had the capacity to 
solve complex arithmetic and scientific problems at very high speed. But nowadays in 
addition to handling complex arithmetic computations, computers perform many other 
tasks like accepting, sorting, selecting, moving, comparing various types of information. 
They also perform arithmetic and logical operations on alphabetic, numeric and other 
types of information. This information provided by the user to the computer is data. The 
information in one form which is presented to the computer is the input information or 
input data.

1.3 COMPUTER DEFINITION

The word ‘computer’ literally means ‘something that computes’ or ‘calculates’ but 
considering a computer to be merely calculating devices would be to severely limit its 
power. It may be defined as a device that can act upon information or data. This is done 
through the execution of a program.

The dictionary definition of computer is:

“An automatic electronic apparatus for making calculations or controlling operations that 
is expansible in numerical or logical term.”
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NOTES

COMPUTER 
FUNDAMENTALS

1.4 CHARACTERISTICS OF COMPUTERS

•	 Speed: Internal process of computers operates at the speed of light, limited only 
by the programs that control this process, and the quantum of data under process. 
The speed with which computer performs it way beyond human capabilities to 
express it differently, a computer does in one minute what a human being could 
take a lifetime.

•	 Accuracy: The accuracy of a computer is consistently high. Errors can occur, but 
these are almost always due to human error rather than technological weakness. 
Imprecise thinking by the programmer, inaccurate data, or poorly designed 
systems is the origins of error. Computer error arising due to incorrect data input 
or unreliable programs are often referred to as GIGO (garbage- in — garbage 
-out).

•	 Diligence: The computer is a machine, that does not suffer from the human traits 
of tiredness. Nor does it lose concentration even after working continuously for a 
long time. This characteristic is especially useful for those jobs where a same task 
is done again and again. It can perform long and complex calculations with same 
speed and accuracy from the start till the end.

•	 Versatility: Versatility is one of the most wonderful things about computer. 
Multiprocessing features of computer makes it quite versatile in nature. One 
moment, it is preparing the results of particular examination, the next moment 
it is busy preparing electricity bills, and in-between it may be helping an office 
secretary to trace an important letter in seconds.

•	 It can perform different types of tasks with the same ease. Al! that is required to 
change its talent is to slip in a new program into it. Briefly, a computer is capable 
of performing almost any task provided that the task can be reduced to a series of 
logical steps.

•	 Storage: Large volumes of data and information can be stored in the computer 
and also retrieved whenever required. A limited amount of data can be stored, 
temporarily, in the primary memory. Secondary storage devices like floppy disk 
and compact disk can store a large amount of data permanently.

1.5 COMPUTER GENERATIONS (EVOLUTION OF COMPUTERS)
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NOTES The abacus was the earliest calculating machine probably originated in China about 3,000 
years ago. It is still widely used in Asia for primary education. The name abacus is derived 
from abax; Greek word for slab. It may be because the counting was once done with 
pebbles placed in a hollow in a slab. In China it is also known as Swan Pan. Abacus consists 
of a rectangular wooden frame with horizontal rods. Beads made of stones, pearls wood 
or ivory (having holes in it to pass through the rods), are placed in these rods. Counting is 
done by shifting the beads from one place to another. Ir is a hand-used device for addition 
and subtraction. The abacus consists of several columns, farthest to the right represents 
‘ones’, the next one tens, then the hundreds and so on.

Blaise Pascal was a French mathematician born on 19th June 1623 at Clermont-Ferrand. 
Auvergne. In 1642, when he was only 19 years old, he invented a calculating machine 
called Pascaline. It was the first mechanical digital calculator that could perform addition 
and subtraction on whole numbers. It had a system of interlocking rotating cog wheels. 
Each wheel had ten segments like in a millimeter. When one wheel completes a rotation, 
the next wheel moves by one segment. Numbers 0 to 9 are there on the circumference of 
the wheel. Pascal patented this machine in 1647, and produced it on a mass scale.

Later many attempts were made in this direction but the inventions of CHARLES 
BABBAGE, a professor at CAMBRIDGE UNIVERSITY, is worth mentioning. He is 
considered being father of modern digital computers. He designed two computers:

•	 The ‘Different Engine’ (1822) based on the mathematical principle of finite 
difference and used to solve calculations on large numbers. It was also used to 
solve trigonometric functions and polynomials.

•	 The ‘Analytical Engine’ (1842) a general-purpose computing device intended to 
be completely automatic. This could perform any mathematical operation and at 
a speed of 60 additions per minute.

LET US DISCUSS THE VARIOUS GENERATIONS OF THE COMPUTERS

FIRST GENERATION
The period of first generation was from 1946-1959. The computers of first generation 
used vacuum tubes as the basic components for memory and circuitry for CPU (Central 
Processing Unit). These tubes, like electric bulbs, produced a lot of heat and the installations COMPUTER 

FUNDAMENTALS
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NOTESused to fuse frequently. Therefore, they were very expensive and only large organizations 
were able to afford it.

In this generation, mainly batch processing operating system was used. Punch cards, paper 
tape, and magnetic tape was used as input and output devices. The computers in this 
generation used machine code as the programming language.

The main features of the first generation are: 
•	 Vacuum tube technology 

•	 Unreliable

•	 Supported machine language only 

•	 Very costly

•	 Generated a lot of heat 

•	 Slow input and output devices

•	 Huge size 

•	 Need of AC

•	 Consumed a lot of electricity

Charles Babbage a British mathematician at Cambridge University invented the first 
analytical engine or difference engine. This machine could be programmed by instructions 
coded on punch cards and had mechanical memory to store the results. For his contributions 
in this field Charles Babbage is known as ‘the father of modern digital computer’.

Some of the early computers included: 
Mark I – This was the first fully automatic calculating machine. It was designed by Howard 
Aiken of Harvard University in collaboration with IBM. This machine was an electronic 
relay computer. Electromagnetic signals were used for the movement of mechanical parts. 
Mark I could perform the basic arithmetic and complex equations. Although this machine 
was extremely reliable, it was very slow (it took about 3-5 seconds per calculation) and was 
complex in design and large in size.

Atanasoff-Berry Computer (ABC) – This computer developed by John Atanasoff and 
Clifford Berry was the world’s first general purpose electronic digital computer. It made use 
of vacuum tubes for internal logic and capacitors for storage. 

COMPUTER 
FUNDAMENTALS
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NOTES ENIAC (Electronic Numeric Integrator and Calculator) – The first all-electronic 
computer was produced by a partnership between the US Government and the University 
of Pennsylvania. It was built using 18,000 vacuum tubes, 70,000 resistors and 1,500 relays 
and consumed 160 kilowatts of electrical power. The ENIAC computed at speed about 
thousand times faster than Mark I. However, it could store and manipulate only a limited 
amount of data. Program modifications and detecting errors were also difficult.

EDVAC – In the mid 1940’s Dr. John von Neumann designed the Electronic Discrete 
Variable Automatic Computer with a memory to store both program and data. This 
was the first machine which used the stored program concept. It had five distinct units - 
arithmetic, central control, memory, input and output. The key element was the central 
control. All the functions of the computer were co-ordinate through this single source, the 
central control. The programming of the computers was done in machine language.

UNIVAC – Remington Rand designed this computer specifically for business data 
processing applications. The Universal Automatic Computer was the first general purpose 
commercially available computer.

SECOND GENERATION
The period of second generation was from 1959-1965. In this generation, transistors 
were used that were cheaper, consumed less power, more compact in size, more reliable 
and faster than the first-generation machines made of vacuum tubes. In this generation, 
magnetic cores were used as the primary memory and magnetic tape and magnetic 
disks as secondary storage devices. In this generation, assembly language and high-level 
programming languages like FORTRAN, COBOL were used. The computers used batch 
processing and multiprogramming operating system.

The first large scale machines that took advantage of the transistor technology were the early 
supercomputers, Stretch by IBM and LARC by Sperry Rand. These machines were mainly 
developed for atomic energy laboratories. Typical computers of the second generation were 
the IBM 1400 and 7000 series, Honeywell 200 and General Electric.

IBM 1401 was universally accepted throughout the industry and largest businesses routinely 
processed financial information using second generation computers. The machine language 
was replaced by assembly language. Thus, the long and difficult binary code was replaced 
with abbreviated programming code which was relatively easy to understand.

The stored program concept and programming languages gave the computers flexibility to 
finally be cost effective and productive for business use. The stored program concept implied 
that the instructions to run a computer for a specific task were held inside the computer’s 
memory and could quickly be modified or replaced by a different set of instructions for 
a different function. Computers started finding vast and varied applications. The entire 
software industry began with the second-generation computers.

The main features of second generation are:
•	 Use of transistors 

COMPUTER 
FUNDAMENTALS
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NOTES•	 Reliable in comparison to first generation computers 

•	 Smaller size as compared to first generation computers 

•	 Generated less heat as compared to first generation computers 

•	 Consumed less electricity as compared to first generation computers

•	 Faster than first generation computers

•	 Still very costly 

•	 AC required 

•	 Supported machine and assembly languages

Some computers of this generation were: 
•	 IBM 1620 

•	 IBM 7094 

•	 CDC 1604 

•	 CDC 3600 

•	 UNIVAC 1108

THIRD GENERATION 
The period of third generation was from 1965-1971. The computers of third generation 
used Integrated Circuits (ICs) in place of transistors. A single IC has many transistors, 
resistors, and capacitors along with the associated circuitry. The IC was invented by Jack 
Kilby. This development made computers smaller in size, reliable, and efficient. In this 
generation remote processing, time-sharing, multi-programming operating system were 
used. High-level languages (FORTRAN-II TO IV, COBOL, PASCAL PL/1, BASIC, 
ALGOL-68 etc.) were used during this generation.

The main features of third generation are: 
•	 IC used 

•	 More reliable in comparison to previous two generations 

•	 Smaller size 

•	 Generated less heat 

•	 Faster 

•	 Lesser maintenance

•	 Costly 

•	 AC required 

•	 Consumed lesser electricity 

•	 Supported high-level language

Some computers of this generation were: 
•	 IBM-360 series 

COMPUTER 
FUNDAMENTALS
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NOTES •	 Honeywell-6000 series 

•	 PDP (Personal Data Processor) 

•	 IBM-370/168 

•	 TDC-316

FOURTH GENERATION 
The period of fourth generation was from 1971-1980. Computers of fourth generation used 
Very Large Scale Integrated (VLSI) circuits. VLSI circuits having about 5000 transistors 
and other circuit elements with their associated circuits on a single chip made it possible 
to have microcomputers of fourth generation. Fourth generation computers became more 
powerful, compact, reliable, and affordable. As a result, it gave rise to Personal Computer 
(PC) revolution. In this generation, time-sharing, real-time networks, distributed operating 
system were used. All the high-level languages like C, C++, DBASE etc., were used in this 
generation.

The Intel 4004 chip, located all the components of a computer (central processing unit, 
memory, input and output controls) on a single chip and microcomputers were introduced. 
Higher capacity storage media like magnetic disks were developed. Fourth generation 
languages emerged and applications software’s started becoming popular.

Computer production became inexpensive and the era of Personal Introduction to 
Computer System/7 Computers (PCs) commenced. In 1981, IBM introduced its personal 
computer for use in office, home and schools. In direct competition, the Macintosh was 
introduced by Apple in 1984. Shared interactive systems and user-friendly environments 
were the features of these computers.

The main features of fourth generation are: 
•	 VLSI technology used 

•	 Very cheap 

•	 Portable and reliable

•	 Use of PCs 

•	 Very small size 

•	 Pipeline processing 

•	 No AC required 

•	 Concept of internet was introduced 

•	 Great developments in the fields of networks 

•	 Computers became easily available

Some computers of this generation were: 
•	 DEC 10 19

•	 STAR 1000 COMPUTER 
FUNDAMENTALS
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NOTES•	 PDP 11

•	 CRAY-1(Super Computer) 

•	 CRAY-X-MP (Super Computer)

FIFTH GENERATION
The period of fifth generation is 1980-till date. In the fifth generation, VLSI technology 
became ULSI (Ultra Large-Scale Integration) technology, resulting in the production of 
microprocessor chips having ten million electronic components. This generation is based 
on parallel processing hardware and AI (Artificial Intelligence) software. AI is an emerging 
branch in computer science, which interprets the means and method of making computers 
think like human beings. All the high-level languages like C and C++, Java, .Net etc., are 
used in this generation.

AI includes: 
•	 Robotics 

•	 Neural Networks 

•	 Game Playing 

•	 Development of expert systems to make decisions in real-life situations 

•	 Natural language understanding and generation

The main features of fifth generation:
•	 Development of true artificial intelligence 

•	 Development of Natural language processing 

•	 Advancement in Parallel Processing 

•	 Advancement in Superconductor technology 

•	 More user-friendly interfaces with multimedia features 

•	 Availability of very powerful and compact computers at cheaper rates

Some computer types of this generation are:
•	 Desktop 

•	 Laptop 

•	 Notebook

•	 Ultra-Book

•	 Chrome Book

1.6 TYPES OF COMPUTERS

Minicomputer
A minicomputer is a type of computer that possesses most of the features and capabilities 
of a large computer but is smaller in physical size.

COMPUTER 
FUNDAMENTALS
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NOTES A minicomputer fills the space between the mainframe and microcomputer, and is smaller 
than the former but larger than the latter. Minicomputers are mainly used as small or mid-
range servers operating business and scientific applications. However, the use of the term 
minicomputer has diminished and has merged with servers.

A minicomputer may also be called a mid-range computer.

  

Microcomputer
A microcomputer is a complete computer on a smaller scale and is generally a synonym for 
the more common term, personal computer or PC, a computer designed for an individual. 
A microcomputer contains a microprocessor (a central processing unit on a microchip), 
memory in the form of read-only memory and random access memory, I/O ports and a bus 
or system of interconnecting wires, housed in a unit that is usually called a motherboard.

Mainframe Computer
A data processing system employed mainly in large organizations for various applications, 
including bulk data processing, process control, industry and consumer statistics, enterprise 
resource planning, and financial transaction processing.

COMPUTER 
FUNDAMENTALS
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NOTESMainframes use proprietary operating systems, most of which are based on Unix, and a 
growing number on Linux. Over the years, they have evolved from being room-sized to 
networked configurations of workstations and servers that are an extremely competitive 
and cost-effective platform for e-commerce development and hosting. Mainframes are so 
called because the earliest ones were housed in large metal frames.

Supercomputer
The term is commonly applied to the fastest high-performance systems available at a given 
time; current personal computers are more powerful than the supercomputers of just a 
few years ago. Supercomputers are used primarily for scientific and engineering work. 
Unlike conventional computers, they usually have more than one CPU, often functioning 
in parallel (simultaneously); even higher-performance supercomputers are now being 
developed through use of massively parallel processing, incorporating thousands of 
individual processors. Supercomputers have huge storage capacity and very fast input/
output capability, and can operate in parallel on corresponding elements of arrays of 
numbers rather than on one pair of elements at a time.

COMPUTER 
FUNDAMENTALS
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NOTES

 

CHECK YOUR PROGRESS

1. 	 What is Computer? Discuss the Characteristics of Computer.
2. 	 Discuss about second generation computers.
3. 	 Discuss about third generation computers.
4. 	 Discuss about different types of computers.
5. 	 List various features of third and fourth generation computers.

1.7 COMPUTER STRUCTURE (BASIC ANATOMY OF THE 
COMPUTER)

We should keep in mind that a computer is a programmable machine. 

The two main characteristics of a computer are:
•	 It responds to a specific set of instructions in a well-defined manner

•	 It can execute a pre-recorded list of instructions (a program). Modern computers 
are electronic and digital.

The actual machinery - wires, transistors and circuits is called hardware; the instructions 
and data are called software.

All general purpose computers require the following hardware components:

COMPUTER 
FUNDAMENTALS
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NOTES

Basic Computer Organisation 

•	 Central Processing Unit (CPU): The ‘brain’ of the computer, the component that 
actually executes instructions.

•	 Memory: It enables a computer to store, at least temporarily, data and programs.

•	 Input device: Usually a keyboard or mouse is used to read data and programs into 
the computer.

•	 Output device: A display screen, printer, etc., that lets you see what the computer 
has accomplished.

•	 Mass storage device: It allows a computer to permanently store large amounts of 
data. Common mass storage devices include disk drive and tape drive.

In addition to these components, many others make it possible for the basic components 
of a computer to work together efficiently.

Input Unit
An input device is any device that provides input to a computer. There are dozens of 
possible input devices, but the two most common ones are a keyboard and mouse. Every 
key you press on the keyboard and every movement or click you make with the mouse sends 
a specific input signal to the computer. These commands allow you to open programs, type 
messages, drag objects, and perform many other functions on your computer.

Since the job of a computer is primarily to process input, computers are pretty useless 
without input devices. Just imagine how much fun you would have using your computer 
without a keyboard or mouse. Therefore, input devices are a vital part of every computer 
system. COMPUTER 

FUNDAMENTALS
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NOTES While most computers come with a keyboard and mouse, other input devices may also 
be used to send information to the computer. Some examples include joysticks, MIDI 
keyboards, microphones, scanners, digital cameras, webcams, card readers, UPC scanners, 
and scientific measuring equipment. All these devices send information to the computer 
and therefore, are categorized as input devices. Peripherals that output data from the 
computer are called output devices.

Arithmetic Logic Unit (ALU)
After input unit transfers the information into the memory unit the information can then 
be further transferred to the ALU where comparisons or calculations are done and result 
sent back to memory unit.

Since all data and instruction are represented in numeric form, ALUs are designed to 
perform the four basic arithmetic operations: add, subtract, multiply, divide, and logical 
operations such as equal to, less than, greater than.

Output Unit
Since computers work with binary code, the result produced is also in binary form. The 
basic function of the output unit therefore is to convert these results into human readable 
form before providing the output through various output devices like terminals, printers 
etc.

Control Unit
It is the function of the control unit to ensure that according to the stored instructions, the 
right operation is done on the right data at the right time. It is the control unit that obtains 
instructions from the program stored in the main memory, interprets them, and ensure 
that other units of the system execute them in the desired order.

Central Processing Unit
The control unit, arithmetic Logic Unit along with the main memory are together known 
as Central Processing Unit (CPU). It is the brain of any computer system.

Secondary Storage
The storage capacity of the primary memory of computer is limited. Often, it is necessary 
to store large amounts of data. So traditional memory called secondary storage or auxiliary 
memory is used in most computer system.

Input Devices
An input device is any hardware device that sends data to the computer, without any input 
devices, a computer would only be a display device and not allow users to interact with 
it, much like a TV. The picture is a Logitech trackball mouse and an example of an input 
device.

COMPUTER 
FUNDAMENTALS
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NOTESKeyboard
Most common and very popular input device is keyboard. The keyboard helps in inputting 
the data to the computer. The layout of the keyboard is like that ol traditional typewriter, 
although there are some additional keys provided for performing some additional functions.

Keyboards are of two sizes 84 keys or 101/102 keys, but now 104 keys or 108 keys keyboard 
is also available for Windows and Internet.

The keys are following

S. No. Keys Description
1 Typing Keys These keys include the letter keys (A-Z) and digits keys (0-

9) which generally give same layout as that of typewriters.
2 Numeric 

Keypad
It is used to enter numeric data or cursor movement. 
Generally, it consists of a set of 17 keys that are laid out in 
the same configuration used by most adding machine and 
calculators.

3 Function Keys The twelve functions keys are present on the keyboard. 
These are arranged in a row along the top of the keyboard. 
Each function key has unique meaning and is used for 
some specific purpose.

4 Control keys These keys provide cursor and screen control. It includes 
four directional arrow key. Control keys also include Home, 
End, Insert, Delete, Page Up, Page Down, Control (Ctrl), 
Alternate (Alt), Escape (Esc).

5

Special Purpose 
Keys

Keyboard also contains some special purpose keys such as 
Enter, Shift, Caps Lock, Num Lock, Space bar, Tab, and 
Print Screen.

Mouse
Mouse is most popular pointing device. It is a very famous cursor-control device. It is a 
small palm size box with a round ball at its base which senses the movement of mouse and 
sends corresponding signals to CPU on pressing the buttons.

Generally, it has two buttons called left and right button and scroll bar is present at the 
mid. Mouse can be used to control the position of cursor on screen, but it cannot be used 
to enter text into the computer.

COMPUTER 
FUNDAMENTALS
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NOTES Advantages
•	 Easy to use

•	 Not very expensive

•	 Moves the cursor faster than the arrow keys of keyboard.

Joystick
Joystick is also a pointing device, which is used to move cursor position on a monitor 
screen. It is a stick having a spherical ball at its both lower and upper ends. The lower 
spherical ball moves in a socket. The joystick can be moved in all four directions. The 
function of joystick is similar to that of a mouse. It is mainly used in Computer Aided 
Designing (CAD) and playing computer games.

Light pen
Light pen is a pointing device, which is similar to a pen. It is used to select a displayed 
menu item or draw pictures on the monitor screen. It consists of a photocell and an optical 
system placed in a small tube.

When light pen’s tip is moved over the monitor screen and pen button is pressed, its 
photocell sensing element detects the screen location and sends the corresponding signal 
to the CPU.

Track Ball
Track ball is an input device that is mostly used in notebook or laptop computer, instead 
of a mouse. This is a ball, which is half inserted and by moving fingers on ball, pointer can 
be moved.

Since the whole device is not moved, a track ball requires less space than a mouse. A track 
ball comes in various shapes like a ball, a button and a square.COMPUTER 

FUNDAMENTALS
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NOTES

Scanner
Scanner is an input device, which works more like a photocopy machine. It is used when 
some information is available on a paper and it is to be transferred to the hard disc of the 
computer for further manipulation.

Scanner captures images from the source which are then converted into the digital form 
that can be stored on the disc. These images can be edited before they are printed.

Optical Mark Reader (OMR)
OMR is a special type of optical scanner used to recognize the type of mark made by pen 
or pencil. It is used where one out of a few alternatives is to be selected and marked. It 
is specially used for checking the answer sheets of examinations having multiple choice 
questions.

Optical Character Reader(OCR)
OCR is an input device used to read a printed text. OCR scans text optically character by 
character, converts them into a machine readable code and stores the text on the system 
memory.

COMPUTER 
FUNDAMENTALS
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Magnetic Ink Card Reader (MICR)
MICR input device is generally used in banks because of a large number of cheques to 
be processed every day. The bank’s code number and cheque number are printed on the 
cheques with a special type of ink that contains particles of magnetic material that are 
machine readable.

This reading process is called Magnetic Ink Character Recognition (MICR). The main 
advantage of MICR is that it is fast and less error prone.

OUTPUT DEVICES

Cathode-Ray Tube (CRT) Monitor
In the CRT, display is made up of small picture elements called pixels for short. The smaller 
the pixels, the better the image clarity or resolution. It takes more than one illuminated 
pixel to form whole character, such as the letter ‘e’ in the word help.

A finite number of characters can be displayed on a screen at once. The screen can be 
divided into a series of character boxes - fixed location on the screen where a standard 
character can be placed.

Most screens are capable of displaying 80 characters of data horizontally and 25 lines 
vertically. 

There are some disadvantages of CRT:
•	 Large in Size

•	 High power consumption

Monitors
Monitor commonly called as Visual Display Unit (VDU) the main output device of a 
computer. It forms images from the dots, called pixels that are arranged in a rectangular 
form. T sharpness of the image depends upon the number of the pixels.
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There are two kinds of viewing screen used for monitors:
•	 Cathode-Ray Tube (CRT)

•	 Flat-Panel Display

Flat-Panel Display Monitor
The flat-panel display refers to a class of video devices that have reduced volume, weight 
and power requirement compared to the CRT. You can hang them on walls or wear them on 
your wrists. Current uses for flat-panel displays include calculators, video games, monitors, 
laptop computer, graphics display.

The flat-panel displays are divided into two categories:
•	 Emissive Displays: The emissive displays are devices that convert electrical energy 

into light. Examples are plasma panel and LED (Light- Emitting Diodes).

•	 Non-emissive Displays: The Non-emissive displays use optical effects to convert 
sunlight or light from some other source into graphics patterns. Example is LCD 
(Liquid-Crystal Device)

Printers
Printer is the most important output device, which is used to print information on pa-
per. There are two types of printers:

•	 Impact Printers

•	 Non-Impact Printers
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NOTES Impact Printers
The printers that print the characters by striking against the ribbon and onto the paper, 
are called impact printers.

Characteristics of Impact Printers are the following:
•	 Very low consumable costs

•	 Impact printers are very noisy

•	 Useful for bulk printing due to low cost

•	 There is physical contact with the paper to produce an image

These printers are of two types:
•	 Character printers

•	 Line printer

Non-impact Printers
The printers that print the characters without striking against the ribbon and onto the 
paper are called Non-Impact Printers. These printers print a complete page at a time, also 
called as Page Printers.

These printers are of two types:
•	 Laser Printers

•	 Inkjet Printers

Characteristics of Non-impact Printers:
•	 Faster than impact printers.

•	 They are not noisy.

•	 High quality.

•	 Supports many fonts and different character sizes.

Character Printers
Character Printers are printers, which print one character at a time.

These are of further two types:
•	 Dot Matrix Printer (DMP)

•	 Daisy Wheel

Dot Matrix Printer
In the market, one of the most popular printers is Dot Matrix Printer because of their ease 
of printing features and economical price. Each character printed is in form of pattern of 
Dot’s and head consists of a Matrix of Pins of size (5 x 7, 7 x 9, 9 * 7 or 9 x 9) which comes 
out to form a character that is why it is called Dot Matrix Printer.
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NOTESInkjet Printers
Inkjet printers are non-impact character printers based on a relatively new technology. 
They print characters by spraying small drops of ink onto paper. Inkjet printers produce 
high quality output with presentable features.

They make less noise because no hammering is done and these have many styles of printing 
modes available. Colour printing is also possible. Some models of Inkjet printers can 
produce multiple copies of printing also.

Advantages
•	 High quality printing

•	 More reliable

Disadvantages
•	 Expensive as cost per page is high

•	 Slow as compared to laser printer

Laser Printers
These are non-impact page printers. They use laser lights to produce the dots needed to 
form the characters to be printed on a page.
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NOTES Advantages
•	 Very high speed.

•	 Very high-quality output.

•	 Gives good graphics quality.

•	 Supports many fonts and different character sizes.

Disadvantage
•	 Expensive.

•	 Cannot be used to produce multiple copies of a document in a single printing.

Computer Output Microfilm (COM)
Computer output microfilm or “COM” is a process for copying and printing data onto 
microfilm from electronic media found on personal, mini, or mainframe computers.

COM consists of: 1) A high-speed recorder that transfers digital data onto microfilm using 
laser technology; and 2) A processor that develops the microfilm once exposed to a light 
source. A 

COM recorder can operate “online” or “offline,” meaning that it can be connected to 
a single computer, a local area network, a minicomputer, or a mainframe computer. In 
addition, the recorder can operate independently as a stand-alone device that reads digital 
data from formatted magnetic media, such as tape. 

A COM recorder generally operates with: 
•	 A duplicator that generates copies of microfiche; and 

•	 A sorter that separates duplicate microfiche cards into bins for easy, end-point 
distribution.

Each functional unit is connected to the next, providing a linear path from creation to 
endpoint distribution of the microfiche.

COM offers many advantages that assist agencies with efficient office operations and 
adherence to sound records management principles. Key benefits include:

•	 Reduction of Paper: One of the primary objectives of providing COM is to 
decrease paper use as allowed by Public Law 40 - 1979, Section 16, which authorizes 
recording, copying, and reproducing records by photo static, photographic, or 
micrographic process to reduce storage space. A one-cubic-foot box of paper records 
holds an average of only 3,000 pages. One microfiche card holds 230 documents 
(or images), and a one-cubic-foot records storage box holds 6,000 microfiches 
cards-a minimum of 1,380,000 pages. To store that many paper documents, 460 
one-cubic-foot records storage boxes would be needed.

•	 Cost Reduction: Using COM to store or distribute information is more economical 
than most electronic media, and is even less expensive than paper. The cost of 
printing a standard 8”x l1” page from a centralized printer is approximately three COMPUTER 
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NOTEScents per sheet, versus only 0.0033 cents per sheet for COM microfiche. Other 
cost savings can be realized through the decrease in office and warehouse spaces 
needed to store paper documents.

•	 Improved Quality: The newest COM technology provides superior image quality 
for improved user productivity. Such features as enhanced titling, enlarged file 
breaks, and bar coding make access and filing easier. Improved quality also means 
reader and printer copies that are legible.

•	 Improved Service: The use of COM services outsourced by MIS helps reduce the 
risk of lost tapes and slow turn-around times from individually-contracted vendors, 
thereby offering agencies quick access to high-quality microfilm images. Initial 
transfer of information from the agency to the Micrographics lab is also simple 
and quick: database (ASCII or EBCIDIC) or image (TIFF Group IV) files may 
be sent directly from your agency’s computers to the Micrographics FTP site for 
transfer to fiche. Contact the Micrographics lab for specific filetype requirements 
and FTP address.

•	 Electronic Record Retention/Archiving: With the proliferation of electronic 
records, and with few rules governing the purchase and use of imaging systems, 
it is vitally important that state agencies have the means to archive records from a 
variety of electronic sources. Using COM, electronic records can be moved from 
diverse, incompatible electronic storage systems to a ‘‘universal” reader.

Voice Response System
Voice response system enables the computer to talk to its user. It consists of audio-response 
devices that produce the audio output Voice response system is typically of two types: voice 
reproduction system and speech synthesizer.

•	 Voice reproduction system: A voice reproduction system produces audio output by 
selecting an appropriate audio output from a set of pre-recorded audio responses. 
The set of pre-recorded responses include words, phrases or sentences spoken by 
human beings, music or alarms generated by musical instruments.

The application of voice reproduction system are:
1.	 	Audio help for guiding how to operate a system. For example, bank uses voice 

reproduction system in ATM (automatic teller machines) to guide customers 
about transactions.

2.	 	Automatic answering machines. For example, telephone enquiries for new 
telephone numbers in place of an old number or vacancy status of a particular 
flight or train is taken care by automatic answering machines.

•	 Speech synthesizer: A speech access system converts text to spoken words. 
The system consists of a synthesizer that does the speaking and the screen ac-
cess program that directs the synthesizer. Some synthesizers and speech access 
program are linked and sold as a package, while others are sold independently. COMPUTER 
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NOTES Screen Image Projector
Screen image projector is an output device, which is used to project information from a 
computer on to a large screen, so that it can be simultaneously viewed by a large group of 
people. This output device is very useful for making presentations to a group of people with 
the direct use of a computer. Before such an output device was available, the contents of a 
presentation were prepared using a computer, the presentation material was then printed 
on a printer, the printout was next reproduced on overhead projector transparency sheets 
by using a copy machine, and finally, the presentation was made by using an overhead 
projector. Special marker pens had to be used for marking certain portions of the contents 
on the transparency sheets during the presentation.

A screen image projector greatly simplifies this job. It can be directly plugged to a computer 
system, and the presenter can make a presentation to a group of people by projecting 
the presentation material one after another on a large screen with the help of computer’s 
keyboard or mouse. With this facility, the presenter can also directly point to mark or 
edit certain portions of the contents of the displayed material during the presentation 
to make the presentation more understandable. Additionally, a fully-fledged multimedia 
presentation with audio, video, image and animation can be prepared and made by using 
this facility to make the presentation livelier and more interesting, and also greatly simplify 
the job of the presenter.

Screen image projectors have become common presentation equipment today. They are 
commonly used with portable notebook computers to quickly setup a modem presentation 
facility at any place with great ease. Like monitors, screen image projectors provide a 
temporary, soft-copy output.

Voice Response System
Voice response system enables the computer to talk to its user. It consists of audio-response 
devices that produce the audio output Voice response system is typically of two types: voice 
reproduction system and speech synthesizer.

•	 Voice reproduction system: A voice reproduction system produces audio output by 
selecting an appropriate audio output from a set of pre-recorded audio responses. 
The set of pre-recorded responses include words, phrases or sentences spoken by 
human beings, music or alarms generated by musical instruments.
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NOTESThe application of voice reproduction system is:
1.	 Audio help for guiding how to operate a system. For example, bank uses voice 

reproduction system in ATM (automatic teller machines) to guide customers 
about transactions.

2.	 Automatic answering machines. For example, telephone enquiries for new 
telephone numbers in place of an old number or vacancy status of a particular 
flight or train is taken care by automatic answering machines.

•	 Speech synthesizer: A speech access system converts text to spoken words. 
The system consists of a synthesizer that does the speaking and the screen ac-
cess program that directs the synthesizer. Some synthesizers and speech access 
program are linked and sold as a package, while others are sold independently.

SOFTWARE CONCEPTS

Computer Software
Today’s computer is highly versatile tools across a myriad disciplines and usages. They 
can perform varied tasks, from correspondence to maintaining inventory information to 
creating drawings and illustration and many more. The least is most never-ending. The 
most important thing to understand is that the computer hardware itself cannot perform 
this task. It requires instructions to successfully carry out this task. In fact computer 
hardware is useless without programs or software. Let us is therefore distinguish between 
this two commonly used terms, hardware and software.

Relationship between Hardware and Software
Hardware constitutes the electronic circuits used in building the computer. The electronic, 
magnetic, and mechanical device together is referred to as computer hardware. Software, 
on the other hand, is the name given to set of instructions, or program to be executed by 
the computer. It is the hardware that executes the software. To take an analogy, a television 
set bought from the shop is hardware and the various entertainment program it receives, is 
its software. Thus, while hardware is necessary, software is vital. An important point that 
is brought out from the analogy is that hardware is a onetime expense while software is an 
on-going expense.

Computer software can be classified into two broad categories: system software, and 
application software:

•	 System software: System software includes general program written for the 
system that provide the environment to facilitate the writing of application 
software. System software is therefore the stuff that makes your computer work. 
The computer’s basic operating system, whether it is Window 2000 on the PC or 
UNIX on as an HP server, all form a part of system software.

•	 Application software: Application software or programs or programs designed 
to perform specific functions directly for the use or, in some case, for another 
application program.
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NOTES Some High-Level Languages
FORTRAN: Early computers were almost exclusively used by scientists. The first high- 
level language, FORTRAN was developed in 1956 by John Backus at IBM. This language 
was designed to solve scientific and engineering problem and is still one of the most popular 
languages for such applications.

COBOL: Cobol, the first languages intended for commercial applications, was developed 
by a committee of computer manufacturers and users under the leadership of Grace 
Hopper, a US Navy programmer, in 1959. The maintenance and further growth of the 
languages was handed over to a group called CODASYL.

BASIC: Basic was developed by two Dartmouth College Professors, John Kemeny 
and Thomas Kurtz, as a teaching tool for undergraduates in 1966. This language was 
primarily designed for beginners and is very easy to learn. It was immediately picked up 
for most business and general purpose application, particularly on small computer, BASIC 
subsequently became the primary language of the personal computer revolution.

PASCAL: Pascal was designed by a Nicholas Wirth, a Swiss Professor, in 1971. He 
developed a more structured language for teaching that he named Pascal. His primary aim 
was to provide a language that supported beginners learning good program solving the 
programming techniques.

ADA: PL/1, developed in the late 1960s by IBM, and ADA, developed in 1981 by the US 
Dept, of Defence, was for both business and scientific use.

LISP: LISP was developed by John McCarthy at the Massachusetts Institute of Technology 
in the early 1950s. It was implemented in 1959, and was a program that handled recursive 
algorithms better. It has become the standard languages for the artificial intelligence 
community.

1.8 OPERATING SYSTEM

An Operating System is a set of programs that controls and coordinates the use of computer 
hardware among various application programs. It provides an environment within which 
user can execute programs. A computer can be divided into four components: the hardware, 
the operating system, the applications programs, the users. It is the operating system that 
manages all the above components. 

The various functions of the operating system are:
•	 Controlling Input/Output devices (Keyboard, Mouse, Monitor, Printer, Plotter 

etc...)

•	 Memory and File storage management

•	 CPU Scheduling and controlling processes

•	 Loading, initiating, executing and supervising user applications programs

•	 Handling errors and restarting
COMPUTER 

FUNDAMENTALS



31Introduction to Computers

NOTES•	 Providing command interface between user and computer system

Examples of Operating system are: UNIX (Solaris, IRIX, HP UNIX, Linux, DEC UNIX) 
Microsoft Disk Operating System (MS-DOS), W1N95/98, WIN NT, OS/2 etc.

MS-DOS
Microsoft Disk Operating system is a single user, single tasking operating system. DOS 
has a command-line, text-based/ non-graphical user-interface commonly referred to 
as Character Based User Interface (CUI). When the computer is switched on, a small 
program checks all internal devices, electronic memory and peripherals. Once this process 
is completed, MS-DOS is loaded.

Introduction to Window
Though UNIX was a powerful operating system available, but it was not suitable for 8-bit 
8086 microprocessor based Personal Computers. So there was a need for a small operating 
system that could work in 640K memory (RAM). DOS was a variant of CP/M (Control 
Program/Monitor) which ran for the first time on IBM-PC in 1981. It is called so because 
it resides on Floppy or Hard disk and provides command level interface between user and 
the computer hardware. The different versions of MS-DOS have evolved over a period of 
time with Microsoft introducing new features in each new release. Starting with MS-DOS 
1.1, the latest version was MS-DOS6.22 released in 1994. There are various versions of 
DOS like MS-DOS (Microsoft), TO-DOS (IBM), Apple DOS etc.

WINDOWS was similar to APPLE Mach operating system interface on IBM-PC. The 
main features of Windows are easy to use graphical user interface (GUI), device independent 
graphics and multitasking support. The first version of Windows 1.0 was introduced in 
1985. Windows was an application of MS-DOS using the basic commands of DOS. 
Windows for Workgroup (W1N3.11) released in 1992 was an integrated windows and 
networking package with file and printer sharing capabilities, a network mail (Microsoft 
Mail) and a workgroup scheduler (Schedule^) package in windows environment. 
WINDOWS-95 released in 1995 is a 32-bit operating system which includes MS-DOS7.0 
and takes control of computer system after starting.

Windows-95
The most visible change in Windows 95 over earlier versions of Windows is the new user 
interface. The full screen display you see when you boot your PC and from which you 
work with documents and applications:

Icon: An icon is a picture. Windows 95 uses small video icons that represent objects - 
documents, applications, folder, devices, and computers. An icon has a text label that 
further describes the object.

Selection: Selecting an object is pointing to it without taking any further action. To select 
the object, move the mouse cursor onto the icon and press the left mouse button once. If 
the currently selected object is in a group, you can change the selected object with arrow 
keys. You can change groups with Tab and Shift- Tab keys and then use arrow keys to select 
an object in the selected group.
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NOTES Drag and Drop: To drag and drop an object onto another object, move the mouse cursor 
onto the icon of the object to be dragged. Press down the left mouse button and hold it 
down while you move mouse cursor to be destination object’s icon. Release the button 
from that position to complete the drop.

The Right Mouse Button: If you move the mouse to almost anywhere or anything on the 
desktop or in a Window and click the right mouse button, Windows 95 displays a menu 
with common commands for the object. To close the menu, click the left mouse button 
anywhere else on the desktop or press the keyboard’s Esc key.

Icons on the Desktop: The upper left corner contain four icons. Those icons provide 
access to your files and documents. Four icons are: My Computer, Network Neighborhood, 
Recycle Bin and Briefcase.

My Computer: The “My Computer” icon on the desktops opens a view into the resources 
of the local computer. The contents of my computer Window depend on the disk drives 
on your PC and the network support that is installed.

Network Neighborhood: This icon displays the computers and shared printers connected 
on the windows network.

Recycle Bin: This icon receives all deleted objects like files, folders, documents, applications, 
etc. These deleted objects can be retrieved back by dragging it out of the recycle bin and 
dropping it onto the desktop or into a folder or they can be permanently deleted from the 
disk by choosing EMPTY RECYCLE BIN selection on the file menu.

Briefcase: The commonly used personal documents can be put or stored in the briefcase. 
This briefcase can be moved to a disk or copied across a network.

Putting new objects on the desktop: new objects can be added to the desktop by dragging 
and dropping them from other locations or creating them on the desktop.

Windows NT
Windows NT is a family of operating systems produced by Microsoft, the first version of 
which was released in July 1993. It was a powerful high-level-language-based, processor-
independent, multiprocessing, multiuser operating system with features comparable to 
UNIX. It was intended to complement consumer versions of Windows that were based 
on MS-DOS. NT was the first fully 32- bit version of Windows, whereas it’s consumer-
oriented counterparts, Windows 3. lx and Windows 9x, were 16-bit/32-bit hybrids. 
Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Windows Home 
Server, Windows Server 2008, and Windows 7 are based on Windows NT, although they 
are not branded as Windows NT.

Windows 2000

There are four versions of Windows 2000:
•	 Professional: An operating system for business desktop and laptop systems. It is COMPUTER 

FUNDAMENTALS



33Introduction to Computers

NOTESused to run software applications, connect to Internet and intranet sites, and access 
files, printers, and network resources.

•	 Server: Both a Web server and an office server. Windows 2000 Server lets users 
build Web applications and connect to the Internet.

•	 Advanced Server: An operating for line-of-business applications and e-commerce. 
It contains all the functionality of the standard version of Windows 2000 Server, 
plus additional features for applications that require higher levels of scalability and 
availability.

•	 Datacenter Server: Developed to work in high-traffic computer networks, it is 
designed for enterprises that need reliable high-end drivers and software. It supports 
up to 64-way SMP and up to 64 GB of physical memory.

UNIX
UNIX is a family of operating systems designed to run in a mainframe environment. 
There has been some effort to make UNIX work on PCs, but for the most part it remains 
the domain of large business system. It has numerous user interfaces which tend to 
range from user hostile to badly outdated, but it works very, very effectively for server 
application. 

LINUX
LINUX is the most popular attempt to create a Unix-like operating system for personal 
computers. Unit recently, Linux also had all of the limitations of UNIX; with the so! 
benefit that you could run it on an Intel based PC. This is one benefit has created an 
environment where pretty much anybody can write software for it, and they have. On the 
good side, both the operating system and most of the application for it are entirely free.

Supporting Utilities

Backup
Backing up is a crucial process that everyone should do in order to have a fail-safe, for 
when the inevitable happens. The principle is to make copies of particular data in order to 
use those copies for restoring the information ii a failure occurs (a data loss event due to 
deletion, corruption, theft, viruses, etc.).

You can perform the backup manually by copying the data to a different location, or 
automatically using a backup program. Backup4all is such a program and you can easily 
download below (opens in new Window so you can still continue reading the article):

Each program has its own approach in executing the backup, but there are four common 
backup types implemented and generally used in most of these programs: full backup, 
differential backup, incremental backup and mirror backup. A type of backup actually 
defines how data is copied from source to destination and lays the grounds of a data 
repository model (how the backup is stored and structured).
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NOTES The image below provides an overview comparison between these backup types, for 
detailed information about each read the rest of the article:

Full Backup

Backup Type Data Backed Up Backup Time Restore Time Storage Space

Full backup All data Slowest Fast High

Incremental 
backup*

Only new/
modified files/
folders

Fast Moderate Lowest

Differential 
backup

All data since last 
full

Moderate Fast Moderate

Mirror backup
Only new/
modified files/
folders

Fastest Fastest Highest

Full backup is the starting point for all other types of backup and contains all the data in 
the folders and files that are selected to be backed up. Because full backup stores all files 
and folders, frequent full backups result in faster and simpler restore operations. Remember 
that when you choose other backup types, restore jobs may take longer. As an example, for 
a full backup job that runs four times the representation below is conclusive on how the 
backed-up data will grow with every run:

Full backup 4

Note: Full back up will always backup the entire source data. If you don’t delete/exclude 
sources (only add/modify) it will always grow in size because it backs up everything.COMPUTER 
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NOTESDifferential Backup
Differential backup contains all files that have changed since the last FULL backup. The 
advantage of a differential backup is that it shortens restore time compared to a full backup 
or an incremental backup. However, if you perform the differential backup too many 
times, the size of the differential backup might grow to be larger than the baseline full 
backup. In the image below you can see an example of how a differential backup would 
look like for a backup job that runs four times:

Note: Each differential backup includes all new/modified files since the last full backup.

Incremental Backup
Incremental backup stores all files that have changed since the last FULL, DIFFERENTIAL 
OR NCREMENTAL backup. The advantage of an incremental backup is that it takes the 
least time to complete. However, during a restore operation, each incremental backup 
must be processed, which could result in a lengthy restore job. The representation below 
shows how a backup job running four times would look like when using incremental:

Mirror Backup

Mirror backup is identical to a full backup, with the exception that the files are not 
compressed in zip files and they cannot be protected with a password. A mirror backup 
is most frequently used to create an exact copy of the source data. It has the benefit that 
the backup files can also be readily accessed using tools like Windows Explorer. The image 
below shows how a mirror backup job would look after four iterations (first mirror will 
back up everything, subsequent fast mirror backups will back up only new/modified files):

Antivirus
An antivirus program is designed to protect your computer from possible virus infections. 
Since most viruses are designed to run in the background, most users do not know when COMPUTER 
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NOTES their computer is infected. Virus protection programs serve to search for, detect, and 
remove these viruses. Antivirus programs must be kept up to date in order for them to 
be able to detect new viruses. So, downloading the program once and never getting the 
updates will leave you unprotected.

A virus is a program that replicates itself. It is usually spread by attaching itself to other 
files and programs. You can get a virus through an e-mail attachment, floppy diskettes, 
downloads, etc. All viruses are different. They can lay dormant for a while and then attack 
your machine or they can immediately begin causing problems as soon as your computer 
is infected.

Firewall
A firewall is software or hardware that checks information coming from the Internet or a 
network, and then either blocks it ot allows it to pass through to your computer, depending 
on your firewall settings.

A firewall can help prevent hackers or malicious software (such as worms) from gaining 
access to your computer through a network or the Internet. A firewall can also help stop 
your computer from sending malicious software to other computers. The following 
illustration shows how a firewall works. Just as a brick wall can create a physical barrier, a 
firewall creates a barrier between the Internet and your computer. A firewall is not the same 
thing as an antivirus program. To help protect your computer, you need both a firewall and 
an antivirus and anti-malware program.

Screen Savers
A screen saver is an animated image that is activated on a personal computer display when 
no user activity has been sensed for a certain time. The original purpose of a screen saver 
was to prevent burn-in (the burning of an image into the phosphor inside the cathode 
ray tube after hours of the same image being rescanned). In fact, today’s CRT display 
technology makes burn-in unlikely except under extreme conditions. (On larger displays 
used for room presentations, burn-in is still a possibility.)

Windows comes with built-in screen savers that you can select. If you purchase your 
computer with the operating system already installed, a screen saver may have been selected 
for you. You can set the screen saver using the task bar by selecting Start, then Settings, 
then Control Panel, then Display, and then Screen Saver, which lets you select one of the 
provided screen savers or one you have added to the Windows screen saver directory. The 
Mac also lets you set up a screen saver.

Spy ware
Any software that covertly gathers user’s information through the user’s Internet connection 
without his or her knowledge, usually for advertising purposes. Spyware applications are 
typically bundled as a hidden component of freeware or shareware programs that can be 
downloaded from the Internet; however, it should be noted that the majority of shareware 
and freeware applications do not come with spyware. Once installed, the spyware monitors COMPUTER 
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NOTESuser activity on the Internet and transmits that information in the background to someone 
else. Spyware can also gather information about e-mail addresses and even passwords and 
credit card numbers.

Spyware is similar to a Trojan horse in that users unwittingly install the product when 
they install something else. A common way to become a victim of spyware is to download 
certain peer-to-peer file swapping products that are available today.

Aside from the questions of ethics and privacy, spyware steals from the user by using the 
computer’s memory resources and also by eating bandwidth as it sends information back 
to the spyware’s home base via the user’s Internet connection. Because spyware is using 
memory and system resources, the applications running in the background can lead to 
system crashes or general system instability.

Software Licence
Allowing an individual or group to use a piece of software. Nearly all applications are 
licensed rather than sold. There are a variety of different types of software licenses. Some 
are based on the number machines on which the licensed program can run whereas others 
are based on the number of users that can use the program. Most personal computer 
software licenses allow you to run the program on only one machine and to make copies 
of the software only for backup purposes. Some licenses also allow you to run the program 
on different computers as long as you don’t use the copies simultaneously.

What is a Software License?
A software license is usually an agreement that grants a right to use software code to 
someone else. A license usually grants less right than a sale of a copy of the software. The 
rights to use the code are defined by the terms of the license.

Software is important; therefore, software licenses are important. Today’s businesses rely 
upon software to perform many critical functions. Software makes machines and systems 
work in every sector of the world economy - everything from applications that control 
advanced medical devices to programs that analyze the behavior of financial markets.

Software developers may want to make code available to other developers in order for 
applications to be more widely used in the market. Manufacturers and publishers may 
want to acquire rights to software that can make their products work in new ways or in 
ways compatible with customers’ existing computer systems. In order to have the legal 
right to use software to achieve the required needs, the rights and limits in the associated 
software license take on critical importance.

Number of Software License
The number of licenses you purchase is the maximum number of users and the maximum 
number of users and the maximum number of computer system the purchased software 
can be installed on or that can access the software if on a network. If you purchase a 
single user license the software must only be accessible from one computer and there must 
be one user. To run the software on more than one computer a network, or provide for 
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NOTES additional users you must purchase a multiuser licence by setting the purchase quantity to 
the required number of user license.

Passport License
A passport is a travel document, usually issued by the government of a nation, that certifies 
the identity and nationality of its holder for the purpose of international travel. Standard 
passports contain the holder’s name, place and date of birth, photograph, signature, 
and other identifying information. Passports are moving towards including biometric 
information embedded in a microchip embedded in the document, making them machine-
readable and difficult to counterfeit.

A passport specifies nationality, but not necessarily the place of residence of the passport 
holder. A passport holder is normally entitled to enter the country that issued the passport, 
though to a passport may not be full citizens with right of abode. A passport is a proof 
of identity and nationality; having the document does not of itself grant any rights. It 
is protection by the consulate of the issuing country, although it may indicate that the 
holder human rights. Some passports attest to status as a diplomat or other official, 
entitled to rights and privileges such as immunity from arrest or prosecution, arising from 
international treaties.

Many countries normally allow entry to holders of passports of other countries, sometimes 
requiring a visa also to be held, but this is not an automatic right. Many other additional 
conditions, such as not being likely to become a public charge for financial or other reasons, 
and the holder not having been convicted of a crime, may be applicable. Where a country 
does not recognize another, or is in dispute with it, entry may be prohibited to holders of 
passports of the other party to the dispute, and sometimes to others who have, for example, 
visited the other country.

Some countries and international organizations issue travel documents which are not 
standard passports, but enable the holder to travel internationally to countries that 
recognize the documents. For example, stateless persons are not normally issued a national 
passport, but may be able to obtain a refugee travel document or the earlier “Nansen 
passport” which enables them to travel to countries which recognize them, and sometimes 
to return to the issuing country. A country may issue a passport to any person, including 
non-nationals.

Software Suites
A group of programs that are sold as a package to solve common problems. Although there 
are suites for graphics and mathematics, the most popular are “office suites.” Also known 
as “productivity suites,” they are a set of basic business programs designed with a uniform 
user interface and common functions such as spell checking. The primary programs are 
word processing, spreadsheet and presentation graphics such as Microsoft’s Word, Excel 
and PowerPoint and Apple’s Pages, Numbers and Keynote. All office suites are able to read 
Microsoft files but may be able to save documents only in their native formats.
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Programs that are uncopyrighted because their authors intended to share them with 
everyone else are in the public domain. The UNIX community has developed a number 
of such programs over the years. Programs in the public domain can be used without 
restriction as components of other programs. When reusing such code, it is good to 
understand its history so that you can be sure it really is in the public domain.

Word Processing Software
Word processing is probably the most common among the “productivity” software 
applications in use. The computer was certainly adopted quickly as a replacement for the 
typewriter when users had increased access to computers and discovered its advantages in 
document creation, editing, formatting and saving - that is, its word processing capabilities. 
This is especially true when it comes to making changes to previously created documents. 
No longer is it necessary to re-type entire pages and/or documents in order to add, delete 
and make corrections, among other things. It has become as simple as retrieving the 
originally typed document from the computer (or storage device), making the necessary 
changes and either printing it with the “push of a button” (or few keystrokes) or putting 
the new version back into a file on the computer or on a storage device. In fact, there 
should be less chance of errors and typos because of such features as spelling and grammar 
checking options.

Software Piracy
Software piracy is the stealing of legally protected software. Under copyright law, software 
piracy occurs when copyright protected software is copied, distributed, modified or sold. 
Software piracy is considered direct copyright infringement when it denies copyright 
holders due compensation for use of their creative works.

1.9 TYPES OF PROCESSORS

General Purpose Processor
There are five types of general-purpose processors they are, Microcontroller, Microprocessor, 
Embedded Processor, DSP and Media Processor

Microprocessor
The general-purpose processors are represented by the microprocessor in embedded 
systems. There are different varieties of microprocessors available in the market from 
different companies. The microprocessor is also a general-purpose processor that consists 
of a control unit, ALU, a bunch of registers also called scratchpad registers, control registers 
and status registers.

There may be an on-chip memory and some interfaces for communicating with the external 
world like interrupt lines, other lines for the memory and ports for communicating with 
the external world. The ports often called the programmable ports that means, we can 
program these ports either to be acting as an input or as an output. COMPUTER 
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NOTES Microcontroller
The microcontroller is basically a computer that comes in various packages and sizes. The 
reading input and responding to output is the basic function of the microcontroller. Generally, 
it is known as General Purpose Input Output (GPIO). Some of the microcontrollers are 
Microchip Atmega328-AU, Microchip P1C16F877A-I/P, Microchip P1C16F1503-I/P, 
Microchip P1C16F671-I/SN, Microchip P1C18F45K22-I/P, etc.

Embedded Processor
An embedded processor is one type of processor which is designed to control mechanical 
functions and electrical functions. It consists of several blocks they are the processor, timer, 
an interrupt controller, program memory and data memory, power supply, reset and clock 
oscillator circuits, system application-specific circuits, ports and interfacing circuits.

Digital Signal Processor
The digital signal processor is one type of processor used for measuring, filtering and/or 
compress digital or analog signals. The signal processing means analysis and manipulation 
of signal. This processing can be done via computer or Application Specific Integrated 
Circuits (ASIC), Field Programmable Gate Array (FPGA) or Digital Signal Processor 
(DSP) to obtain the clear signal. The DSP processors are used in an oscilloscope, barcode 
scanners, mobile phones, printers, etc. These processors are fast and use for real-time 
applications.

Media Processor
The image/video processor is the media processor that is designed or created to deal with 
the data in real-time. The voice user interface and professional audio are the applications 
of the audio processor. Some of the media processors are TN2302AP IP, IN2602 AP IP, 
DM3730, DM3725, DM37385, DM388, TMS320DM6467, TMS320DM6431, etc.

Application-Specific System Processors (ASSPs)
The application-specific system processor is a semiconductor integrated circuit product 
used to implements a specific function. The performance, characteristics and die size of 
the application-specific system processor is the same as the ASIC. The ASSP’s are used in 
various types of industries to perform video encoding or decoding and audio encoding or 
decoding. In place of embedded software, the application-specific system processor is used 
to run the application and it provides the solution faster. Example: IIM7100, W3100A

Application-Specific Instruction Set Processors (ASIPs)
The application-specific instruction-set processors are designed for specific applications. 
These processors have low power consumption, high computational speed, and good 
flexibility. Due to programmability, the data path utilization is high in ASIPs, and the 
performance of this instruction set processor is good.

ASIC Processors
The application-specific integrated circuits are built for specific applications. These chips 
are small in size and consume low power. The design cost of ASIC is high and this is the 
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NOTESmain disadvantage. The application-specific integrated circuit chips are used in satellites, 
modems, computers, etc. Some of the top ASICs manufacturer companies are Ams AG. 
Listed Company, Bitfury. Private Company, XMOS Semiconductor Private Company, 
Analogix Semiconductor Private Company, EDAptive Computing Private Company, 
Lumen Radio Private Company, Integrated Device Technology, Hookit. Private Company, 
etc.

Multiprocessor
The multiprocessor is a computer with more than one CPU, each shares main memory, a 
computer bus, and peripherals to simultaneously process the programs and these systems 
are also known as tightly coupled systems. The advantages of multiprocessors are increased 
throughput, increased reliability and economy of scale. These processors are used when 
very high speed is required to process a large volume of data.

1.10 USES OF COMPUTERS IN BUSINESS

Just about every business you can think of uses computers in one way or another to carry 
out its functions. From generating reports to communicating with clients, computers do a 
lot for the efficiency with which a business is run. The computer has brought the business a 
long way from the age of pen and paper, and folders stored in dusty storage compartments. 
The uses of a computer are simply endless.

Not only do businesses use computers to carry out different functions, they also use many 
different types of computers to carry out those functions. These functions include laptops, 
PCs, servers, and even smartphones. Because of computers, concepts such as flexible 
working schedules and remote work forces have become possible – enabling employees to 
work from wherever they want and at whatever times they wish.

Computers Are Used for Communication
When it comes to establishing contact with clients, computers are a vital tool; they are 
also vital when it comes to maintaining that contact. This is a very important computer 
application in business, enabling a business to communicate with its clients via email, 
IM, Skype, collaboration software, and via various other communication solutions that a 
business might wish to use. When a business can keep in touch with its clients, it becomes 
easier for the clients to make inquiries of the business or to ask for more information about 
the services and products the business offers. It also becomes easier for the business to offer 
customer support to its clients in a timely, efficient manner. The business will also be able 
to keep the clients updated about any new developments concerning the business.

Communication goes beyond a business’ clients. A business also needs to communicate 
with its employees, and computers play an important role. Rather than have time-wasting 
one-on-one meetings with employees, managers can simply email their employees or they 
can message them on any other acceptable communication platform. This saves time, and 
it also improves the internal communication of the business.
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Computers allow a business to perform a variety of tasks. For starters, with the help of the 
internet, computers help put a business on the map. With a computer, a business’s team 
of IT developers can create a professional website complete with enticing graphics and 
content with different forms of media, such as text, images, and videos. They can do search 
engine optimization – SEO – for the website so that it appears prominently in Google’s 
search results, which then attracts traffic, which, ultimately, will enable the business to sell 
those products to website visitors.

With a computer, a business can create and execute entire marketing campaigns that span 
across every social media platform on the internet. The business can create ads to run on 
websites and social media platforms, using special software, and it can also buy marketing 
services from other businesses – all connected to the internet. The computer is likely the 
greatest marketing device ever built!

Computers Are Used for Accounting
Accounting is a function in which accuracy is of the utmost importance. When you 
perform accounting functions – and you have nothing nothing except pen and paper - and 
you’re relying solely on brain power, you expose yourself to errors. Accounting software 
helps prevent that from happening.

Accounting software enables a business to quickly and accurately obtain large- and small-
scale pictures of the company’s financial situation. All the employees need to do is to 
input his financial information into the software and – with a few clicks – the employees 
understand everything about the financial health of the business’ operations.

Computers are also critical for tasks such as invoicing clients; maintaining data about 
debtors and creditors; calculating payroll, calculating and filing tax forms, as well as for a 
lot of other functions.

With the computer, accountants can now focus on the higher level picture of a business’s 
finances, leaving the lower level stuff to the machines.

Computers Are Used for Storage
Businesses have come a long way from the era of filing cabinets thanks to computers. 
Although a filing cabinet will occupy a very large space but will store only a small amount 
of information, a computer will occupy only a fraction of that space but it will store 
thousands of times the amount of information. With computers and servers, businesses are 
able to store and sort millions of files, to enable the business to access at any time.

1.11 CHAPTER SUMMARY

A computer is an electronic device, operating under the control of instructions stored in 
its own memory that can accept data (input), process the data according to specified rules, 
produce information (output), and store the information for future use.
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NOTESAny kind of computers consists of hardware and software. Computer hardware is the 
collection of physical elements that constitutes a computer system. Computer hardware 
refers to the physical parts or components of a computer such as the monitor, mouse, 
keyboard, computer data storage, hard drive disk (HDD), system unit (graphic cards, 
sound cards, memory, motherboard and chips), etc. all of which are physical objects that 
can be touched. Software is a generic term for organized collections of computer data and 
instructions, often broken into two major categories: system software that provides the 
basic non-task-specific functions of the computer, and application software which is used 
by users to accomplish specific tasks.

1.12 REVIEW QUESTIONS

SHORT ANSWER TYPE QUESTIONS

1.	 Discuss about Firewall.

2.	 Discuss some High Level Languages.

3.	 Discuss Screen Image Projector.

4.	 Discuss about voice recognition system.

5.	 Discuss about various computer generations. 

LONG ANSWER TYPE QUESTIONS

1.	 Explain the concept of spyware.

2.	 Explain any 3 input devices.

3.	 Explain different types of processors

4.	 Explain different uses of computers in business.

5.	 Discuss Passport License.

1.13 MULTIPLE CHOICE QUESTIONS

1. 	 The _____ was the earliest calculating machine probably originated in China 
about 3,000 years ago.
a)	 Abacus

b)	 Windows

c)	 Dos

d)	 Microsoft

2. 	 An ____device is any device that provides input to a computer.
a)	 Output 

b)	 Input 

c)	 Memory 

d)	 Secondary 
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NOTES 3. 	 A ______is a type of computer that possesses most of the features and 
capabilities of a large computer but is smaller in physical size.
a)	 Supercomouter

b)	 microcomputer 

c)	 Minicomputer 

d)	 Macrocomputer

4. 	 Primary storage or the commonly referred Random Access Memory is the 
memory which is directly accessible to the______.
a)	 Memory 

b)	 Hard disk

c)	 Registers 

d)	 CPU

5. 	 ______is also a pointing device, which is used to move cursor position on a 
monitor screen.
a)	 Joystick

b)	 Mouse 

c)	 Keyboard 

d)	 Screen 

6. 	 The printers that print the characters without striking against the ribbon and 
onto the paper are called _________.
a)	 Impact printers

b)	 Non-impact Printers

c)	 Character printers

d)	 Line printers

7. 	 An ________ is a set of programs that controls and coordinates the use of 
computer hardware among various application programs.
a)	 Memory system

b)	 Operating System

c)	 Storage system

d)	 Registers 

8. 	 A _______ is a program that replicates itself. It is usually spread by attaching 
itself to other files and programs.
a)	 Antivirus

b)	 Operating system

c)	 Virus 

d)	 SoftwareCOMPUTER 
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NOTES9. 	 Accounting is a function in which ______is of the utmost importance.
a)	 Accuracy 

b)	 Memory

c)	 Speed

d)	 Duplicity

10. 	 When it comes to establishing contact with clients, _______ are a vital tool; 
they are also vital when it comes to maintaining that contact.
a)	 Radio

b)	 Computers

c)	 Printers

d)	 Keyboards 

sssss
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NOTES2.1 LEARNING OBJECTIVE

After completing this chapter, you will be able to:
•	 Understand the concepts Data Communication.

•	 Understand various Data communication components.

•	 Learn and understand the concept of communication media. 

•	 Understand the concept of Modem. 

•	 Understand the networking terms. 

•	 Understand the concept of Computer networks.

•	 Understand about Teleconferencing tools.

•	 Understand the concept of OSI Model.

2.2 INTRODUCTION 

Data refers to the raw facts that are collected while information refers to processed data 
that enables us to take decisions. For example, when result of a particular test is declared 
it contains data of all students, when you find the marks, you have scored you have the 
information that lets you know whether you have passed or failed. The word data refers 
to any information which is presented in a form that is agreed and accepted upon by its 
creators and users.

Data communications are the exchange of data between two devices via some form 
of transmission medium such as a wire cable. For data communications to occur, the 
communicating devices must be part of a communication system. It refers to the 
transmission of the digital data between two or more computers and a computer network 
or data network is a telecommunications network that allows computers to exchange data. 
The physical connection between networked computing devices is established using either 
cable media or wireless media. The best-known computer network is the Internet.

The effectiveness of a data communications system depends on four fundamental char-
acteristics:

1. 	 Delivery: The data should be delivered to the correct destination and correct user. 

2. 	 Accuracy: The communication system should deliver the data accurately, without 
introducing any errors. The data may get corrupted during transmission affecting 
the accuracy of the delivered data.

3. 	 Timeliness: Audio and Video data has to be delivered in a timely manner without 
any delay; such a data delivery is called real time transmission of data.

4. 	 Jitter: It is the variation in the packet arrival time. Uneven Jitter may affect the 
timeliness of data being transmitted.
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NOTES 2.3 DATA COMMUNICATION COMPONENTS

A data communication system has five components:
•	 Message: The message is the data to be communicated. It can be text, numbers, 

pictures, audios and videos.

•	 Sender: The sender is the device that send the data message. It can be a computer, 
telephone, handset, video camera and so on.

•	 Receiver: The receiver is the device that receive the message. It can be a computer, 
telephone, handset, video camera and so on.

•	 Transmission medium: The transmission is the physical path by which a message 
travels from the sender to receiver. Some examples of transmission medium include 
twisted pair wire, coaxial cable, fiber-optic cable, radio waves and so on.

•	 Protocol: A protocol is a set of rules for two devices to communicate. Communication 
is not possible without a protocol.

Data Representation

Data (Information) today comes in different forms of text, numbers, audios, and videos.
•	 Text: Text is represented as a bit pattern, a sequences of bits (Os or Is). For text 

representation American Standard Code for Information Interchange (ASCII) 
Code are used.

•	 Numbers: Numbers are also represented by bit pattern here. ASCII codes are not 
used but a number is directly converted into binary numbers (Os or Is).

•	 Images: Images refers to the still picture. Images are also represented by a bit 
pattern. In its simplest form, an image is composed of matrix of pixels, where each 
pixel is a small dot. Numbers of pixels depends on the resolution.

•	 Audio: Audio refers to the recording or broadcasting of sound or music. Audio is 
by nature different from text, numbers or images. Audio is in continuous form.

•	 Video: Video refers to recording or broadcasting of a picture or movie. Video can 
either be produced as a continuous entity or it can be a combination of images, 
where each separate entity is arranged to convey an idea.

Data Transmission Mode (Data Flow)
•	 Simplex Mode: Simplex mode permits data to flow in only one direction. A 

terminal connected to such line is either to send only or receive only devices. This 
mode is generally not used.

•	 Half Duplex Mode: In this mode data can be transmitted back and forth between 
2 stations, but data can only go in one of the 2 directions at any given point of 
time.

•	 Full Duplex Mode: In this mode data can be simultaneously send and receive 
between 2 stations. It is commonly used method.DATA 
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In centralized network, there is a main computer known as Server and the other computers 
connected to the Server are called nodes or workstations. The server does the entire process 
and the output is transferred to the node/s. It is best suited for companies which require 
centralized processing.

Distributed Processing (Decentralized Processing)
Processing can be centralized or decentralized. Most networks use distributed processing, 
in which a task is divided among multiple computers. Instead of one single large machine 
being responsible for all aspects of a process, separate computers (usually a personal 
computer) handle a subset.

2.4 NETWORK MEDIA

Network media refers to the means used to link a network’s nodes together. There are 
many different types of transmission media, such as, twisted-pair wire, coaxial cable and 
fiber optic cable. In wireless networks, the atmosphere itself acts as the medium because it 
carries the wireless signals that nodes and servers use to communicate.

Guided Media (Wire-based Media)
It is defined as the physical medium through which the signals are transmitted. It is also 
known as Bounded media.

Different types of Guided Media are:
•	 Twisted-pair Cable: Normally consists of four pairs of wires. Individuals pairs 

have two wires that are separately insulated in plastic, then twisted around each 
other and bound together in a layer of plastic. Except for plastic coating, nothing 
shields this type of wire from outside interface, so it is called as unshielded twisted-
pair (UTP) wire; some twistedpair cable is not immune to the electromagnetic 
interference. Data is transferred using electrical current. Nowadays twisted-pair 
wires can support speed up to 1GBPS.

•	 Coaxial Cable: This cable has two conductors. One is a single wire in the centre 
of the cable, and the other is a mesh shield that surrounds the first wire, with an 
insulator between. Coaxial cable is immune to the electromagnetic interference. 
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Data is transferred using electrical current. It can support speed up to 10 MBPS.

•	 Fiber-optic cable: It is a thin thread of glass that transmits lively beams of light 
rather than electric current. Fiber-optic cable can carry data at a higher speed. 
Fiber-optic cable is immune to the electromagnetic interference. Nowadays it can 
support speed up to 100 GBPS.

Unguided Transmission Media (Wireless Media)
Unguided media transport electromagnetic waves without using a physical conductor. 
This type of communication is often referred to as wireless communication. Signals are 
normally broadcast through free space and thus are available to anyone who has a device 
capable of receiving them.

Unguided Transmission media is classified into three categories:
•	 Radio waves

•	 Microwave

•	 Infrared

Radio waves:
Waves ranging in frequencies between 3 kHz and 1 GHz are called radio waves. Radio 
waves, for the most part, are omnidirectional. When an antenna transmits radio waves, 
they are propagated in all directions. This means that the sending and receiving antennas 
do not have to be aligned. A sending antenna sends waves that can be received by any 
receiving antenna. The omnidirectional property has a disadvantage, too. The radio waves 
transmitted by one antenna are susceptible to interference by another antenna that may 
send signals using the same frequency or band. 

Radio waves, particularly those waves that propagate in the sky mode, can travel long 
distances. This makes radio waves a good candidate for long-distance broadcasting such as 
AM radio. Radio waves, particularly those of low and medium frequencies, can penetrate 
walls. This characteristic can be both an advantage and a disadvantage. It is an advantage 
because, for example, an AM radio can receive signals inside a building. It is a disadvantage 
because we cannot isolate a communication to just inside or outside a building. The radio 
wave band is relatively narrow, just under 1 GHz, compared to the microwave band.

An example of radio wave is FM radio.

Applications of Radio waves:
•	 A Radio wave is useful for multicasting when there is one sender and many receivers.

•	 An FM radio, television, cordless phones are examples of a radio wave.
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NOTESAdvantages of Radio waves:
•	 Radio transmission is mainly used for wide area networks and mobile cellular 

phones.

•	 Radio waves cover a large area, and they can penetrate the walls.

•	 Radio transmission provides a higher transmission rate.

Microwave:
Electromagnetic waves having frequencies between I and 300 GHz are called microwaves. 
Microwaves are unidirectional. When an antenna transmits microwave waves, they can be 
narrowly focused. This means that the sending and receiving antennas need to be aligned. 
The unidirectional property has an obvious advantage. A pair of antennas can be aligned 
without interfering with another pair of aligned antennas. 

The following describes some characteristics of microwave propagation: 
•	 Microwave propagation is line-of-sight. Since the towers with the mounted 

antennas need to be in direct sight of each other, towers that are far apart need to 
be very tall. The curvature of the earth as well as other blocking obstacles do not 
allow two short towers to communicate by using microwaves. Repeaters are often 
needed for long distance communication. 

•	 Very high-frequency microwaves cannot penetrate walls. This characteristic can be 
a disadvantage if receivers are inside buildings. 

•	 The microwave band is relatively wide, almost 299 GHz. Therefore, wider sub 
bands can be assigned, and a high data rate is possible.

•	 Use of certain portions of the band requires permission from authorities.

Unidirectional Antenna 
Microwaves need unidirectional antennas that send out signals in one direction. Two types 
of antennas are used for microwave communications: the parabolic dish and the horn. A 
parabolic dish antenna is based on the geometry of a parabola: Every line parallel to the line 
of symmetry (line of sight) reflects off the curve at angles such that all the lines intersect 
in a common point called the focus. The parabolic dish works as a funnel, catching a wide 
range of waves and directing them to a common point. In this way, more of the signal is 
recovered than would be possible with a single-point receiver. Outgoing transmissions are 
broadcast through a horn aimed at the dish. The microwaves hit the dish and are deflected 
outward in a reversal of the receipt path. 

A horn antenna looks like a gigantic scoop. Outgoing transmissions are broadcast up a 
stem (resembling a handle) and deflected outward in a series of narrow parallel beams by 
the curved head. Received transmissions are collected by the scooped shape of the horn, in 
a manner similar to the parabolic dish, and are deflected down into the stem.

Infrared
Infrared links are light emitting diodes (LEDs) or Injection laser diodes (ILDs) and 
photodiodes to exchange data between stations. Infrared signals -are not capable of 
penetrating walls or other opaque objects and are diluted by strong light
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CHECK YOUR PROGRESS

1. 	 What is Computer Network? Discuss advantages of network.
2. 	 Discuss various data communication components.
3. 	 What do you mean by Communication Media?
4. 	 Discuss Coaxial Cable and microwave communication. 
5.	 What is radio waves? Discuss the application and advantages of radio waves.

2.5 MODEM

Modem stands for Modulation Demodulation. A modem converts the digital data signals 
into analogue data signals. They can be installed within the computer in a development 
slot applicable for it.

There are frequently two types of Modems that are as follows

Standard Modem
The standard modems use generic device drivers, and they can be internal and external 
ones. The internal modems do not need much physical structure. They can be installed 
into a compatible development slot. The external modem is connected through one of the 
COM port to the computer through a cable called a null-modem cable.

Window Modem
A window modem is a private plug and plays tool. It requires a particular device driver 
supported by the window operating framework to function correctly.

Features of Modems

The main features of modems are as follows 
•	 They have high uploading and communication rates. An X2 modem provides an 

uploading bandwidth between 28.8 to 56 Kbps.

•	 They are upgradeable through a software patch to meet almost any universal 
standard.

•	 They enable high-speed downstream data transfers by digitally encoding all 
downstream data while upstream runs at conventional rates of 33.6 kbps.

•	 Some modems incorporate dual simultaneous voice and Data (DSVD), i.e., they 
can carry both analog voices and computer data.

•	 They can detect callers originating telephone number, and thus they can serve as 
caller ID.

•	 Some modems provide advanced voice mail features, and those modems serve as 
intelligent, answering machines or digital information systems.

2.6 COMPUTER NETWORK

Network is a group of computers and other devices, such as printers and scanners, 
connected by a communication link, enabling all the devices to interact with each other 
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NOTESand share applications, data and hardware components. Networks can be small or large, 
permanently connected through wires or cables, or temporarily connected through phone 
lines or wireless transmission. The largest network is the Internet, which is a worldwide 
group of networks.

Benefits of Computer Network
•	 Network provides us to communicate over the network in a fast and efficient 

manner. For example, we can do video conferencing, email messaging, etc. over 
the internet.

•	 Computer network provides us to share the files with each other.

•	 Since the files are stored in the main server which is centrally located. Therefore, it 
is easy to take the back up from the main server.

•	 Network allows the security by ensuring that the user has the right to access the 
certain files and applications.

•	 Computer network can use the alternative source for the data communication in 
case of any hardware failure.

•	 Network must be scalable so that we can extend the network by adding new devices.

TYPES OF NETWORK

LAN (Local Area Network)
•	 It is a small network of connected computers, wherein computers are connected 

to each other physically with the help of wire or cable (Twisted Pair or Coaxial). 
(Though now days there are wireless LANs, they come under WIRELESS 
NETWORK and not LAN.)

•	 Each computer may work with peripheral devices such as printer, data storage 
devices.

•	 Connected computer must be within certain radius limit; generally, one kilometer. 
In other words, LAN is confined to a small area.

•	 In LAN at least one computer is designed as file server. In some LAN file server is 
referred to as network derivers.

•	 The microcomputers managed by a file server are called as workstations or nodes.

•	 In LAN resources such as printers, data storage devices, software etc. can be shared.

•	 The file server manages the communication and sharing of peripheral devices.

•	 If required, LAN can contain more than one file server.

•	 Data transfer speed is measured in megabytes per second (mbps) (10 mbps or 
more).

•	 Two or more LANs can be connected to each other with the help of Bridges or 
Gateways.

•	 LAN is generally owned by an organisation (Privately owned)
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NOTES MAN (Metropolitan Area Network)
•	 It is a bigger network of connected computers, wherein computers are connected 

to each physically with the help of fiber optic cable.

•	 Each computer may work with peripheral devices such as printer, data storage 
devices.

•	 Connected computers must be within certain radius limit; generally 40 to 60 
kilometres. In other word MAN is confined to a bigger area.

•	 Generally, man contains more than one file server.

•	 The microcomputer managed by the file server is called as workstations or nodes.

•	 In MAN resources such as printer, data storage devices, softwares can be shared.

•	 The file server manages the communications and sharing of peripheral devices.

•	 Data transfer speed is measured in megabytes per second (mbps) (20 mbps or 
more).

•	 Two or more MANs can be connected to each other with the help of Bridge or 
Gateways.

•	 MAN is generally not owned by a single organisation.

WAN (Wide Area Network)
•	 It is a large network of connected computers, wherein computers are connected to 

each other with the help of various communication facilities such as long distance 
telephone services, satellite transmission, under sea-cables etc.

•	 Each computer may work with peripheral devices such as printer, data storage 
devices.

•	 WAN covers wide geographical area. The connected computers can be anywhere 
in the world.

•	 Generally, WAN contains more than one file server.

•	 The microcomputers managed by the file server are called as workstations or nodes.

•	 In WAN resources such as data storages devices, software, etc., can be shared.

•	 The file server manages the communication and sharing of peripheral devices.

•	 Less freedom as compared to LAN, because public telecommunication is involved.

•	 MAN can be connected to WAN.

Network Structure (Architecture)

Server-based Network
This type of network has certain computers (servers) that are especially dedicated to provide 
various services to the other computers (nodes). In this architecture, when a node requires 
any information from the server, it requests the file containing information, the file is then 
downloaded from the server to the node and then processing is done by the nodes.DATA 
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NOTESClient Server Network:
This type of network has certain computers (services) that are especially dedicated to 
provide various services to other computers (clients). In this architecture, when a client 
requires any information from the server, it requests the server about the information; the 
server then, will process the data and return just the requested information to the client. 
Nodes works as Input/Output devices.

Peer to Peer Network
In peer-to-peer architecture, there is no dedicated server. All computers are equal and 
therefore termed as peer. Each computer functions as a server and a client. It is suitable 
only for limited number of users.

2.7 NETWORKING TERMS

WAN
It stands for Wide Area Network and covers a wide area such as a city.

LAN
It stands for Local Area Network and covers a small area such as a small office or home. It 
physically connects all the computers located in the premises.

Internet
It is a computer network system that connects the computers of the world. It is normally 
connecting through WAN and LAN.

Intranet
It is a close room computer network system, as it covers a small area and only authorized 
people can access it.

Extranet
It is also a sort of Internet the access to which is granted only to a few.

World Wide Web (WWW)
It is the service that is used on Internet to view and search contents (in the form of web-
pages).

Instant messaging (IM)
It is an online facility that facilitates us to chat or talk. Such service is provided by Skype, 
Google Talk, Windows Live Messenger, Yahoo Messenger, etc.

Voice over Internet Protocol (VoIP)
It is a Protocol, which is used especially for voice transfer over IP network. Likewise, it 
facilitates users to make phone-calls by using internet. DATA 
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NOTES Really Simple Syndication (RSS)
It is a technique, which is used for the dissemination of information, articles, etc. Users 
normally subscribe to the RSS channel in order to receive news. After subscription, users 
do not need to visit the respective website rather they receive emails regarding the same.

Web log
It is a sort of online inventory (normally on a specialized topics) that consists of a series 
of entries. These entries are arranged in opposite chronological order. The person who 
maintains the weblog regularly update it with a new information.

Podcast
It is a digital file that normally contains audio or video record and is available on the 
Internet as well.

Social networking websites
It refers to the websites that facilitate users with a common platform where they can 
share their message (in text, audio, or even video form), images, videos, etc. For example, 
Facebook, Google+, Twitter, LinkedIn, Myspace, etc.

Chat Rooms

It is a dedicated area on the Internet that facilitates users to communicate.

Public Switched Telephone Network (PSTN)
It is a technical expression for public telephone system.

Integrated Services Digital Network (ISDN)
It is a set of communication standards that transmits voice, video, data, and other network 
services simultaneously.

Asymmetric Digital Subscriber Line (ADSL)
It is a sort of digital subscriber line (DSL) technology that facilitates faster data transmission.

Download
It is a process that saves data from Internet onto a personal computer.

Upload
It is a process that transfers the saved data from a personal computer to Internet server.

Dial-up
It is a technique in which a phone line is used in order to connect to the Internet.

Broadband
It is a wide bandwidth data transmission that transports multiple signals and traffic types 
swiftly.
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NOTES2.8 TELECONFERENCING TOOLS

Teleconferencing means meeting through a telecommunications medium. It is a generic 
term for linking people between two or more locations by electronics. There are at least 
six types of teleconferencing: audio, audio graphic, computer, video, business television 
(BTV), and distance education. The methods used differ in the technology, but common 
factors contribute to the shared definition of teleconferencing. Education and healthcare 
are basic needs for human development. Technical innovation has broadened the access to 
higher quality health care and instruction without regard to time, distance or geopolitical 
boundaries. Distance learning has earned popularity as a way of learning in recent years 
due to widely distributed learners, busy schedules and rising travel prices. Teleconferencing 
is also a very useful tool as a distance learning method. Teleconference is a real-time 
and live interactive course of study in which one set of participants are at one or more 
localizations and the other set of participants are at some other. The teleconference allows 
for interaction, including sound recording and/or video, and possibly other modalities, 
between at least two websites.

Few examples of teleconferencing tools are:
•	 RingCentral

•	 Webex

•	 Microsoft Teams

•	 Google Meet

•	 GoToMeeting

•	 ClickMeeting

•	 AnyMeeting

•	 ezTalk Cloud Meeting

•	 Bluejeans Meetings

•	 Join.me

•	 Lifesize

•	 U Meeting

•	 Zoho Meeting

•	 Big Blue Button

•	 Zoom Meetings

2.9 OPEN SYSTEM INTERCONNECTION (OSI) MODEL

In 1977, the International Organization for Standardization (ISO), began to develop its 
OSI networking suite. OSI has two major components: an abstract model of networking 
(the Basic Reference Model, or seven-layer model), and a set of concrete protocols. The 
standard documents that describe OSI are for sale and not currently available online. 
Parts of OSI have influenced Internet protocol development, but none more than the 
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NOTES abstract model itself, documented in ISO 7498 and its various addenda. In this model, a 
networking system is divided into layers. Within each layer, one or more entities implement 
its functionality. Each entity interacts directly only with the layer immediately beneath it, 
and provides facilities for use by the layer above it.

In particular, Internet protocols are deliberately not as rigorously architected as the OSI 
model, but a common version of the TCP/IP model splits it into four layers. The Internet 
Application Layer includes the OSI Application Layer, Presentation Layer, and most of 
the Session Layer. Its End-to-End Layer includes the graceful close function of the OSI 
Session Layer as well as the Transport Layer. Its Internetwork Layer is equivalent to the OSI 
Network Layer, while its Interface layer includes the OSI Data Link and Physical Layers. 
These comparisons are based on the original seven-layer protocol model as defined in ISO 
7498, rather than refinements in such things as the Internal Organization of the Network 
Layer document.

Protocols enable an entity in one host to interact with a corresponding entity at the same 
layer in a remote host. Service definitions abstractly describe the functionality provided to 
a (N)-layer by an (N-1) layer, where N is one of the seven layers inside the local host

Layer 7: Application Layer 
The application layer is the seventh level of the seven-layer OSI model. It directly to and 
interfaces performs common application services for the it also issues application processes; 
requests to the presentation layer. Note carefully services to user-defined that this layer 
provides application processes, and not to the end user. For example, it defines a file transfer 
protocol, but the end user must go through an application process to invoke file transfer. 
The OSI model does not include human interfaces. The common application services 
sublayer provides functional elements including the Remote Operations Service Element 
(comparable to Internet Remote Procedure Call), Association Control, and Transaction 
Processing (according to the ACID requirements). Above the common application 
service sublayer are functions meaningful to user application programs, such as messaging 
(X.400), directory (X.500), file transfer (FTAM), virtual terminal (VTAM), and batch job 
manipulation (JTAM).

Layer 6: Presentation Layer 
The Presentation layer transforms the, data to provide a standard interface for the 
Application layer. MIME encoding, data encryption and similar manipulation of the 
presentation are done at this layer to present the data as a service or protocol developer sees 
fit. Examples of this layer are converting an EBCDIC-coded text file to an ASCIL-coded 
file, or serializing objects and other data structures into and out of XML.

Layer 5: Session Layer 
The Session layer controls the dialogues/connections (sessions) between computers. 
It establishes, manages and terminates the connections between the local and remote 
application. It provides for either full-duplex or half-duplex operation, and establishes 
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NOTEScheck pointing, adjournment, termination, and restart procedures. The OSI model made 
this layer responsible for “graceful close” of sessions, which is a property of TCP, and also 
for session check pointing and recovery, which is not usually used in the Internet protocols 
suite. Session layers are commonly used in application environments that make use of 
remote procedure calls (RPCs). iSCSI, which implements the Small Computer Systems 
Interface (SCS) encapsulated into TCP/IP packets, is a session layer protocol increasingly 
used in Storage Area Networks and internally between processors and high-performance 
storage devices. iSCSI leverages TCP for guaranteed delivery, and carries SCSI command 
descriptor blocks (CDB) as payload to create a virtual SCSI bus between iSCSI initiators 
and iSCSI targets.

Layer 4: Transport Layer 
The Transport layer provides transparent transfer of data between end users, providing 
reliable data transfer services to the upper layers. The transport layer controls the reliability 
of a given link through flow control, segmentation/de-segmentation, and error control. 
Some protocols are state and connection oriented. This means that the transport layer can 
keep track of the segments and retransmit those that fail.

The best-known example of a layer 4 protocol is the Transmission Control Protocol (TCP).

The transport layer is the layer that converts messages into TCP segments or Use Datagram 
Protocol etc. (UDP), Stream Control Transmission Protocol (SCTP). et packets. Perhaps 
an easy way to visualize the Transport Layer is to compare it with a Post Office, which deals 
with the dispatch and classification of mail and parcels sent. Do remember, however, that 
a post office manages the outer envelope of mail. Higher layers may have the equivalent 
of double envelopes, such as cryptographic Presentation services that can be read by the 
addressee only.

Roughly speaking, tunneling protocols operate at the transport layer, such as carrying 
non-IP protocols such as IBM’s SNA or Novell’s IPX over an IP network, or end-to end 
encryption with IPsec. While Generic Routing Encapsulation (GRE) might seem to be a 
network layer protocol, if the encapsulation of the payload takes place only at endpoint, 
GRE becomes closer to a transport protocol that uses IP headers but contains complete 
frames or packets to deliver to an endpoint. L2TP carries PPP frames inside transport 
packets.

Layer 3: Network Layer 
The Network layer provides the functional and procedural means of transferring variable 
length data sequences from a source to a destination via one or more networks while 
maintaining the quality of service requested by the Transport layer. The Network layer 
performs network routing functions, and might also perform fragmentation and reassembly, 
and report delivery errors. Routers operate at this layer-sending data throughout the 
extended network and making the Internet possible. This is a logical addressing scheme - 
values are chosen by the network engineer. DATA 
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NOTES The addressing scheme is hierarchical. The best-known example of a layer3 protocol is the 
Internet Protocol (IP).

Perhaps it’s easier to visualize this layer as managing the sequence of human carriers taking 
a letter from the sender to the local post office, trucks that carry sacks of mail to other post 
offices or airports, airplanes that carry airmail between major cities, trucks that distribute 
mail sacks in a city, and carriers that take a letter to its destinations. Think of fragmentation 
as splitting a large document into smaller envelopes for shipping, or, in the case of the 
network layer, splitting an application or transport record into packets.

Layer2: Data Link Layer 
The Data Link layer provides the functional and between network procedural means to 
transfer data entities and to detect and the Physical possibly correct errors that may occur 
in layer. The best-known example of this is Ethernet. This layer manages the interaction 
of devices with a shared medium. Other examples of data link protocols are HDLC and 
ADCCP for point-to-point or packet-switched networks and Aloha for local area networks. 
On IEEE 802- local area networks, and some non-IEEE 802 networks such as FLDDI, 
this layer may be split into a Media Access Control layer (MAC) and the IEEE 802.2 
Logical Link Control (LLC) layer. Its physical layer into arranges bits from the logical 
chunks of data, known as frames.

This is the layer at which the bridges and switches operate. Connectivity is only among 
locally attached network provided nodes broadcast forming layer 2 domains for unicast 
or forwarding. Other protocols may be imposed on the data frames to create tunnels and 
logically separated layer 2 forwarding domain. The data link layer might implement a 
sliding window flow control and acknowledgment mechanism to provide reliable delivery 
of frames; that is the case for SDLC and HDLC, and derivatives of HDLC such as LAPB 
and LAPD. In modern practice, only error detection, not flow control using sliding window, 
is present in modern data link protocols such as Point-to-Point Protocol (PPP), and, on 
local area networks, the IEEE 802.2 LLC layer is not used for most protocols on Ethernet, 
and, on other local area networks, its flow control and acknowledgment mechanisms are 
rarely used. Sliding window flow control and acknowledge merit is used at the transport 
layers by protocols such as TCP.

Layer 1: Physical Layer 
The Physical layer defines all the electrical and physical specifications for devices. In 
particular, it defines the relationship between a device and a physical medium. This includes 
the layout of pins, voltages, and cable specifications. Hubs, repeaters, network adapters and 
Host Bus Adapters (HBAs used in Storage Area Networks) are physical layer devices. To 
understand the function of the physical layer in contrast to the functions of the data link 
layer, think of the physical layer as concerned primarily with the interaction of a single 
device with a medium, where the data link layer is concerned more with the interactions 
of multiple devices (i.e., at least two) with a shared medium. The physical layer will tell 
one device how to transmit to the medium, and another device how to receive from it, but 
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NOTESnot, with modern protocols, how to gain access to the medium. Obsolescent physical layer 
standards such as RS-232 do use physical wires to control access to the medium.

The major functions and services performed by the physical layer are: Establishment and 
termination of a connection to a communications medium. Participation in the process 
whereby the communication resources are effectively shared among multiple users. For 
example, contention resolution and flow control. Modulation, or conversion between the 
representation of digital data in user equipment and the corresponding signals transmitted 
over a communications channel. These are signals operating over the physical cabling (such 
as copper and fiber optic) or over a radio link.

Parallel SCSI buses operate in this layer, although it must be remembered that the logical 
SCSI protocol is a transport-layer protocol that runs over this bus. Various physical-layer 
Ethernet standards are also in this layer; Ethernet incorporates both this layer and the data-
link layer. The same applies to other local-area networks, such as token ring, FDDI, and 
IEEE 802.11, as well as personal area networks such as Bluetooth and IEEE 802.15.4.

2.10 CHAPTER SUMMARY

Data communications refers to the transmission of this digital data between two or more 
computers and a computer network or data network is a telecommunications network 
that allows computers to exchange data. The physical connection between networked 
computing devices is established using either cable media or wireless media. The best-
known computer network is the Internet.A system of interconnected computers and 
computerized peripherals such as printers is called computer network. This interconnection 
among computers facilitates information sharing among them. Computers may connect to 
each other by either wired or wireless media.

Data communication networks deal with the transfer of data between two points. Data 
originates at the source and is finally delivered to the destination, which is also called 
a sink. It can also be classified according to the type of medium over which the signal 
propagates. In this case, there are two types of transmissions: guided transmission and 
wireless transmission; wireless transmission is also called unguided transmission. There 
are two ways in which data can be transferred from source to destination: switching and 
broadcasting. In a switched network, data is transferred from source to destination through 
a series of intermediate switching nodes. In a broadcast network, a transmission from a 
source is received by all nodes in the network. There are two network access techniques that 
are closely related to the transfer technique used: switched network access and broadcast 
network access.

A network can be categorized as a local area network (LAN), a metropolitan-area network 
(MAN), or a wide area network (WAN). A LAN is a data communication system within a 
building, plant, or campus, or between nearby buildings. A MAN is a data communication 
system covering an area the size of a town or city. A WAN is a data communication system 
spanning states, countries, or the whole world. An internet is a network of networks. The 
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NOTES Internet is a collection of many separate networks. TCP/IP is the protocol suite for the 
Internet. There are local, regional, national, and international Internet service providers 
(ISPs). A protocol is a set of rules that governs data communication; the key elements of a 
protocol are syntax, semantics, and timing. Standards are necessary to ensure that products 
from different manufacturers can work together as expected.

2.11 REVIEW QUESTIONS

SHORT ANSWER TYPE QUESTIONS

1.	 Discuss the concept of Modem.
2.	 Discuss Network layer of OSI Model.
3.	 What do you mean by Teleconferencing tools? Give some examples.
4.	 Discuss the concept of LAN and MAN.
5.	 Discuss Physical layer of OSI Model.

LONG ANSWER TYPE QUESTIONS

1.	 Discuss the concept of Gateway.
2.	 Discuss the advantages of Computer Network.
3.	 Discuss about MAN.
4.	 What do you mean by unguided media? Discuss different types. 
5.	 Discuss guided media. Discuss different types. 

2.12 MULTIPLE CHOICE QUESTIONS

1.	 __________ is also called Data Transmission.
a)	 Data communication

b)	 Data sender

c)	 Data optimization

d)	 Data Handling

2. 	 _________ has certain computers (servers) that are especially dedicated to 
provide various services to the other computers (nodes).
a)	 Network-based Network. 

b)	 Server-based Network

c)	 Particular-based Network

d)	 Client-based Network  

3. 	 The geometrical arrangement of resources, remote devices and communication 
facilities is known as ______ or network structure.
a)	 Network node

b)	 Network cable
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NOTESc)	 Network topology 

d)	 Network session

4.	 ________ refers to the means used to link a network’s nodes together.
a)	 Network issue

b)	 Network area

c)	 Network collection

d)	 Network media

5. 	 The term _____is derived from 2 terms Modulator and Demodulator.
 a)	 Modem 

b)	 Demo

c)	 Bridge

d)	 Mod-Demod

6. 	 ______ are usually used to link LAN of different topologies.
a)	 Bridge

b)	 Routers

c)	 Gateways

d)	 Cables

7. 	 A _______ is a dedicated circuit between two specific locations.
a)	 Direct transfer

b)	 Leased line 

c)	 Coaxial connection

d)	 Gateway

8.	 ______ is a standard Internet protocol for transmitting files between computers 
on the Internet.
a)	 SMTP

b)	 OSI

c)	 HTTP

d)	 FTP

9. 	 ______covers a small area such as a small office or home. 
a)	 LAN

b)	 MAN

c)	 WAN

d)	 SAN
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NOTES 10. 	 VoIP stands for _______
a)	 Voice over Intranet Protocol

b)	 Voice over Internet Protocol

c)	 Voice on Internet Protocol

d)	 Voice over Internet Project
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NOTES 3.1 LEARNING OBJECTIVE

After completing this chapter, you will be able to:
•	 Understand the concepts Operating System.

•	 Understand various Functions of Operating System.

•	 Learn and understand the types of Operating system.

•	 Understand the History of WINDOWS Operating system.

•	 Understand about WINDOWS API.

•	 Understand the concept of Drivers and Unicode.

•	 Understand about Teleconferencing tools.

•	 Understand the basic concepts of Windows.

3.2 INTRODUCTION

An operating system acts as an intermediary between the user of a computer and computer 
hardware. The purpose of an operating system is to provide an environment in which a 
user can execute programs conveniently and efficiently. 

An operating system is a software that manages computer hardware. The hardware must 
provide appropriate mechanisms to ensure the correct operation of the computer system 
and to prevent user programs from interfering with the proper operation of the system. 

A computer system has many resources (hardware and software), which may be require to 
complete a task. The commonly required resources are input/output devices, memory, file 
storage space, CPU etc. The operating system acts as a manager of the above resources and 
allocates them to specific programs and users, whenever necessary to perform a particular 
task. Therefore, operating system is the resource manager i.e., it can manage the resource of 
a computer system internally. The resources are processor, memory, files, and I/O devices. 

3.3 DEFINITION AND FUNCTIONS OF OPERATING SYSTEM

An Operating system is defined as an integrated set of programs which manage the 
various resources and operations of a computer system. The operating system acts as an 
interface between the humans and the computer.

One of the earliest operating systems was MS-DOS, developed by Microsoft for IBM PC. 
It was a Command Line Interface (CLI) OS that revolutionized the PC market. DOS 
was difficult to use because of its interface. The users needed to remember instructions 
to do their tasks. To make computers more accessible and user-friendly, Microsoft 
developed Graphical User Interface (GUI) based OS called Windows, which transformed 
the way people used computers.

OPERATING SYSTEM 
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NOTESThere are two views of Operating System:
•	 User View

•	 System View

1. 	 Operating System: User View
The user view of the computer refers to the interface being used. Such systems are 
designed for one user to monopolize its resources, to maximize the work that the user 
is performing. In these cases, the operating system is designed mostly for ease of use, 
with some attention paid to performance, and none paid to resource utilization.

2. 	 Operating System: System View
Operating system can be viewed as a resource allocator also. A computer system 
consists of many resources like - hardware and software - that must be managed 
efficiently. The operating system acts as the manager of the resources, decides between 
conflicting requests, controls execution of programs etc.

FUNCTIONS OF OPERATING SYSTEM
Memory management - It manages both the primary and secondary memory such as RAM, 
ROM, hard disk, pen drive, etc. It checks and decides the allocations and deallocation of 
memory space to different processes. When a user interacts with a system, the CPU is 
supposed to read or write operations, in this case, OS decides the amount of memory to 
be allocated for loading the program instructions and data into RAM. After this program 
is terminated, the memory area is again free and is ready to be allocated to other programs 
by the OS.

As we know, computers have two types of memory-primary  and  secondary. Primary 
memory is fast but expensive and secondary memory is cheap but slower. OS has to strike 
a balance between the two to ensure that system performance is not hurt due to very less 
primary memory or system costs do not shoot up due to too much primary memory.

Input and output data, user instructions and data interim to program execution need to 
be stored, accessed and retrieved efficiently for high system performance. Once a program 
request is accepted, OS allocates it primary and secondary storage areas as per requirement. 
Once execution is completed, the memory space allocated to it is freed. OS uses many 
storage management techniques to keep a track of all storage spaces that are allocated or 
free.

OPERATING SYSTEM 
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NOTES Input/output management: It manages the input output devices and makes the I/O process 
smooth and effective. For example, it receives the input provided by the user through an 
input device and stores it in the main memory. Then it directs the CPU to process this 
input and accordingly provides the output through an output device such as a monitor.

File management: Data and information is stored on computers in form of files. Managing 
file system to enable users to keep their data safely and correctly is an important function 
of operating systems. Managing file systems by OS is called file management. 

File management is required to provide tools for these file related activities 
•	 Creating new files for storing data

•	 Updating

•	 Sharing

•	 Securing data through passwords and encryption

•	 Recovery in case of system failure

Processor management: A process is a program in execution. The processor is a hardware 
device which processes a sequence of instructions. Assigning of processors to the different 
tasks being executed by the computer is processor management.

It facilitates processor management, where it decides the order for the processes to access 
the processor as well as decides the processing time to be allocated for each process. Besides 
this, it monitors the status of processes, frees the processor when a process is executed then 
allocates it to a new process.

Device Management: The process of implementation, operation and maintenance of a 
device by operating system is called device management. Operating system uses a utility 
software called device driver as interface to the device.

When many processes access the devices or request access to the devices, the OS manages 
the devices in a way that efficiently shares the devices among all processes. Processes access 
devices through system call interface, a programming interface provided by the OS.

Data management: It helps in data management by offering and displaying directories for 
data management. You can view and manipulate files, folders, e.g., you can move, copy, 
name, or rename, delete a file or a folder.

Provides user interface: It acts as an interface between the user and the hardware. It can 
be a GUI where you can see and click elements on the screen to perform various tasks. 
It enables you to communicate with the computer even without knowing the computer’s 
language.

Time Management: It helps CPU in time management. The Kernel OS keeps checking 
the frequency of processes that requests CPU time. When two or more processes that are 
equally important compete for the CPU time, then the CPU time is sliced into segments 
and allocated to these processes in a round-robin fashion to prevent a single process from 
monopolizing the CPU.
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NOTESDeadlock Prevention: Sometimes a resource that is supposed to be shared by two or more 
processes is held by one process due to which the resource cannot continue. This situation 
is known as deadlock. The OS does not let this situation arise by carefully distributing the 
resources among the different processes.

Interrupt Handling: OS also responds to interrupts, which are signals generated by a 
program or a device to seek the attention of the CPU. The OS checks the priority of 
the interrupt, and if it is more important than the currently running process, it stops 
the execution of the current process and preserves this state of CPU then executes the 
requested process. Thereafter the CPU returns to the same state where it was stopped.

3.4 TYPES OF OPERATING SYSTEM

Batch Processing
In batch processing, a number of jobs are collected by the operator offline and when a 
batch of jobs gets collected, they are input to the computer for processing. The jobs are 
then processed without user intervention.

The interaction between a user and the computer does not occur in this system. The 
user is required to prepare jobs on punch cards in the form of batches and submit them 
to the computer operator. The computer operator sorts the jobs or programs and keeps 
similar programs or jobs in the same batch and run as a group to speed up processing. It is 
designed to execute one job at a time. Jobs are processed on a first-come, first-serve basis, 
i.e., in the order of their submission without any human intervention.

For example, in a payroll system, the salaries of employees of the company are calculated 
and generated through the batch processing system at the end of each month.

Advantages of Batch processing operating system:
•	 Repeated jobs can be completed easily without any human intervention.

•	 Hardware or system support is not required to input data in batch systems.
OPERATING SYSTEM 
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NOTES •	 It can work offline, so it causes less stress on the processor as it knows which task 
to process next and how long the task will last.

•	 It can be shared among multiple users.

•	 The timing of batch jobs can set so that when the computer is not busy, it can start 
processing the batch jobs such as at night or any other free time.

Disadvantages of multiprogramming system
•	 It is difficult to program a system because of complicated schedule handling.

•	 Tracking all tasks/processes is sometimes difficult to handle.

•	 Due to high load of tasks, long time jobs have to wait long.

Multiprocessing Operating System
In multiprocessing systems, two or more CPUs are connected together. Therefore, it is 
possible to execute instructions from different programs at the same time. Thus, more than 
one instruction can be executed simultaneously. The idle time of the computer reduces, 
since there is not user intervention in between jobs.

Execute different instructions of the same program. Different multiprocessing systems use 
different types of memory configurations. Some systems have a common main memory 
for all the CPUs, in some systems each system has its own main memory while in still 
others each CPU can have its own memory as well as share a common memory with 
other processors. Multiprocessing systems require a very complex and sophisticated 
operating system to coordinate all the activities of the multiple CPUs and other devices. 
Multiprocessing systems are also very expensive.

There are four major components, which are used in the Multiprocessor Operating Sys-
tem:

•	 CPU – CPU is capable to access memories as well as controlling the entire I/O 
tasks.

•	 IOP – I/P processor can access direct memories, and every I/O processor have to 
responsible for controlling all input and output tasks.

•	 Input/output Devices – These devices are used for inserting the input commands, 
and producing output after processing.

•	 Memory Unit – Multiprocessor system uses the two types of memory modules 
such as shared memory and distributed shared memory.

Advantages of Multiprocessor Operating System:
•	 If due to any reason, any one processor gets fails then do not worry because, entire 

system will do work properly. 

•	 Enhancing the throughput of system, entire system is improved, if couples of 
processors work with getting collaboration.

•	 Multiprocessor systems are cost effective compare to single processor system  in 
long life because this system is capable to share all  input/output devices, power 
supplies system, and data storage centre.
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NOTES•	 Multiprocessor O/S gets high performance due to parallel processing. In this 
system, single job is divided into various same small jobs, and execute them like as 
Parallel nature.

Disadvantages of Multiprocessor Operating System:
•	 Multiprocessor has complicated nature in both form such as H/W and S/W.

•	 It is more expensive due to its large architecture.

•	 Multiprocessor operating system has a daunting task for scheduling processes due 
to its shareable nature.

•	 Multiprocessor system needs large memory due to sharing its memory with other 
resources.

•	 It has more time delay when processor receives message and take appropriate 
action.

Multiprocessor Operating System

Time Sharing Operating System
Time Sharing Operating system or Multitasking Operating system enables multiple users 
located at different terminals to use a computer system and to share the processor’s time 
simultaneously. In other words, each task gets time to get executed, and thus all tasks are 
executed smoothly.It is considered to be a logical extension of multiprogramming because 
both does simultaneous execution but differ in their prime objectives.

Each user gets the processor’s time as they get while using a single system. The duration 
of time allocated to a task is called quantum or time slice; when this duration is over, OS 
starts the next task.
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NOTES Advantages of Time-Sharing Operating System:
•	 It reduces CPU idle time and thus makes it more productive.

•	 Each process gets the chance to use the CPU.

•	 It allowed different applications run simultaneously.

Disadvantages of Time-sharing Operating System:
•	 It requires a special operating system as it consumes more resources.

•	 Switching between tasks may hang up the system as it serves lots of users and 
runs lots of applications at the same time, so it requires hardware with high 
specifications.It is less reliable. 

Distributed Operating System 
It uses or runs on multiple independent processors (CPUs) to serve multiple users and 
multiple real-time applications. The communication between processors is established 
through many communication lines such as telephone lines and high-speed buses. The 
processors may differ from each other in terms of size and function.

The availability of powerful microprocessor and advanced communication technology have 
made it possible to design, develop, and use the distributed operating system. Besides this, it 
is an extension of a network operating system that supports a high level of communication 
and integration of machines on the network.

To make it more simple, distributed systems are a collection of several separate(individual) 
systems which communicate (through a LAN or WAN) and cooperate with each other 
(using some software) in order to provide the users, access to various resources that the 
system maintains. One  important  point to note about distributed systems is that they 
are  loosely-coupled  i.e.; hardware and software may communicate with each other but 
they need not depend upon each other. One example is Solaris Operating System.

Advantages of distributed operating system:
•	 Its performance is higher than a single system as resources are being shared.

•	 If one system stops working, malfunctions, or breaks down, other nodes are not 
affected.
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NOTES•	 Additional resources can be added easily.

•	 Shared access to resources like printer can be established.

•	 Delay in processing is reduced to a greater extent.

•	 Data sharing or exchange speed is high, owing to the use of electronic mail.

Disadvantages of distributed operating system:
•	 Security issue may arise due to sharing of resources

•	 Few messages may be lost in the system

•	 Higher bandwidth is required in case of handling a large amount of data

•	 Overloading issue may arise

•	 The performance may be low

•	 The languages which are used to set up a distributed system are not well defined 
yet

•	 They are very costly, so they are not easily available.

 

Network Operating System
Network Operating system connects computers and devices to a local area network and 
manages network resources. The software in a NOS enables the devices of the network to 
share resources and communicate with each other. It runs on a server and allows shared 
access to printers, files, applications, files, and other networking resources and functions 
over a LAN. Besides this, all users in the network are aware of each other’s underlying 
configuration and individual connections. Examples: Ms Windows Server 2003 and 2008, 
Linux, UNIX, Novell NetWare, Mac OS X, etc.

Advantages of network operating system:
•	 The servers are centralized that can be accessed remotely from distant locations 

and different systems.

•	 It is easy to integrate advanced and recent technologies and hardware in this system.

Disadvantages of network operating system:
•	 The servers used in the system may be expensive.

•	 The system depends on the central location and requires regular monitoring and 
maintenance.
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It is developed for real-time applications where data should be processed in a fixed, small 
duration of time. It is used in an environment where multiple processes are supposed to be 
accepted and processed in a short time. RTOS requires quick input and immediate response, 
e.g., in a petroleum refinery, if the temperate gets too high and crosses the threshold value, 
there should be an immediate response to this situation to avoid the explosion. Similarly, 
this system is used to control scientific instruments, missile launch systems, traffic lights 
control systems, air traffic control systems, etc.

This system is further divided into two types based on the time constraints:

Hard Real-Time Systems:
These are used for the applications where timing is critical or response time is a major 
factor; even a delay of a fraction of the second can result in a disaster. For example, airbags 
and automatic parachutes that open instantly in case of an accident. Besides this, these 
systems lack virtual memory.

Soft Real-Time Systems:
These are used for application where timing or response time is less critical. Here, the 
failure to meet the deadline may result in a degraded performance instead of a disaster. For 
example, video surveillance (cctv), video player, virtual reality, etc. Here, the deadlines are 
not critical for every task every time.

Advantages of real-time operating system:
•	 The output is more and quick owing to the maximum utilization of devices and 

system

•	 Task shifting is very quick, e.g., 3 microseconds, due to which it seems that several 
tasks are executed simultaneously

•	 Gives more importance to the currently running applications than the queued 
application

•	 It can be used in embedded systems like in transport and others.

•	 It is free of errors.

•	 Memory is allocated appropriately.

Disadvantages of real-time operating system:
•	 A fewer number of tasks can run simultaneously to avoid errors.

•	 It is not easy for a designer to write complex and difficult algorithms or proficient 
programs required to get the desired output.

•	 Specific drivers and interrupt signals are required to respond to interrupts quickly.

•	 It may be very expensive due to the involvement of the resources required to work.
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CHECK YOUR PROGRESS

1. 	 What is Operating System? Discuss the functions of Operating System.
2. 	 Discuss Distributed Operating System stating its advantages and disadvantages.
3. 	 Discuss Real-Time Operating system stating its advantages and disadvantages.
4. 	 Discuss Multiprocessing Operating system stating its advantages and 

disadvantages. 
5.	 What is Network Operating System? Discuss Advantages of Network operating 

system.

3.5 WINDOWS OPERATING SYSTEM HISTORY

The history of Microsoft windows can be understood with the help of following table
Year Event
1983 Bill Gates announced Microsoft Windows on November 10, 1983.
1985 Microsoft Windows 1.0 was introduced on November 20, 1985, and was 

initially sold for $100.00.
1987 Microsoft Windows 2.0 was released on December 9, 1987, and was initially 

sold for $100.00.
1987 Microsoft Windows/386 or Windows 386 was introduced on December 9, 

1987, and was initially sold for $100.00.
1988 Microsoft Windows/286 or Windows 286 was introduced in June 1988, and 

initially sold for $100.00.
1990 Microsoft Windows 3.0 was released on May, 22 1990. Microsoft Windows 

3.0 full version was priced at $149.95 and the upgrade version was priced at 
$79.95.

1991 Following its decision not to develop operating systems cooperatively with 
IBM, Microsoft changed the name of their version of OS/2, originally named 
NT OS/2 3.0, to Windows NT. Developed by David Cutler, Windows NT 
was built on a different architecture than IBM’s OS/2 operating system.

1991 Microsoft Windows 3.0 or Windows 3.0a with multimedia was released in 
October 1991.

1992 Microsoft Windows 3.1 was released in April 1992 and sells more than one 
million copies in the first two months of its release.

1992 Microsoft Windows for Workgroups 3.1 was released in October 1992.
1993 Microsoft Windows NT 3.1 was released on July 27, 1993.
1993 Microsoft Windows 3.11, an update to Windows 3.1 was released on December 

31, 1993.
1993 The number of licensed users of Microsoft Windows totaled more than 25 

million in 1993.
1994 Microsoft Windows for Workgroups 3.11 was released in February 1994.
1994 Microsoft Windows NT 3.5 was released on September 21, 1994. OPERATING SYSTEM 
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NOTES 1995 Microsoft Windows NT 3.51 was released on May 30, 1995.
1995 Microsoft Windows 95 was released on August 24, 1995, and sold more than 

one million copies within four days.
1995 Microsoft Windows 95 Service Pack 1 (4.00.950A) was released on February 

14, 1996.
1996 Microsoft Windows NT 4.0 was released on July 29, 1996.
1996 Microsoft Windows 95 (4.00.950B) aka OSR2 with FAT32 and MMX 

support was released on August 24, 1996.
1996 Microsoft Windows CE 1.0 was released in November 1996.
1997 Microsoft Windows CE 2.0 was released in November 1997.
1997 Microsoft Windows 95 (4.00.950C) aka OSR2.5 was released on November 

26, 1997.
1998 Microsoft Windows 98 was released in June 1998.
1998 Microsoft Windows CE 2.1 was released in July 1998.
1998 In October 1998, Microsoft announced that future releases of Windows NT 

would no longer have the initials of NT and that the next edition would be 
Windows 2000.

1999 Microsoft Windows 98 SE (Second Edition) was released on May 5, 1999.
1999 Microsoft Windows CE 3.0 was released in 1999.
2000 On January 4th, 2000, at CES, Bill Gates announced the new version of 

Windows CE will be called Pocket PC.
2000 Microsoft Windows 2000 was released on February 17, 2000.
2000 Microsoft Windows ME (Millennium) was released on June 19, 2000.
2001 Microsoft Windows XP was released on October 25, 2001.
2001 Microsoft Windows XP 64-bit edition (version 2002) for Itanium systems was 

released on March 28, 2003.
2003 Microsoft Windows Server 2003 was released on March 28, 2003.
2003 Microsoft Windows XP 64-bit edition (version 2003) for Itanium 2 systems 

was released on March 28, 2003.
2003 Microsoft Windows XP Media Center edition 2003 was released on December 

18, 2003.
2004 Microsoft Windows XP Media Center edition 2005 was released on October 

12, 2004.
2005 Microsoft Windows XP Professional x64 edition was released on April 24, 

2005.
2005 Microsoft announced its next operating system, code-named “Longhorn,” 

would be named Windows Vista on July 23, 2005.
2006 Microsoft released Microsoft Windows Vista to corporations on November 

30, 2006.
2007 Microsoft released Microsoft Windows Vista and Office 2007 to the general 

public on January 30, 2007.
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NOTES2008 Microsoft released Microsoft Windows Server 2008 to the public on February 
27, 2008.

2009 Microsoft released Windows 7 on October 22, 2009.
2012 Microsoft released Windows Server 2012 on September 4, 2012.
2012 Microsoft released Windows 8 on October 26, 2012.
2013 Microsoft released Windows 8.1 on October 17, 2013.
2015 Microsoft released Windows 10 on July 29, 2015.
2021 Microsoft announced released Windows 11 on October 5, 2021.

3.6 WINDOWS API

The Windows API, informally WinAPI, is Microsoft’s core set of application programming 
interfaces (APIs) available in the Microsoft Windows operating systems. The name 
Windows API collectively refers to several different platform implementations that are 
often referred to by their own names (for example, Win32 API); see the versions section. 
Almost all Windows programs interact with the Windows API. On the Windows NT 
line of operating systems, a small number (such as programs started early in the Windows 
startup process) use the Native API.

Developer support is available in the form of a software development kit, Microsoft 
Windows SDK, providing documentation and tools needed to build software based on the 
Windows API and associated Windows interfaces.

3.7 DRIVERS AND UNICODE

Driver
A driver, or device driver, is a set of files that tells a piece of hardware how to function 
by communicating with a computer’s operating system. All pieces of hardware require 
a driver, from your internal computer components, such as your graphics card, to your 
external peripherals, like a printer

Unicode
Unicode is a universal character encoding standard that assigns a code to every character 
and symbol in every language in the world. Since no other encoding standard supports 
all languages, Unicode is the only encoding standard that ensures that you can retrieve or 
combine data using any combination of languages.

3.8 BASIC COMPONENTS OF WINDOWS

Windows is an essential part of a Computer. It’s the most commonly used Operating 
System all around the world both individually and commercially. Since the beginning of 
the creation of Windows, there are many versions of Windows like Windows XP, Vista, 8, 
10, etc.
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NOTES Windows consists of the following components:

Desktop:
The desktop is the very first screen we see after windows start. Here, we can see folders like 
My Computer, Documents, etc. It is the main working area of many of your computer 
operations. You keep your special files on the desktop so you can access them easily and it 
gives access to other important functionalities as well such as search bar, taskbar, and file 
explorer.

Taskbar:
The taskbar is a simple row at the very bottom of the screen where all currently opened 
files or applications are listed. It helps you select what you want to keep opened and what 
you want to close.

Start Menu:
By clicking the start menu, in the bottom left corner of the screen, a vertical window 
consisting of the recently opened applications and saved locations will pop-up. Although 
the Start Menu was a major component of Windows before Windows 8, It was removed 
from Windows 8 and then brought back in Windows 10.

Maximize/Minimize/Close Buttons:
These buttons are located at the top right corner of our opened documents, and the area 
used to close, minimize or maximize the document window. They help us jump from one 
task to another fast and let us decide either we want to close an application or resize it’s area 
on the screen or just hide it for a few moments.

My Computer:
When we double click on My Computer, We find ourselves looking at a window where we 
can navigate between Computer Drives and Control Panel tools. It also gives us access to 
different drives on our computer and the data which lies in those drives.

My Computer Right Click Menu:
When we right-click on My Computer or any other file or folder, we get a menu where 
we can look into different options related to that specific file, for example, Properties, etc.

Recycle Bin:
When we delete a file or folder, It goes into the Recycle Bin from where It can either be 
restored or permanently deleted from the Computer. Once, a file or folder is deleted from 
the Recycle Bin, It is very difficult to recover it again. Therefore, the utility of the recycle 
bin is very essential to use properly if you deal with important documents and files on a 
day-to-day basis.

Shortcut:
A shortcut creates a button or icon which typically is located on the Desktop. By clicking on 
this Shortcut, We can quickly open the document or application of which it is a shortcut. OPERATING SYSTEM 
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NOTESIt helps us save the tedious task of going to the main directory again and again and saves 
our time.

Mouse Functions:
The mouse is an input device which is essential in the working of a computer. It performs 
several important functions on Windows like Scrolling, Right and Left Clicks, etc. It 
performs another very important function of modern windows which is pointing towards 
different things and giving special instructions whenever needed.

Highlight:
When we have opened a document, we can easily highlight the required portion of our 
document by using Mouse. It is essential for documents and helps keep track of useful 
information.

Copy/Cut/Paste:
These options are one of the most essential components of Windows. The copy is used 
to copy a portion of a document from one document to another or a file or folder from 
one location to another. The paste is used to paste the copied item on the desired location. 
While Cut is used to move an item to our desired location in the computer.

Toolbar:
The toolbar is a simple row where we can see different options to customize the look of our 
opened window. It has two types, Formatting Toolbar, and Standard Toolbar. The standard 
toolbar consists of options like new documents, save a document, etc. While Formatting 
Toolbar consists of options like font size, font type, etc.

Drag/Drop:
Dragging an object means to move an object (file or folder) from one location to another 
and when we reach our desired location, then we can drop the object to that location. It is 
one of the most used features of windows as you have to move files from one location to 
another.

File Extensions:
File extensions are used to define the type of the file. For example, an image file will have 
an extension of .jpg, .jpeg and a Word document will have an extension .docx, .xls, .txt etc. 
You could have different types of extensions and these extensions help you decide the type 
of software that will be used to access these files.

Multitasking:
The term Multitasking means to run more than one file or application on Windows at the 
same time. It is a very important component of Windows which saves our time as well as 
allow us to perform more tasks at the same time.

Virtual Keyboard:
A virtual keyboard is a software through which we can see a keyboard on our screen and use 
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NOTES it by our Mouse. It is mostly used in the cases when your keyboard is not working properly 
or you use windows on a touch device.

Disk Drives:
Disk Drives are drives used to store applications and files. Hard Drives and Floppy Drives 
are used for this purpose. They are very important for your instructions as well as your 
hardware to work properly.

Defragmenting Hard Drives:
Defragmenting a Drive means to erase all the data from that drive. It is also another 
important component of windows as users need to clean up their hard drives from time to 
time and it also comes as a built-in utility.

3.9 CHAPTER SUMMARY

Operating System (OS), Software that controls the operation of a computer, directs the 
input and output of data, keeps track of files, and controls the processing of computer 
programs. Its roles include managing the functioning of the computer hardware, running 
the applications programs, serving as an interface between the computer and the user, 
and allocating computer resources to various functions. When several jobs reside in 
the computer simultaneously and share resources (multitasking), the OS allocates fixed 
amounts of CPU time and memory in turn or allows one job to read data while another 
writes to a printer and still another performs computations. 

Through a process called time-sharing, a large computer can handle interaction with 
hundreds of users simultaneously, giving each the perception of being the sole user. Modern 
computer operating systems are becoming increasingly machine-independent, capable 
of running on any hardware platform; a widely used platform-independent operating 
system in use today on mainframe computers is UNIX. Most personal computers run on 
Microsoft’s Windows operating system, which grew out of and eventually replaced MS-
DOS. There are many other things that are associated with an operating system like the 
concept of drivers, API, Unicode etc. 

The Windows API, informally Win API, is Microsoft’s core set of application programming 
interfaces (APIs) available in the Microsoft Windows operating systems. A driver, or device 
driver, is a set of files that tells a piece of hardware how to function by communicating with 
a computer’s operating system. Unicode is a universal character encoding standard that 
assigns a code to every character and symbol in every language in the world.

3.10 REVIEW QUESTIONS

SHORT ANSWER TYPE QUESTIONS

1.	 Discuss the history of windows operating system.
2.	 Discuss Windows API.OPERATING SYSTEM 
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NOTES3.	 Discuss Drivers and Unicode
4.	 Discuss any 4 components of WINDOWS Operating system.
5.	 Discuss the Terms Multitasking and Virtual Keyboard.

LONG ANSWER TYPE QUESTIONS

1.	 Distinguish between Real Time and Multiprocessing Operating Systems.
2.	 Discuss various Real- Time Systems.
3.	 Discuss about Processor Management and Device Management Functions of OS.
4.	 What do you mean by recycle bin. 
5.	 Discuss various types of operating system.  

3.11 MULTIPLE CHOICE QUESTIONS

1.	 An _______ acts as an intermediary between the user of a computer and 
computer hardware.
a)	 Operative System

b)	 Operating system 

c)	 Operation System

d)	 Job scheduling

2. 	 One of the earliest operating systems was ______, developed by Microsoft for 
IBM PC.
a)	 MS-DOS

b)	 MS-WINDOWS

c)	 MS-WORD

d)	 MAC OS

3. 	 A process is a program in ______.
a)	 Maintenance 

b)	 Solution 

c)	 Execution 

d)	 Development 

4. 	 Operating system uses a utility software called ______ as interface to the 
device.
a)	 Operating system

b)	 Device driver

c)	 Scanner

d)	 Input device

5. 	 In ________, a number of jobs are collected by the operator offline and when 
a batch of jobs gets collected, they are input to the computer for processing.
a)	 Real time OPERATING SYSTEM 
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NOTES b)	 Online 

c)	 Network

d)	 Batch processing 

6. 	 In _______ systems, two or more CPUs are connected together.
a)	 Multiprogramming

b)	 Multitasking 

c)	 Multiprocessing 

d)	 Real Time

7. 	 ______ Operating system connects computers and devices to a local area 
network and manages network resources.
a)	 Network

b)	 Real Time

c)	 Online

d)	 Distributed

8. 	 _______ is a universal character encoding standard that assigns a code to every 
character and symbol in every language in the world.
a)	 Barcode

b)	 Semi-code

c)	 Arc-code

d)	 Unicode

9. 	 The Kernel OS keeps checking the frequency of processes that requests 
_______time. 
a)	 CPU

b)	 GPU

c)	 Memory

d)	 Icon

10. 	 The process of implementation, operation and maintenance of a device by 
operating system is called _________.
a)	 Operating system

b)	 Device management

c)	 Memory management

d)	 Services management 

sssss
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NOTES 4.1 LEARNING OBJECTIVE

After completing this chapter, you will be able to:
•	 Understand the concepts Office Software.

•	 Understand various uses and Features of MS WORD.

•	 Learn and understand the use and features of MS POWERPOINT.

•	 Learn and understand the use and features of MS EXCEL.

•	 Learn the process of MS Office installation.

•	 Understand about Office 365.

4.2 INTRODUCTION

Microsoft Office (or simply Office) is a family of server software, and services developed by 
Microsoft. It was first announced by Bill Gates on August 1, 1988, in Las Vegas. The first 
version of Office contained Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. 
Over the years, Office applications have grown substantially closer with shared features 
such as a common spell checker, data integration etc. Office is produced in several versions 
targeted towards different end-users and computing environments. The original, and most 
widely used version, is the desktop version, available for PCs running the Windows, Linux 
and Mac OS operating systems. Office Online is a version of the software that runs within 
a web browser, while Microsoft also maintains Office apps for Android and iOS.

Microsoft Office is a suite of desktop productivity applications that is designed specifically 
to be used for office or business use. It is a proprietary product of Microsoft Corporation 
and was first released in 1990. Microsoft Office is available in 35 different languages and is 
supported by Windows, Mac and most Linux variants. It mainly consists of Word, Excel, 
PowerPoint, Access, OneNote, Outlook and Publisher applications.

Microsoft Office was primarily created to automate the manual office work with a collection 
of purpose-built applications.

4.3 WORD PROCESSOR

A word processor, or word processing program, does exactly what the name implies. It 
processes words. It also processes paragraphs, pages, and entire papers. Some examples of 
word processing programs include Microsoft Word, WordPerfect (Windows only), Apple 
Works (Mac only), and Open Office.org.
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The first word processors were basically computerized typewriters, which did little more 
than place characters on a screen, which could then be printed by a printer. Modern word 
processing programs, however, include features to customize the style of the text, change the 
page formatting, and may be able to add headers, footers, and page numbers to each page. 
Some may also include a “Word Count” option, which counts the words and characters 
within a document.

While all these features can be useful and fun to play with, the most significant improvement 
over the typewriter is the word processor’s ability to make changes to a document after it has 
been written. By using the mouse, you can click anywhere within the text of a document 
and add or remove content. Since reprinting a. paper is much easier than retyping it, word 
processing programs have made revising text documents a much more efficient process.

The term “text editor” can also be used to refer to a word processing program. However, it 
is more commonly used to describe basic word processing programs with limited features.
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NOTES Toolbar and Their icons 

•	 New: Creates a new document based on normal templates. Shortcut = Ctrl + N.

•	 Save: Saves the active document or templates. Shortcut = Ctrl + S.

•	 Open: Opens an existing document or template. Shortcut = Ctrl + O.

•	 E-mail: It sends the contents of the document as the body of the e-mail message.

•	 Print: Prints the active document using current defaults. Shortcut = Ctrl + P.

•	 Print Preview: Display full page as they are printed. Shortcut = Ctrl + F2.

•	 Spellings: Check the spelling in the active document. Shortcut = F7.

•	 Cut: Cuts the selection and puts it on the Clipboard. Shortcut = Ctrl + X.

•	 Copy: Copies the selection and puts it on the Clipboard. Shortcut = Ctrl + C.

•	 Paste: Places the content of the clipboard at the insertion point. Shortcut = Ctrl 
+ V.

•	 Format painter: Copies the format from a selected object or text and applies to 
other objects or text. Shortcut = Ctrl + Shift + C.

•	 Undo: Reverses the last command, use pull-down menu to undo several steps. 
Shortcut = Ctrl + Z.

•	 Redo: Reverses the action of the Undo button, use the pull-down menu to redo 
several steps. Shortcut = Ctrl + Y.

•	 Insert Table: Insert a table into the document, or make a table of selected text.

•	 Insert an Excel Worksheet: Insert an Excel spreadsheet into the Word document.

•	 Columns: Changes the number of columns in a document.

•	 Zoom: Enlarge or reduce the display of the active document.

Creating A New Document
Getting started with a basic document in Word is as easy as opening a new blank document. 
The steps are as follows:

•	 Click the File tab.

•	 Click New.OFFICE PACKAGES
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Formatting of Document

Change font in your current document
To change the font in the document you are currently working on, find the Styles section 
in the home tab of the ribbon at the top. Right click on the Normal style, and select 
Modify Style.

A new window will appear. Use the Formatting section to make any changes you need. 
Any changes you make to the Normal style will affect the formatting of both you’re in-
text citations and your bibliography. Some common changes include font, size, and line 
spacing. In this example, we have simply changed the font to Times New Roman and 
the size to 12pt. You can also use the dropdown menu in the bottom left corner marked 
Format to make more advanced changes if needed. When you are finished, click OK. OFFICE PACKAGES
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document immediately.

Fonts
Font defines the font, font size, color, highlighting and style.

Paragraph
Paragraph defines justification, line spacing, shading, borders, indentation, formatting 
symbols and list style. 

Saving Documents
Now since we have put in substantial amount of work creating this document, it might 
be a good idea to save it for posterity! In fact, for your entire subsequent document you 
must go on saving your work from time to time, lets us say every 15 minute or so, or after 
completing every section. Doing this ensure that if there is problem like power off or your 
machine has gone into hung state, etc. You only loose minimal work.

•	 Click the File tab.

•	 Choose save.

•	 Type the file name by which you want to save your file.

•	 Specify where you want to save your document. By default, MS Word saves your 
document in the default My Documents folder.

•	 Click on the Save button.

Closing The Document
When you finish working with a document, you would like to close it. Closing a document 
removes it from your computer screen and if you had other documents open, Word displays 
the last document you used otherwise, you see a blank Word window. Here are simple steps 
to close an opened document.

1.	 Choose Close command from the File menu.

2.	 When you select Close option and if document is not saved before closing, it will 
display following Warning box asking whether the document should be saved of 
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3.	 Now it’s up to you if you want to save the changes, then click Save, otherwise click 
Don’t Save button.

Opening The Document
Once you’ve saved a document, you may want to access it again to make changes or print 
it out. This guide explains how to open a saved document in Microsoft Word 2010. Some 
steps may be different in earlier versions of Word, but similar in concept.

1.	 If you already have Microsoft Word opened, click File in the upper left-hand corner 
of the screen. Click Open.

2.	 An ‘Open’ dialogue box will pop up. From this, find your way to the folder in 
which your document is saved. Folders are shown down the left-hand side of the 
dialogue box.

3.	 Once you’ve located your document and clicked on it to select it, its name will 
be shown in the ‘File name’ box at the bottom of the dialogue box. - See more at: 
http. Click Open.

4.	 You can also open a document by navigating through the ‘Start’ menu. Click 
Start. From the menu that now appears, choose Documents. Navigate to find the 
document you’re looking for through your folders and files. Double-click on the 
name of the document you want to open.

Creating Tables
Microsoft Word offers a number of ways to make a table. The best way depends on how 
you like to work, and on how simple or complex the table needs to be.

1.	 Click where you want to create a table.

2.	 Click Insert Table on the Standard toolbar.

3.	 Drag to select the number of rows and columns you want. 

Inserting Columns
1.	 Select the text you want formatted in columns, or place your cursor where you 

want columns to begin.

2.	 On the Page Layout tab, in the Page Setup group, click Columns.

3.	 Click More Columns.
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5.	 In the Apply to list, click selected text or this point forward.

Borders
•	 Select the table to which you want to add border. To select a table, click over the 

table anywhere which will make Cross Icon visible at the top-left corner of the 
table. Just click this cross icon to select the table.

•	 Click the Border Button to display a list of options to put a border around the 
selected table. You can select any of the option available by simply clicking over it.

•	 Try to add and remove different borders like left, right top or bottom by selecting 
different options from the border options.

•	 You can apply border to any of the selected row or column. You can try it yourself.

•	 To delete the existing border, simply select No Border option from the border 
options.
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You use mail merge when you want to create a set of documents, such as a form letter that 
is sent to many customers. Each document has the same kind of information, yet some of 
the content is unique. For example, in letters to your customers, you can personalize each 
letter to address each customer by name. The unique information in each letter comes 
from entries in a data source. Suppose that you need to send to each of your employees a 
letter or e-mail message containing personal tax withholding and salary information.

Creating each letter, e-mail message, or envelope individually would take hours. That’s 
where mail merge comes in. Using mail merge, all you have to do is create one document 
that contains the information that is the same in each copy, and add some placeholders for 
the information that is unique to each copy. Word takes care of the rest.

Mail merge is a software function describing the production of multiple (and potentially 
large numbers of ) documents from a single template form and a structured data source. 
The letter may be sent out to many “recipients” with small changes, such as a change of 
address or a change in the greeting line. MS Word Mail Merge allows a user to send letters 
or documents to many people simultaneously; users simply create one document that 
contains the information that will be the same in each version, and then add placeholders 
for the information that will be unique to each version.

Mail Merge is a useful tool that allows you to produce multiple letters, labels, envelopes, 
name tags, and more using information stored in a list, database, or spreadsheet. When 
performing a Mail Merge, you will need a Word document.

In order to understand how mail merge works you need to examine The elements involved 
in the process. In any mail merge, you’ll deal with three different elements:

Main Document: Form letter, mailing label, envelope, or directory (a single document 
that stores addresses). Information that is identical in each copy, such as the main body text 
of a form letter. You only have to type this information once regardless of how many letters 
you intend to print. Placeholders for unique information. For example, in a form letter, the 
address block and greeting name would be unique in each copy. OFFICE PACKAGES
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(information) that you will use to merge data into a merge document. The data will be the 
parts of the document that varies (names, addresses, etc.). Some examples of data sources 
are Microsoft Word tables, Microsoft Outlook contact list, Microsoft Excel worksheet, 
Microsoft Access database or text files.

Finished Documents: Mail merge documents that can serve as templates for future 
mailings. Merged main documents and data sources that creates your final products (i.e., 
labels, letters, and envelopes). They can then be used as templates for your future mail 
merge needs.

Macros
For many Word users, the term macro strikes fear in their heart, mainly because they do not 
fully understand Word macros and have most likely never created their own. Fortunately, 
creating and running macros isn’t too difficult, and the resulting efficiency is well worth 
the time spent learning to use them.

Simply put, a macro is a series of commands that is recorded so it can be played back, or 
executed, later. There are a couple different ways to create Word macros: The first, and 
easiest way, is to use the macro recorder; the second way is to use VBA or Visual Basic 
for Applications. Further, Word macros can be edited by using the VBE, or Visual Basic 
Editor. Visual Basic and the Visual Basic Editor will be addressed in subsequent tutorials.

There are over 950 commands in Word, most of which are on menus and toolbars and 
have shortcut keys assigned to them. Some of these commands, however, are not assigned 
to menus or toolbars by default. Before you create your own Word macro, you should 
check to see if it already exists and can be assigned to a toolbar.

A macro is a small software program. A program is a series of instruction written by a 
computer language to execute a specific task or tasks. It enables a execution of a series of 
sequential and logical commands without having to give those commands one by one. 
It is a bit like having a very faithful and obedient servant - just showing him how to do 
anything once and he will faultlessly do it again whenever asked to do. In short, macros can 
save you considerable time and efforts by automating your respective tasks.

There are two states using macros:
•	 Creating macros, and

•	 Running macros

While creating a macro, you require two things:
•	 The actual commands/steps which are to be grouped together to run as one, and

•	 Assigning the macro. ‘Assigning’ means specifying to the computer how you would 
prefer to run this macro.

You can create macros in two ways:
•	 Record a series of steps/action using the keyboard and mouse, orOFFICE PACKAGES



93Introduction to Computers

NOTES•	 Type a macro directly into a macro editing window using visual basic programming 
language.

Needless to say, the first option is easier, while the second is more powerful and flexible. 
For creating complex and sophisticated macros you can combine the two approaches - 
record as much as you can and then edit the result using Visual Basic Editor

You can assign a macro as follows:
•	 An option in any menu 

•	 As an icon in a toolbar

•	 To a button

•	 To shortcut key (like function keys)

•	 To key combination

Given below are steps involved in recording a macro.
•	 Choose Record New Macro command from Macro option, in the Tools menu.

•	 Click on the keyword button to define the macro from the keyword. The following 
dialog box would be displayed.

•	 Click in this box ALT and X keys from the keyword together. This is now the 
macro shortcut.

•	 Click on Assign button to assign the macro to these two keys.

•	 Click on Close button to close this dialog box.

You would notice the small macro box on the left side.
•	 Choose a table with the dimension of 4 rows and 5 columns from Insert Table 

icon on the standard toolbar.

•	 Fill in the details of the columns as shown below:

•	 Click on the Stop Recording button to stop recording the macro.

•	 Now presses ALT + X from the keyword together to see whether the macro that 
you have recorded actually works or not. You would notice that a table, just like 
the one that you have made, has been created.

Templates
A template is a special type of document that determines the basic layout of a document and 
can contain various document settings like fonts, page layout, toolbars, special formatting 
and styles. Using different templates is like having pre-printed stationery (examples letter 
heads, voucher forms, fax forms etc.) for different uses. Every word document is based 
on a template. There are two basic type of templates - Global templates and Document 
templates.

Global Templates
Global templates contain setting that is available to all documents. The normal template 
by design is always a Global template. This is because any settings added to the Normal OFFICE PACKAGES
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in word, it is based on normal templates.

Document Templates
Documents templates contain settings that are available only to documents based on that 
template.

Letters, Faxes and Memos are some of the in-built document templates of MS word. If 
a new document is created using letter template, then that document will have all the 
document settings defined in the letter template as well as all the document settings 
contained in any global template.

Words provide a variety of document templates and allow you to modify the existing 
templates. It allows saving your own document design as a new template and the use it to 
create new templates. 

Follow the steps below to save a document as templates:
•	 Create a sample document with the required set of styles.

•	 Choose save as from the File menu.

•	 In the save drop down box choose Document template. All templates have their 
extension name as .DOT unlike word files that have .DOC as their extension 
name.

•	 Type a name for your template. All the templates must be stored in the Template 
directory so that they can be used as a base for creating new documents.

•	 Click on the Save button to save your template.

CHECK YOUR PROGRESS

1. 	 Discuss the Concept of Document Templates.
2. 	 Discuss the concept of Mail-Merge.
3. 	 Discuss the concept of Templates in WORD.
4. 	 Discuss the concept of Tables in WORD.
5. 	 Discuss about Document Templates.

4.4 PRESENTATION WITH POWER POINT

Creating a Basic Presentation
When you make your next presentation — whether it’s to demonstrate a product, outline 
a project, or sell an idea — PowerPoint offers a way to take the focus of you and put it 
where it belongs: on what you have to say! In this skill, you’ll learn how to create a polished 
presentation with minimal efforts.

What is PowerPoint
Use PowerPoint to create electronic slides that can liven up even the most apathetic 
crowd. If you don’t give your presentation electronically, you can create vivid overhead 
transparencies and valuable audience handouts that will rival the most polished presenters. 
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presentations are often used at kiosks at trade shows, but such presentations are seeing 
increased use of Internet.

Creating Your First Presentation
Every PowerPoint presentation consists of a series of slides: text or object displayed on a 
graphic background. You create your presentation by adding text and object to slides.

You’ll go through a series of steps for every presentation you create in PowerPoint:
•	 Create the presentation, entering and editing text, and rearranging slides.

•	 Apply a presentation design. Modify the design if necessary.

•	 Format individual slides if you wish.

•	 Add objects to the presentation.

•	 Apply and modify transitions, animations efforts, and links for electronic 
presentations.

•	 Create audience’s materials and speakers notes.

•	 Rehearse and add slide timings.

•	 Present the presentation.

When you launch PowerPoint, the PowerPoint dialog box opens.

NEW PRESENTATION

General | Presentation Designs Presentations | Web Pages |

Powerpoint Activate the AutoContent Wizard

Using the AutoContent Wizard
The AutoContent wizard works like any of the other wizards in Office 97. You are taken 
through a series of steps with additional question that helps design your presentation. 
In each step, click Next to advance, or back to return to a previous step. If you have just 
launched PowerPoint, choose AutoContent wizard from the PowerPoint dialog box, and 
click OK to start the wizard. If PowerPoint is already running from an earlier presentation, 
or if you closed the PowerPoint dialog box, choose file->New to open new presentation 
dialog box. OFFICE PACKAGES
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one of the type buttons displays a list of topics in the list box.

In the third step, choose a presentation method. If you’re creating slides to support a live 
presentation, choose presentation, informal meetings, handouts. If the presentation will be 
posted on a website or left running at a trade show or large meeting, choose Internet, kiosk.

In the fourth step, specify the output you want. The first four output options determine 
which set of design templates you’ll choose from. For example, tht On-screen presentation 
use colored background; the color overhead templates have no backgrounds; but colored 
graphic images.

In the fifth step, supply the presentation options that will appear on the first slide of the 
presentation: the name of your presentation, your name, and the name of your company 
or department.

Viewing Slides
The PowerPoint window includes a few features that aren’t included in other Office 97. 
The AutoContent wizard had just closed and the presentation has been opened in Outline 
view, one of five ways to view a presentation.

Each view provides a different way to look at work with your presentation. In Outline 
view, presentation text appears in the document window. The standard and Formatting 
toolbars appears above the document window, and a vertical outlining toolbar is at the left 
edge of the window. You can see the contents of several slides at once in the outline and 
edit text as you would in word. Use the scroll bars through the outline.

Slide view lets you work with slides one at a time. If you double-click a slide’s icon in outline 
view or a slide in slide sorter view, you move to slide view. In this view, use the PgUp and 
PgDn keys or previous slides and next buttons (at the bottom of the vertical scroll bar) to 
move between slides. You can edit text or place objects on slides and immediately see the 
impact of your changes and additions. Some users prefer to do all their editing in slide 
view.

Slide sorter view allows you to see a screen full of slide at one time. You can swap slides 
around, delete around, and add special effects. You cannot edit text or place object on 
slides in this view.

In Notes page view, you can add speakers’ notes containing more detailed information to 
your slides. The Drawing toolbar opens automatically in Slides and Note page views.

Working in Outline View
In the early stages of your presentation’s development, you’ll probably want to work in 
outline view, which provides you with the most editing flexibility and allows you to see the 
texts from multiple slides at one time.

In the outline, each slide has a number in the left margin and a slide icon. Slides that only 
content text have a plain white icon next to them.
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next to the slide icon. Indented below the title is the body text.

Entering and Editing Text
You will want to replace the content of the slides created by the wizard before making 
substantial formatting changes. To change the content, just double-click on the line or 
single-click in the left margin to select the line u want to change and type the new text. 
(In the left margin, the cursor changes to a four-headed arrow because you can drag the 
selected line to move it.) Each level in the outline has a different size or shapes of bullet, 
font size, and font attributes. There are five levels below the slide title.

Checking Spelling
PowerPoint includes two spelling features. Auto Spell automatically underlines misspelled 
word that you enter. Right-click on the underlined word to see suggested correct spelling. 
Click the spelling button on the Standard toolbar to check for an entire presentation.

Using Find and Replace
Use PowerPoint’s find feature to locate a next string in your presentation. Choose Edit 
Find from the menu bar to open the Find dialog box.

In the Find What text box, enter the text string that you want to find, and then set the 
Find options.

Turn on the Match case option to only find those text strings in the presentation that 
exactly match the string you entered. If you entered Review, and turn to match case, find 
will locate Review but not review or REVIEW. To find Review but not Reviews, turn on 
Whole Words Only.

If you use Find in slide, outline, or Note Page View clicking Find Next will move to and 
select the next text string that matches the Find What string. In Slide Sorter view, there 
isn’t a Find Next button; instead, the button is Find all. Clicking Find All select all the 
slides that contain Find What string.
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You can replace each occurrence of one text string with another. For example, you’ve created 
a presentation for the Three-Year Project. The Three-Year Project has just been renamed 
Building sales Project. You can find every occurrence of Three Years Project and change it 
to Building sales Project. Choose Edit Replace, or if the Find dialog box is already open, 
click the Replace button in the Find dialog box. Enter the string you want to find in Find 
what and the string you want to replace it with in Replace with.

To replace all the occurrences, click replaces All. Or you can work through the replacement 
one at a time. To find the next occurrences, click Find Next. Click replaces to make the 
replacement, and Find Next to move to the next possible replacement. When you’ve 
replaced all occurrence of the text string, a message box appears to let you know that 
PowerPoint has searched the entire presentation and there aren’t any more occurrences of 
the text string. A similar dialog box opens to let you know if the text string you entered in 
Find what doesn’t appear in the presentation.

Working in Slide View
It’s easy to put too much on one slide in Outline view, so that some lines of text run off the 
button of the slide. If you prefer, you can edit and format slides in slides view. Although 
you can work with only one slide at a time, Slide view gives you a better feel for how the 
slide will actually look when complete.

Most slides include two text boxes, one for the title and one for the body text. When you 
click on the title or body, a frame appears around the text box. You can point to the frame 
and drag the text box to another location on the slide. To format the text in the box, select 
the text by clicking or dragging as you would in outline view, then change formats using 
the Formatting toolbar or Format menu.

Using the Slide Sorter
In Slide Sorter view, you work with entire slides. You can’t rearrange the text on a slide, but 
you can move or copy entire slides.

Click once on a slide to select it, or select multiple slides by holding shift while selecting. A 
selected slide has a dark border around it. To move a selected slide, drag the slide towards 
its new location. A gray vertical line will appear. Drag-and-drop to move the line, and the 
selected slide, to the new location. To copy a slide, hold the Ctrl key on the keyword while OFFICE PACKAGES
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select the slide then press the Delete key on the keyboard.

Adding Notes to the Notes Page
Notes page view, lets you keep separate notes about the slides in a presentation. You can 
use the Notes Page for speaker notes during a presentation, but u can also use them to keep 
track of other information about particular slide as you’re creating a presentation: data that 
needs to be verified or alternative information or wording you’ve considered adding to the 
slide.

Notes Page view opens with a view of a single page. The slide is at the top of the page; 
the button half of the page is a single text box where you can type your notes. Change the 
Zoom percentage so that you can actually see what you’re typing, and then clicks in the text 
box and enter your notes. When you’re finished entering notes for a slide, you can use the 
Previous Slide and Next Slide buttons to move to another slide.

Building Presentations

Their Ways to Create Presentation
The benefit of the AutoContent Wizard is that it helps you to develop your content. If 
you’ve already decided what should be in your presentation, you don’t need to use the 
Wizard. 

There are other ways you can create a presentation:
•	 Using a design template, which gives you a “look” without burdening you with 

text to alter or delete Borrowing the design from an existing presentation, which 
is useful if the presentation in your department should share a common design.

•	 “From scratch”: entering your text first, then applying a design

•	 Importing and modifying an existing Word outline

You can always apply another design template or presentation design to an existing 
presentation. 
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You can use the design elements from any presentation or templates in a new presentation. 
To create a presentation using a design saved as a template, either choose template in the 
dialog box that opens when you launch PowerPoint, or choose File New from the menu 
bar to open the New Presentation dialog box. The Presentation tab includes AutoContent 
Wizard and the templates that include content. The Presentation tab displays templates. 
Select a design template to see the sample title slide in the preview area. Double-click on a 
design template or click OK to choose the selected template.

To create a Presentation without a design, choose Blank Presentation when you Launch 
PowerPoint, or choose Blank Presentation from the new dialog box.

Selecting Slide’s Layouts
If you begin a presentation with a design template or choose to create a blank presentation, 
the New Slide dialog box opens.

In the New Slide Dialog box, you select an Auto Layout for each new slide. When you click 
the thumbnail for the layout, a description appears. No choice that you may in this dialog 
box carved in stone: you can always change a slide’s layout. Notice that there is a scroll bar 
in this dialog box; there are other layouts you might want to look at. Select the title Slide 
layout for the first slide in the presentation. After you’ve selected the slide layout, click the 
title text box and enter your title. (If you prefer, you can switch to outline view and enter 
all of the text for this slide.) Using Slides from an Existing Presentation

Applying a design uses a presentation’s background, fonts, and formatting without any 
of the content. You can take entire slides from an existing presentation and add them to 
another presentation using the slide finder. Choose Insert Slides from Files to open the 
Slide Finder. Click the Browse button and select the file that contains the slide you want 
to add to your presentation, and then click the display button to add thumbnails of the 
slides to the slide Finder.

Inserting Slides from other Presentation
•	 Position the insertion point (in outline view) or slide selector (in slide sorter view) 

where you want to insert slides.

•	 Choose Insert Slides from files to open the Slide Finder.

•	 Select the presentation that includes the slides you want to insert.

•	 Click the Display button to view the slides.

•	 Select the slide (s) you want to insert then click insert to insert the slide in the 
current presentation. If you want to insert all the slides click the insert all the 
button.

•	 The Slide Finder remains open, so you can move a different location in the active 
presentation and insert other slides.

•	 When you are finished inserting, close the Slide Finder.
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Changing the Color Scheme
It is easiest to choose one of PowerPoint’s design to establish the primary background for 
your presentation, then change the background or colors to meet your specifics need. 
Consider the purpose of your presentation when changing color. For overheads, the lighter 
the better. Dark background work well for on-screen presentation, but if you need to show 
a presentation with room light on, choose a light background and dark text. Choosing 
Format slide color scheme dialog box. (You can’t change the color scheme in a blank 
presentation; you must have already applied a design.)

The dialog box has tabs for standard and custom color schemes. The standard color 
schemes include the current color scheme, at least one alternate scheme, and one black-
and-white choice. You can choose to apply a scheme to the current slide or to all the slides 
in the presentation. To see how a slide will look, click the preview button. (You’ll have to 
move the dialog box out of the way to see the impact on the slide.) When you’re satisfied, 
click Apply to change the selected slide or slides or apply to all to change every slide in the 
presentation.

Steps for Applying a Color Scheme
•	 Open the Design tab by clicking it on the Ribbon.

•	 Select a color scheme to use.

•	 Click the Theme Colors button and then choose Create New Theme Colors.

•	 Click the button for the color you want to change.

•	 Repeat step 3 for any other colors you want to change.

•	 Choose preview to see the changes before applying them. Click Apply to or Apply 
All to apply the scheme to the current slide or all slides in the presentation.

Adding Slide Footers
The master slide includes a footer area. You can have a data, slide number, or other 
footer appear on every slide by changing it in the master. Choose View => Headers and 
Footers from the menu bar to open the dialog box. For Date and Time, choose Update 
Automatically or fixed to add a changing or fixed date to each slide. Click the slide number 
text box to show to the slide number. If you want footer text, click the Footer text box and 
type the footer in the text box.

Steps for Setting Slide Footer
•	 Choose View Header and Footer to open Header and Footer dialog box.

•	 Turn on items you want displayed on all slides.

•	 Turn on Don’t show on Title Slide if you don’t want the footer to appear on the 
first slide in the presentation.

•	 Choose Apply to apply to the active or selected slide, or Apply to All to apply to 
every slide in the presentation. (If you open the dialog box from the Slide Master, 
you can only choose Apply to All.)
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•	 Choose Format Custom Background to open the custom background dialog box.

•	 Click the Omit Background Graphics from Master Check box to remove the 
background graphics from a particular slide or all the slides.

•	 Click the drop-down arrow next to the blank text box to select the fill option that 
you want to change. 

•	 Choose from shadowed, patterned, or textured fill, or choose a picture from the 
Clipart folder. To return to the original fill, Choose automatic from the drop-
down list. Checking Presentation Styles

•	 Click the option button to open the Style Checker Option dialog box. In the 
punctuation page, you can have the checker notify you if some title or body text 
doesn’t match the case.

You select in the case drop-down list. Or you can turn off the Checking of title and body 
text case. In the End Punctuation section, you can have the checker remove, add, or ignore 
punctuation at the end of titles or in the body.

On the visual clarity page, set option for the maximum number of fonts, minimum font 
size, and number of points per slide that should be included in the presentation. When you 
have set all the option, close the dialog box and choose start to begin Style Checker with 
the settings you selected.Steps for Checking Style.

Steps for Adding Clip Art to a Slide
•	 In slide view, Choose Insert Picture <=> Clip At or double-click a Clip Art 

placeholder to open the Clip Art folder or the Microsoft Clip Art Gallery.

•	 Select the picture you want to insert and click Insert.

Steps for Recoloring Clip Art
•	 In slide view, select the Clip Art object

•	 Click the Recolor picture button on the Picture toolbar.OFFICE PACKAGES
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NOTES•	 Choose to change Colors or Fills.

•	 Check and choose a new color you want to change.

•	 Click Preview to preview the change in the slide; Click OK to apply the changes. 
Sound and Video.

PowerPoint includes sounds and video you can play during you slide shows. Some sounds, 
like the typewriter or laser sound, are included are included on the Animation Effects 
toolbar. Other sounds, music, and videos are in Microsoft Clip Art Gallery.

Steps for inserting a Sound or Video File
1.	 In slide view, move to the slide you want to add an object to.

2.	 Choose Insert >=> Movies and Sounds Sound from Gallery or Video from Gallery.

3.	 In the Clip Gallery, select the sound or video you want to add. Click the play 
button to preview the selected sound or video.

4.	 Click Insert to insert the object or place a sound icon or video object on the slide.

5.	 To play the sound or video, double-click the icon or object in the slide show view.

Applying Transition, Animation Effects and Linking

An electronic presentation, or slide show, is a presentation displayed on a computer screen 
or projected with an LCD projector. Since slides are “changed” by the computer rather 
than by a hand, you can add computerized special effects to a slide show that aren’t possible 
when you use overheads for a presentation. A transition is a special effect added to the slide’s 
initial appearance on screen. The slide can appear from the right, dissolve in gradually, or 
fade through the background of a previous slide. Some of the design templates also include 
animated features: for example, one of the background object may streak into place. OFFICE PACKAGES
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NOTES Individual slides can include animation — different steps used to construct the slide, one 
placeholder at a time. For example, the slides can appear with a title only, one bulleted 
points can be added. Add transition in Slide Sorter view using the tools on the Slide Sorter 
toolbar. While you can add preset text animation in the slide sorter, you can’t animate 
other object, so you’ll generally want to work with animation in slide view.

Setting Transition Speed and Sound
Each type of transition had a default speed. The default for wipes, for example, is fast. You 
can change the speed for transitions, choose a different transition, or add sound effects to 
accompany a transition in the Slides Transition dialog box.

4.5  EXCEL

It is important to know about the interface of an application to work in any environment 
with ease. Excel 2010 provides an excellent user interface based on the task yow need to 
perform.

When you open Excel 2010, the application display two windows, one within the other. 
The outer window is the application window that allows you to interact with Excel 2010. 
The inner window is the workbook window that appears within the application window. 
The inner window is used to work with data.

An Excel file is also referred as workbook. It acts as a repository of related worksheets. A 
workbook has three worksheets by default: Sheet 1, Sheet2 and Sheet3. You can also add 
or remove worksheets in an Excel workbook.
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NOTESThe Excel 2010 application window includes the following components:
•	 File Tab: Provides common options that are used while working with Excel.

•	 Quick Access Toolbar: Provides access to frequently used commands in the 
application.

•	 Title Bar: Displays the name of the current workbook. It integrates the Quick 
Access Toolbar within it. The title bar is placed above the Ribbon panel.

•	 Ribbon: Displays the commands that you need to complete a task.

•	 Formula Bar: Displays the contents of the currently selected cell in a worksheet. In 
addition, it allows you to type the required formula or function.

•	 Task Pane: Displays various options for a selected command on the Ribbon panel. 
It appears on an as-needed basis.

•	 Status Bar: Contains features such as the dynamic zoom slider and the document 
layer option.

The Excel 2010 workbook window includes the following components:
•	 Cell: Is an intersection of a row and a column. Cells can contain various types of 

data. A cell is referred by the name of the column and the number of the row. For 
example, the first cell Al is in column A and row 1.

•	 Worksheet: Is a work area comprising of rows and columns. It is used to store 
data. A worksheet consists of 16,384 columns and 1,048,576 rows. Rows are 
referred by the letter A continuing to letter Z. After 26th column (column Z), 
headings become double letters, from AA to AZ. After AZ, the letter pair starts 
again with columns BA through BZ, and so on, until all 16,384 columns have 
alphabetical headings, ending at XFD. Row heading begin with 1 and continue 
through 1,048,576.

•	 Sheet Tab Bar: This bar appears at the bottom of the workbook. It consists of the 
following components:

•	 Sheet Tabs: These tabs help you to move between multiple worksheets in a 
workbook. To move to a particular worksheet, you need to click the corresponding 
Sheet tab.

•	 Tab Scrolling Buttons: These buttons appear to the worksheet tabs. They allow 
you to scroll the display of the worksheet tabs one at a time. In addition, they help 
you to directly move to the first or last worksheet within a workbook.

•	 Insert Worksheet Tab: This tab allows you to add new worksheets to the workbook. 
It appears to the right of the worksheet tabs.

•	 Horizontal Scroll Bar: This bar serves as a tool to view the left or the right part of 
worksheet that is not displayed on the screen.

•	 Vertical Scroll Bar: The bar serves as a tool to view the top or the bottom part of 
the worksheet that is not displayed on screen.
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NOTES The following figure shows the various components of the Excel 2010 window. 

 

Exploring the File Tab
The File tab is placed at the top-left comer of the Excel interface. When you click File tab, 
the backstage view appears.

In addition to a set of options, the Backstage view displays additional information and 
properties of the worksheet. The Backstage view is portioned into three panes; left, centre, 
and right. The left pane consists of a set of options. The centre and the right pane display 
the section corresponding to the selected option in the left pane.

The Backstage view contains the following options:
•	 Save: This option is used to save a worksheet.

•	 Save As: This option enables you to save a copy of a worksheet. In addition, it 
enables you to 

•	 save a worksheet in different formats.

•	 Open: This option enables you to open a worksheet stored on your computer.

•	 Close: This option is used to close the currently active worksheet. In case you have 
not saved your worksheet, a Microsoft Excel message box appears, prompting you 
to save your worksheet.

•	 Info: This option displays additional information and properties of the worksheet. 
In addition, it enables you to recover the unsaved workbooks, protect your OFFICE PACKAGES
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NOTESworksheet, and check for issues. Moreover, it enables you to manage versions of 
the worksheet.

•	 Recent: This option displays all the recent workbooks in the centre pane along 
with the location of the recent workbook in the right pane. In addition, it provides 
the functionality to recover unsaved workbooks.

•	 New: This option enables you to create a new workbook.

•	 Print: This option allows users to preview and print worksheets.

•	 Save and Send: This option allows you to send a copy of your workbook to 
other users. You can send your workbook either through e-mail or through fax. 
In addition, this option lets you share your workbook with other people using 
SharePoint. Moreover, this option enables you to save your worksheet to the Web. 
It also enables you to save your worksheet as PDF/XPS.

•	 Help: This option provides you help on the Microsoft Office 2010 related queries.

•	 Options: This option enables you to customize the Ribbon and the Quick 
Access Toolbar. Moreover, it enables you to customize the display settings of 
your workbook. This option lets you change the Word correcting and formatting 
option. In addition, it allows you to manage the Add-ins and the privacy settings 
of the worksheet.

•	 Exit: This option lets you save and exit the Excel application.

Exploring the Status Bar
The Status bar is placed at the bottom of the Excel 2010 window. It is a bar that displays 
options such as page umber and word count.

In addition, the Status bar provides additional features such as the dynamic zoom slider 
that help you to zoom in or zoom out the worksheet. The Status bar is shown in the 
following figure.

You can modify the information displayed on the status bar by right-clicking anywhere 
on the Status bar. This displays the Customized Status Bar pop-up-menu, as shown in the 
following figure.
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NOTES By default, the Status bar includes the following components:
•	 Zoom level: This button allows you to select or set the zoom percentage by using 

the zoom dialog box.

•	 Zoom in: This button enables you to have an enlarged view of the contents of a 
worksheet.

•	 Zoom Out: This button enables you to view the contents of a worksheet in a 
smaller size.

•	 Zoom Slider: This slider enables you a quickly magnify, in other words enlarge, or 
reduce the size of the worksheet to the required size.

•	 Views: These buttons display the different views of a workbook. Normal, page 
Layout, and Page Break Preview are the three default views.

Exploring the Quick Access Toolbar
The Quick Access Toolbar provides access to frequently used commands of Excel 2010. It is 
a part of the title bar. By default, the toolbar displays the save, undo, and redo commands.

Customizing the Quick Access Toolbar
Along with the default commands, frequently used commands can be added to the Excel 
2010 interface by customizing or modifying the Quick Access Toolbars. In addition, you 
can customize the Quick Access Toolbar to hide those commands that you commonly do 
not use. To add the commands to the Quick Access Toolbar, 

You need to perform the following steps:
•	 Click the Customize Quick Access Toolbar button present on Quick Access 

Toolbar. The Customize Quick Access Toolbar pop-up-menu appears.

•	 Select the More commands option from the pop-up-menu. The Excel options 
dialog box appears.

•	 Select the desired category from the Choose commands from drop-down list in the 
Customize the Quick Access Toolbar section.

•	 Select the command that you want to add to the Quick Access Toolbar from the 
list box below the Choose commands from drop-down list.

•	 Click the ADD button. The selected commands appear in the list box below the 
Customized Quick Access Toolbar drop-down list.OFFICE PACKAGES
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NOTESExploring the Ribbon
The Ribbon is a component of the Excel 2010 window. It contains several task-specific 
commands that are grouped under various commands tabs. Additionally, the Ribbon 
provides instant access to the Excel 2010 help system, allowing you to search information 
easily. The Ribbons has various commands tabs.

The following tab appears on the Ribbon:
•	 Home

•	 Insert

•	 Page Layout

•	 Formulas

•	 Data

•	 Review

•	 View

Home Tab
The Home tab helps in performing clipboard operations, such as cut, copy, and paste and 
basic text and cell formatting.

The Home tab includes the following groups:
•	 Clipboard: Provides options to cut copy and paste content. In addition, it provides 

an option to format text.

•	 Font: Provides tools to format text.

•	 Alignment: Provides option to align, indent, and wrap text, and merge and 
unmerge cell. In addition, it provides an option to rotate text.

•	 Numbers: Provides option to specify number formatting for cells.

•	 Style: Provides options to conditionally format cell and tables, and modify styles.

•	 Cells: Provides option to insert and delete rows and columns. In addition, it 
provides options to format cells and worksheet.

•	 Editing: Provides options to find, select, sort, and filter data. In addition, it 
provides to sum, fill series, and clear option.

Insert Tab
The Insert tab is used to insert objects such as tables, charts, illustrations, text and hyperlink 
in a worksheet 

The Insert tab includes the following groups:
•	 Tables: Provides options to insert tables and pivot tables.

•	 Illustrations: Provides options to insert pictures from various locations, such as a 
file, ClipArt or the SmartArt gallery.

•	 Charts: Provides options to insert several types of charts in a worksheet. OFFICE PACKAGES
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NOTES •	 Sparkline: Provides options to insert a tiny chart that fits in a cell, to visually trends 
in data.

•	 Filter: provides option to add slicer in a pivot table.

•	 Links: Provides options to insert a hyperlink into a worksheet.

•	 Text: Provides options to insert a text box, WordArt graphics, objects, header and 
footer, and signature lines.

•	 Symbols: Provides options for adding symbols and equations.

Page Layout Tab
The Page Layout tab is used to specify the page settings, layout, orientation, margins, and 
other related options such as themes and gridlines.

The Page Layout tab includes the following groups:
•	 Themes: Provides options to apply preset color, font, and present themes to a 

workbook.

•	 Page Setup: Provides options to customize a worksheet for printing, such as page 
margin, size, orientation, and background.

•	 Scale to Fit: Provides options to adjust the width, height, and scale of the worksheet 
that needs to be printed.

•	 Sheet Options: Provides options to display custom views, gridlines, and headings.

•	 Arrange: Provides option to arrange, align, group, order, and route shaped on a 
worksheet.

Formulas Tab
The Formulas Tab helps in working easily with formulas and functions.

The Formulas Tab includes the following groups:
•	 Function Library: Provides options to insert functions, such as financial function 

and trigonometric functions.

•	 Defined Name: Provides options to name the cell so that they can be referred in 
the formulas by their names.

•	 Formula Auditing: Provides functions to check for errors and to trace action. It 
also provides the Watch window that allows you to constantly track specific value.

•	 Calculation: Allows you to specify whether calculations within a workbook should 
be manual or automatic.

Data Tab
The Data tab helps in data-related-tasks, such as setting up connection, with external data 
sources and importing data within Excel worksheet.
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NOTESThe Data tab includes the following groups:
•	 Get External Data: Provides options to access and import data from external 

locations such as Microsoft Office Access 2010, and the Internet.

•	 Connections: Provides options to add, view, and work with connections to data 
sources.

•	 Sort and Filter: Provides options to perform data analysis.

•	 Data Tools: Provides tools to convert text or tables and remove duplicate values.

•	 Outline: Provides options to group cells and organize data into an outline for each 
group to provide additional clarity.

The Review Tab
The Review tab helps in accessing tools that can be used for reviewing an Excel worksheet. 
It also enables you to insert comments, ensure that the language used in the worksheet is 
correct, convert text to a different language, and share your workbook and worksheets.

The Review tab includes the following groups:
•	 Proofing: Provides proofing tools such as spelling, thesaurus and translate.

•	 Language: Provides option to translate the words used in the worksheet.

•	 Comments: Provides options to add comments and move between them.

•	 Changes: Provides option to accept or reject the changes made in a workbook or 
worksheet.

The View Tab
The View tab is used to view a worksheet in different views. In addition, it provides options 
to show or hide the element of a worksheet window, such as a ruler or gridlines.

The View tab includes the following groups:
•	 Workbook Views: Provides options to display a worksheet in different type of 

views, such as the normal and Page Layout view.

•	 Show: Provides options to display or hide elements such as the ruler, gridlines, and 
formula bar in the worksheet.

•	 Zoom: Provides options to magnify a particular selection or the whole worksheet.

•	 Window: Provides options to arrange and size an application window.

•	 Macros: Provides options to perform a repetitive task with ease by recordings 
macros.

Customizing the Ribbon
You can customize the Ribbon the way you want it. To customize the Ribbons, you need 
to perform the following steps:

•	 Open MS Office Word 2010.

•	 Choose File —* Options —» Customize Ribbon. OFFICE PACKAGES
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NOTES Under Main Tabs, select the tab that you want the new Ribbon tab to come before.

•	 New group is selected under New Tab.

•	 Choose commands from section and click ADD button.

•	 Right click the New Tab from Main Tab.

•	 Select Rename option from pop-up-menu.

•	 Type name in Display name text box.

•	 Click OK.

•	 Similarly rename New Group option.

•	 Click OK.

4.6 MICROSOFT OFFICE INSTALLATION 2013

Connect to Server

1.	 Click on the Windows icon to open the Start menu.

2.	 Type \\software.oc.edu\dist\microsoft\office\2013 in the search box at the bottom 
of the screen, and press enter.OFFICE PACKAGES
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NOTES3.	 Launch the Installation

Double-click Setup to launch the installer.

Allow Changes

Click Yes to allow the program to make changes to your computer.
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NOTES Accept the Software License Terms

1. 	 Check the box to I accept the terms of this agreement

2. 	 Click Continue

3. 	 Install Now
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NOTESClick Install Now

Wait

This could take several minutes.

Finished!
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NOTES This program will now be located in your Start Menu. Click Close.

Enter the Product Key

Find Product Key

The product key is located in the file called  License  in the same folder that holds 
the setup file \\software.oc.edu\dist\microsoft\office\2013

Follow the instructions below to enter the product key for Microsoft Office 2013. 

Open All Programs

1.	 Click on the Windows icon to open the Start menu.

2.	 Click on All Programs

Open Any Microsoft Office 2013 Program
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NOTESClick any Microsoft Office 2013 program to open it. This example will use Microsoft 
Word.

Use Recommended Settings

1.	 Select Use recommended settings

2.	 Click Accept

Allow Changes

Click Yes to allow the program to make changes to your computer.
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NOTES Find Account

1.	 Select Open Other Documents

2.	 Select Account

Click Change Product Key
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NOTESEnter Product Key

1.	 Enter the product key found in the License file (view Find Product Key step above).

2.	 Click Install

Success!

You have successfully installed Office 2013 on Windows 7.

4.7 MICROSOFT OFFICE 365

Launched in 2001, Office 365 is a cloud-based, subscription model version of Microsoft’s 
popular productivity suite Microsoft Office. Office 365 contains the same core applications 
as traditional versions of Office, including Word, Excel, PowerPoint, Outlook, OneNote, 
and depending on the plan purchased, may also include other apps and services such 
as Publisher, Planner, OneDrive, Exchange, SharePoint, Access, Skype, Yammer, and 
Microsoft Teams.

There are a number of different packages available when licensing Office 365, including 
versions for personal use, multi-user households, students, businesses, nonprofits, and 
education institutions.

There are also online- and mobile-only versions of Office, known as Office Online, through 
which users can get access to feature-limited versions of Office apps for free.

Although Office 365 does provide the actual Office package, this is merely a fraction of the 
features on offer. The real benefit is frequently underrated or even overlooked entirely. The 
Office 365 creates an integral and strategic direction within the enterprise. Besides features 
such as  Exchange Online,  SharePoint Online  or  Skype for Business Online,  Office 
365 enables security functions, data analyses, project work, real-time communication, 
social networks and much more.

How is Office 365 different from previous versions of Office?
Office 365 is a subscription-based service, meaning rather than buying a copy of the suite 
outright for a one-time, up-front cost, users instead pay a monthly subscription fee to 
access the service at a level of their choosing.
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NOTES With Office 365’s subscription-based model, users always have access to the latest version, 
as the platform is updated at Microsoft’s end, whereas as perpetual, on premise users would 
have to buy a new copy of the latest edition to be able to use new features.

Office 365 is also built as a cloud-first application; although desktop versions of its apps are 
available with certain plans, it’s designed to be used online. All applications, services, and 
data generated by Office 365 are hosted on Microsoft’s servers.

Users don’t need to install software or maintain any hardware on which to run it. Office 
365 also comes with email hosting, and cloud storage space, so users can host their files 
online and have access to them wherever and whenever they need to, from any device that 
connects to the internet.

Being cloud-based, Office 365 also comes with a host of features not available in previous, 
perpetual versions.

4.8 CHAPTER SUMMARY

Microsoft Office (or simply Office) is a family of server software, and services developed by 
Microsoft. It was first announced by Bill Gates on August 1, 1988, in Las Vegas. The first 
version of Office contained Microsoft Word, Microsoft Excel, and Microsoft PowerPoint.

Microsoft Office 2010 programs have always been the most popular productivity software 
that is used by majority of the world population. Microsoft word has been one of the most 
useful ones and it provides a wide range of functionality and purposeful uses.

Microsoft Word 2010 is the most recent Word processing program and it is one of the 
mostly used one of the Microsoft Office Pack. Microsoft Word 2010 is highly sophisticated 
and it is used for composing letters, reports, academic papers, references, CVs, essays, term 
papers, articles, novels and many other things. You can print out what you produce, design 
it to make more attractive, add pictures, tables and list fact and figures by using graphics. 
You can save the word office document you have produced on the hard drive for later use 
or to edit further in future.

With the release of Office 2010, Microsoft made several improvements to the Office suite 
that includes Word, Excel, PowerPoint, Access, and Outlook. 

Use PowerPoint to create electronic slides that can liven up even the most apathetic 
crowd. If you don’t give your presentation electronically, you can create vivid overhead 
transparencies and valuable audience handouts that will rival the most polished presenters. 
With PowerPoint, you can create presentations that run automatically. Automated 
presentations are often used at kiosks at trade shows, but such presentations are seeing 
increased use of Internet. It is important to know about the interface of an application to 
work in any environment with ease. Excel 2010 provides an excellent user interface based 
on the task yow need to perform.
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NOTESWhen you open Excel 2010, the application displays two windows, one within the other. 
The outer window is the application window that allows you to interact with Excel 2010. 
The inner window is the workbook window that appears within the application window. 
The inner window is used to work with data.

Launched in 2001, Office 365 is a cloud-based, subscription model version of Microsoft’s 
popular productivity suite Microsoft Office. Office 365 contains the same core applications 
as traditional versions of Office, including Word, Excel, PowerPoint, Outlook, OneNote, 
and depending on the plan purchased, may also include other apps and services such 
as Publisher, Planner, OneDrive, Exchange, SharePoint, Access, Skype, Yammer, and 
Microsoft Teams.

4.9 REVIEW QUESTIONS

SHORT ANSWER TYPE QUESTIONS

1.	 Discuss about Ribbon of MS EXCEL.
2.	 Discuss the concept of Status Bar in MS EXCEL.
3.	 How can we change the color scheme in Power Point.
4.	 Discuss the various ways to Build a Presentation.
5.	 How is Office 365 different from previous versions of Office?

LONG ANSWER TYPE QUESTIONS

1.	 Discuss the procedure of installing MS-OFFICE.
2.	 Discuss the File tab in Excel.
3.	 Explain the concept of Applying Transition, Animation Effects and Linking.
4.	 Discuss the File Tab of excel.
5.	 Discuss the procedure of adding footer in a presentation

4.10 MULTIPLE CHOICE QUESTIONS

1. 	 _________ is a family of server software, and services developed by Microsoft.
a)	 Microsoft Office

b)	 Microsoft Outlook

c)	 Microsoft Office

d)	 Microsoft Excel

2. 	 A _________processes words.
a)	 Word processor 

b)	 Spreadsheet Package

c)	 Powerpoint

d)	 Textprocessor
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NOTES 3. 	 ________is a software function describing the production of multiple (and 
potentially large numbers of) documents from a single template form and a 
structured data source.
a)	 Header

b)	 Footer

c)	 Mail merge

d)	 Merger

4. 	 A ______ is a small software program.
a)	 Debugger

b)	 Scroller

c)	 Hard drive

d)	 Macro 

5. 	 A _______is a special type of document that determines the basic layout of a 
document.
a)	 Document 

b)	 Template 

c)	 Heading

d)	 Mail Merge

6. 	 Use PowerPoint to create electronic _____ that can liven up even the most 
apathetic crowd. 
a)	 Slides 

b)	 Pages

c)	 Spreadsheets

d)	 Documents

7. 	 _______lets you work with slides one at a time.
a)	 Book view

b)	 Bar Graph view

c)	 Print Layout view

d)	 Slide view

8. 	 PowerPoint includes sounds and video you can play during you______.
a)	 Slide views

b)	 Slide shows

c)	 Slide sorter

d)	 Slide optimization

9. 	 An Excel file is also referred as _____.
a)	 Workbook 
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NOTESb)	 Book

c)	 Document

d)	 Spreadsheet file

10. 	 The master slide includes a footer area.
a)	 First

b)	 Master

c)	 Document

d)	 Last 

sssss
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NOTES5.1 LEARNING OBJECTIVE

After completing this chapter, you will be able to:
•	 Understand the working of Excel.

•	 Understand various Functions of MS Excel.

•	 Learn and understand about Multimedia.

5.2 INTRODUCTION

Microsoft Excel  is a spreadsheet program used to record and analyze numerical and 
statistical data. Microsoft Excel provides multiple features to perform various operations 
like calculations, pivot tables, graph tools, macro programming, etc. It is compatible with 
multiple OS like Windows, mac OS, Android and iOS.

An Excel spreadsheet can be understood as a collection of columns and rows that form 
a table. Alphabetical letters are usually assigned to columns, and numbers are usually 
assigned to rows. The point where a column and a row meet is called a cell. The address 
of a cell is given by the letter representing the column and the number representing a row.

5.3 EXCEL WORKING

How to Use Excel
To use Excel, you only need to input the data into the rows and columns. And then you’ll 
use formulas and functions to turn that data into insights. 

We’re going to go over the best formulas and functions you need to know. But first, let’s 
take a look at the types of documents you can create using the software. That way, you have 
an overarching understanding of how you can use Excel in your day-to-day. 

Documents You Can Create in Excel
Not sure how you can actually use Excel in your team? Here is a list of documents you can 
create:

•	 Income Statements: You can use an Excel spreadsheet to track a company’s sales 
activity and financial health.

•	 Balance Sheets: Balance sheets are among the most common types of documents 
you can create with Excel. It allows you to get a holistic view of a company’s 
financial standing.

•	 Calendar: You can easily create a spreadsheet monthly calendar to track events or 
other date-sensitive information.

Here are some documents you can create specifically for marketers.
•	 Marketing Budgets: Excel is a strong budget-keeping tool. You can create and 

track marketing budgets, as well as spend, using Excel.
ADVANCED EXCEL 
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NOTES •	 Marketing Reports: If you don’t use a marketing tool such as Marketing Hub, 
you might find yourself in need of a dashboard with all of your reports. Excel is an 
excellent tool to create marketing reports.

•	 Editorial Calendars: You can create editorial calendars in Excel. The tab format 
makes it extremely easy to track your content creation efforts for custom time 
ranges. 

•	 Traffic and Leads Calculator: Because of its strong computational powers, Excel 
is an excellent tool to create all sorts of calculators — including one for tracking 
leads and traffic

•	 This is only a small sampling of the types of marketing and business documents 
you can create in Excel. 

5.4 FUNCTIONS IN EXCEL

Financial Functions
FV: Future value is one of the most important concepts in finance. Luckily, once you learn 
a few tricks, you can calculate it easily using Microsoft Excel or a financial calculator.

Let’s look at an example to illustrate the process.
Assume you are trying save up enough money to buy a car at the end of six months. You 
already have $10,000 in an account that pays 5% interest per year. You can add $1,000 to 
the account at the end of each month. How much will you have to spend on a car at the 
end of six months?

How to Calculate Future Value Using Excel
•	 The process will be easiest if you use the spreadsheet as a table to keep track of the 

different variables and periods you’ll need for your calculation. First, label the cells 
in column A as follows:
Al = the time period — in this case, Al = Months

A2 = Periodic Rate

A3 = Payment Amount

A4 = Present Value (PV)

A5 = Future Value (FV)

•	 Next, fill in the information for the cells in each row.
Bl-Hl = Months 0-6

B2-H2 = 0.417% (to calculate the periodic rate, take the annual rate from the example 
and divide by the number of periods per year. Using our example, Periodic Rate = 
5.0% / 12 = 0.417%)

C3-H3 =-$1,000
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Note that because we’re not making a payment today (at time 0), we don’t put 
anything in cell B3. Also note that we’ve decide to make the amount negative because 
the $1,000 payments are coming out of our wallets and going into the bank’s account. 
They are cash outflows relative to you, the investor. We use the same idea for the 
present value of the money we’ve already set aside.

Your Excel spreadsheet should now look like this:

A B C D E F • i G H
1 i Month 0 1 2 3 4 5 6

2 Periodic Rate 0.417% 0.417% 0.417% 0.417% 0.417% 0.417% 0.417%

3 Payment 
Amount

0 -1,000 -1,000 -1,000 -1,000 -1,000 -1,000

4 Present Value -10,000

5 : Future 
Value

		
	

•	 Now that we have our table, we are ready to calculate FV. First, select the cell at B5.

•	 Next, click on the function button (fx) which is located right above the column 
labels. Once you click fx, a box will pop up.

•	 Select the “Financial” category from the drop down menu and choose the FV 
function from the list. Then click “OK.”

•	 A new box will come up asking you to type in the amounts for each variable 
given. Use your table to help you fill in the boxes — you’re being asked for all 
the information you already used to create your table. Once you have entered the 
amounts, the solution to FV will automatically appear in the bottom left corner of 
the box and be labeled “Formula result.”

When you click “OK” to accept the solution, it will be displayed in the cell you selected 
next to future Value. Your Excel spreadsheet should now look like this with this correct 
solution for 
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NOTES PV: The PV (Present Value) function in Excel 2013 is found on the Financial button’s 
dropdown menu on the Ribbon’s Formulas tab (Alt+MI). The PV function returns the 
present value of an investment, which is the total amount that a series of future payments 
is worth presently.

The syntax of the PV function is as follows:
= PV (rate, nper, pmt, [fv], [type])

The FV and type arguments are optional arguments in the function (indicated by the 
square brackets). The FV argument is the future value or cash balance that you want to 
have after making your last payment. If you omit the FV argument, Excel assumes a future 
value of zero (0).

The type argument indicates whether the payment is made at the beginning or end of the 
period: Enter 0 (or omit the type argument)’ when the payment is made at the end of the 
period, and use 1 when it is made at the beginning of the period.

The figure contains several examples using the PV function. All three PV functions use the 
same annual percentage rate of 1.25 per cent and term of 10 years. Because payments are 
made monthly, each function converts these annual figures into monthly ones.

For example, in the PV function in cell E3, the annual interest rate in cell A3 is converted 
into a monthly rate by dividing by 12 (A3/12). The annual term in cell B3 is converted 
into equivalent anthly periods by multiplying by 12 (B3 x 12).

Note that although the PV functions in cells E3 and E5 use the rate, nper, and pmt 
($218.46) arguments, their results are slightly different.

This is caused by the difference in the type argument in the two functions: the PV function 
in cell E3 assumes that each payment is made at the end of the period (the type argument 
is 0 whenever it is omitted), whereas the PV function in cell E5 assumes that each payment 
is made at the beginning of the period (indicated by a type argument of 1).

When the payment is made at the beginning of the period, the present value of this 
investment is $0.89 higher than when the payment is made at the end of the period, 
reflecting the interest accrued during the last period.

The third example in cell E7 uses the PV function with an FV argument instead of the pmt 
argument. In this example, the PV function states that you would have to make monthly 
payments of $7,060.43 for a 10-year period to realize a cash balance of $8,000, assuming 
that the investment returned a constant annual interest rate of 1 1/4 per cent.

Note that when you use the PV function with the FV argument instead of the pmt 
argument, you must still indicate the position of the pmt argument in the function with a 
comma (thus the two commas in a row in the function) so that Excel doesn’t mistake your 
FV argument for the pmt argument.
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NOTESPMT: The PMT function, one of Excel’s financial functions, can be used to calculate the 
payments for a loan or the future value of an investment.

The syntax for the PMT function is:

= PMT (rate, nper, pv, fv, type)

rate: the annual interest rate for the loan.

PPMT
This article describes the formula syntax and usage of the PPMT function in Microsoft 
Excel.

Description
Returns the payment on the principal for a given period for an investment based on 
periodic, constant payments and a constant interest rate.

Syntax
PPMT (rate, per, nper, pv, [fv], [type])

Note For a more complete description of the arguments in PPMT, see PV.

The PPMT function syntax has the following arguments:

•	 Rate: The interest rate per period.

•	 Per: Required. Specifies the period and must be in the range 1 to nper.

•	 Nper: Required. The total number of payment periods in an annuity.

•	 Pv: Required. The present value — the total amount that a series of future payments 
is worth now.

•	 Fv: Optional. The future value, or a cash balance you want to attain after the last 
payment is made. If fv is omitted, it is assumed to be 0 (zero), that is, the future 
value of a loan is 0.

•	 Type: Optional. The number 0 or I and indicates when payments are due.

IPMT

Description
The Microsoft Excel IPMT function returns the interest payment for an investment based 
on an interest rate and a constant payment schedule.

Syntax
The syntax for the Microsoft Excel IPMT function is:

IPMT(interest rate, period, number_payments, PV, [FV], [Type])NPER
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NOTES Description
The Microsoft Excel NPER function returns the number of periods for an investment 
based on an interest rate and a constant payment schedule.

Syntax
The syntax for the Microsoft Excel NPER function is:

NPER (interest rate, payment, PV, [FV], [Type])

RATE:

Description
The Microsoft Excel RATE function returns the interest rate for an annuity.

Syntax
The syntax for the Microsoft Excel RATE function is:

RATE (number payments, payment, PV, [FV], [Type], [Estimate] )

Parameters or Arguments
number payments is the number of payments for the annuity.

payment is the amount of the payment made each period.

PV is the present value.

FV is optional. It is the future value. If this parameter is omitted, the RATE function 
assumes a FV value of 0.

Type is optional. It indicates when the payments are due. Type can be one of the follow-
ing values:

Value Explanation

0 Payments are due at the end of the period, (default)

1 Payments are due at the beginning of the period.

If the Type parameter is omitted, the RATE function assumes a Type value of 0. Estimate 
is optional. It is your guess at what the rate will be. If this parameter is omitted, the RATE 
function assumes an Estimate of 10%.

NPV

Description
The Microsoft Excel NPV function returns the net present value of an investment.

Syntax
The syntax for the Microsoft Excel NPV function is:

NPV (discount rate, value I, [value2, ... value n) 
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•	 Discount rate is the discount rate for the period.

•	 Value I, value2, ... value n are the future payments and income for the investment 
(ie: cash flows). 

Note
Microsoft Excel’s NPV function does not account for the initial cash outlay, or may account 
for it improperly depending on the version of Excel. However, there is a workaround.

This workaround requires that you NOT include the initial investment in the future 
payments/income for the investment (i.e.: value 1, value2, ... value n), but instead, you 
need to subtract from the result of the NPV function, the amount of the initial investment.

The workaround formula is also different depending on whether the cash flows occur at 
the end of the period (EOP) or at the beginning of the period (BOP).

If the cash flows occur at the end of the period (EOP), you would use the following 
formula:

= NPV( discount rate, value 1, value2, ... value n ) - Initial Investment

If the cash flows occur at the beginning of the period (BOP), you would use the following 

formula:

= NPV (discount rate, value2, ... value n ) - Initial Investment + value 1

IRR
Internal rate of return (IRR) that is also known as the discounted cash flow rate of return 
(DCFROR), is commonly used to evaluate the profitability of an investment. For folks 
who like to sign up for an investment plan, endowment plan and wealth accumulation 
plan to enhance their wealth management and diversification certainly would like to know 
the internal rate of return. Normally, the IRR is not mentioned in the plan, but can be 
easily calculated with Microsoft Office Excel application. With Microsoft Excel, you can 
calculate IRR yourself to avoid any misleading cases due to dishonest financial planner and 
agent.

For example, an investment plan requires you to invest $6,000 annually for 10 years, and 
$1,000 cash is returned as rebate from year 2 to year 10, followed by $2,500 yearly cash 
rebate from year 11 - 19. For final year (20) which is when the plan is terminated, you can 
get back another one lump sum of $80,000. So, what’s the internal rate of return?

Formula to use in Excel is IRR (values, guess).

Note: guess is a number that you guess is close to the result of IRR; Excel will use the 
default value of 0.1 (10%) if omitted. It’s normally no need to enter a guess value for the 
IRR calculation.
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NOTES Formula = IRR (A1:A2O) = 0.053 = 5.3%

The real effective interest rate of the plan A is 5.3% per year!

CHECK YOUR PROGRESS

1. 	 Explain Rate Function.
2. 	 Explain NPV Function.
3. 	 Explain IRR Function.
4. 	 Explain Working of Excel.
5. 	 Discuss IPMT function in Excel.

DATABASE FUNCTIONS

VLOOKUP:

Description
The VLOOKUP function performs a vertical lookup by searching for a value in the left-
most column of table array and returning the value in the same row in the index number 
position.

Syntax
The syntax for the Microsoft Excel VLOOKUP function is:

VLOOKUP (value, table array, index number, ^not exact match))

Parameters or Arguments
•	 Value is the value to search for in the first column of the table array.

•	 Table array is two or more columns of data that is sorted in ascending order.index 
number is the column number in table array from which the matching value must 
be returned. The first column is 1.

•	 Not exact match is optional. It determines if you are looking for an exact 
match based on value. Enter false to find an exact match. Enter true to find an 
approximate match, which means that if an exact match if not found, then the 
vlookup function will look for the next largest value that is less than value. If this 
parameter is omitted, the VLOOKUP function returns an approximate match.

Note
•	 If index number is less than 1, the VLOOKUP function will return #VALUE!.

•	 If index number is greater than the number of columns in table array, the 
VLOOKUP function will return #REF!.

•	 If you specify FALSE for the not exact match parameter and no exact match is 
found, then the VLOOKUP function will return #N/A.

HLOOKUP
The Microsoft Excel HLOOKUP function performs a horizontal lookup by searching for 
a value in the top row of table array and returning the value in the same column based on 
the index number.
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NOTESSyntax
The syntax for the Microsoft Excel HLOOKUP function is:

HLOOKUP (value, table array, index number, [not_exact_match])

Parameters or Arguments
•	 Value is the value to search for in the first row of the table array.

•	 Table array is two or more rows of data that is sorted in ascending order.

•	 Index number is the row number in table array from which the matching value 
must be returned. 

The first row is 1.
•	 Not exact match is optional. It determines if you are looking for an exact match 

based on value. 

•	 Enter false to find an exact match. Enter true to find an approximate match, which 
means that 

•	 If an exact match if not found, then the hlookup function will look for the next 
largest value 

•	 That is less than value. If this parameter is omitted, HLOOKUP will return an 
approximate match.

Note
•	 If index number is less than 1, the HLOOKUP function will return #VALUE!

•	 If index number is greater than the number of columns in table array, the 
HLOOKUP function will return #REF!

•	 If you enter FALSE for the not exact match parameter and no exact match is 
found, then the HLOOKUP function will return #N/A.

Conditional Logic Functions

IF

Description
The Microsoft Excel IF function returns one value if a specified condition evaluates to 
TRUE, or another value if it evaluates to FALSE.

Syntax
The syntax for the Microsoft Excel IF function is:

IF(condition, [value_if_true], [value if ’false])

Parameters or Arguments
•	 Condition is the value that you want to test.

•	 Value if true is optional. It is the value that is returned if condition evaluates to 
true.

•	 Value if false is optional. It is the value that is return if condition evaluates to false.
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Description
The Microsoft Excel COUNTIF function counts the number of cells in a range, that 
meets a given criterion. If you wish to apply multiple criteria, try using the COUNTIES 
function.

Syntax
The syntax for the Microsoft Excel COUNTIF function is:

COUNTIF (range, criteria)

Parameters or Arguments
•	 Range is the range of cells that you want to count based on the criteria.

•	 Criteria are used to determine which cells to count.

SUMIF

Description
The Microsoft Excel SUMIFS function adds all numbers in a range of cells, based on a 
single or multiple criteria.

Syntax
The syntax for the Microsoft Excel SUMIFS function is:

SUMIF (sum range, criteria range 1, criterial, [criteria _range2, criteria2, ... criteria range 
n, criteria nl)

Parameters or Arguments
•	 Sum range is the cells to sum.

•	 Criteria range 1 is the range of cells that you want to apply criterial against.

•	 Criterial is used to determine which cells to add. criterial is applied against criteria 
range 1.
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Goal Seeks
If you know the result that you want from a formula, but are not sure what input value 
the formula needs to get that result, use the Goal Seek feature. For example, suppose that 
you need to borrow some money. You know how much money you want, how long you 
want to take to pay off the loan, and how much you can afford to pay each month. You 
can use Goal Seek to determine what interest rate you will need to secure in order to meet 
your loan goal.

Note: Goal Seek works only with one variable input value. If you want to accept more than 
one input value; for example, both the loan amount and the monthly payment amount for 
a loan, you use the Solver add-in. For more information about the Solver add-in, follow 
the links in the See Also section.

Step-by-step with an example
Let’s look at the preceding example, step-by-step.

Because you want to calculate the loan interest rate needed to meet your goal, you use 
the PMT function. The PMT function calculates a monthly payment amount. In this 
example, the monthly payment amount is the goal that you seek.

Prepare the worksheet
•	 Open a new, blank worksheet.

•	 First, add some labels in the first column to make it easier to read the worksheet.

•	 In cell Al, type Loan Amount.

•	 In cell A2, type Term in Months.

•	 In cell A3, type Interest Rate.

•	 In cell A4, type Payment.

•	 Next, add the values that you know.

•	 In cell Bl, type 100000. This is the amount that you want to borrow.

•	 In cell B2, type 180. This is the number of months that you want to pay off the 
loan.

Note: Although you know the payment amount that you want, you do not enter it as a 
value, because the payment amount is a result of the formula. Instead, you add the formula 
to the worksheet and specify the payment value at a later step, when you use Goal Seek.

•	 Next, add the formula for which you have a goal. For the example, use the PMT 
function:

•	 In cell B4, type = PMT(B3/12,B2,B1). This formula calculates the payment 
amount. In this example, you want to pay $900 each month. You don’t enter that 
amount here, because you want to use Goal Seek to determine the interest rate, 
and Goal Seek requires that you start with a formula.
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NOTES The formula refers to cells B1 and B2, which contain values that you specified in preceding 
steps. The formula also refers to cell B3, which is where you will specify that Goal Seek put 
the interest rate.The formula divides the value in B3 by 12 because you specified a monthly 
payment, and the PMT function assumes an annual interest rate.

Because there is no value in cell B3, Excel assumes a 0% interest rate and, using the values 
in the example, returns a payment of $555.56. You can ignore that value for now.

For more information about the PMT function, see the See Also section.

Use Goal Seek to determine the interest rate
•	 On the Data tab, in the Data Tools group, click What-If Analysis, and then click 

Goal Seek.

•	 In the Set cell box, enter the reference for the cell that contains the formula that 
you want to resolve. In the example, this reference is cell B4.

•	 In the To value box, type the formula result that you want. In the example, this is 
-900. Note that this number is negative because it represents a payment.

•	 In the By changing cell box, enter the reference for the cell that contains the value 
that you want to adjust. In the example, this reference is cell B3.

Note: The cell that Goal Seek changes must be referenced by the formula in the cell that 
you specified in the Set cell box.

•	 Click OK.

Goal Seek runs and produces a result, as shown in the following illustration.

The value in cell 04 is the result of the 
formula =PMT(03/12,02,01).

A 8

1 Loan Amount $ 100,000
2 Term in Months 180

3 Interest Rate 7.02%’i

4 Payment -- ($900.00)

Goal seeks to determine the interest rate in cell B3 based on the payment in cell 04.

•	 Finally, format the target cell (B3) so that it displays the result as a percentage.

•	 On the Home tab, in the Number group, click Percentage.

•	 Click Increase Decimal or Decrease Decimal to set the number of decimal places.

Solver
The Solver is an add-in for Microsoft Excel which is used for the optimization and 
simulation of business and engineering models. It solves complex linear and non linear 
problems and can also be used in conjunction with VBA to automate tasks.ADVANCED EXCEL 
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NOTESHow To Enable The Solver Add-in
The add-in is included by default in MS Excel but kept disabled. In order to enable it, 
click the File Menu and choose Options. Now, in the Excel Options dialogue box, select 
Add-Ins from the left sidebar and then hit the GO button next to Manage Excel Add-ins 
at the bottom. What you have to do now is check the Solver Add-in option and hit OK 
to enable it.

How To Access The Solver Add-in

Solver is located under the Data tab as shown in the screenshot below.
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NOTES How To Use Solver
Once you click the Solver option, it loads the dialogue box as shown below. Here you 
specify the parameters to run the solver.  

These parameters will vary depending upon your problem, but let’s see what are the most 
common and mandatory parameters and how they work so that you can utilize the solver 
in your daily life problems when needed. Followings are the three main parts of the solver 
which you should understand before applying the solver.

Target Cell
The target cell is the cell which will represent the objective or goal. Lets suppose a scenario 
in which the production manager of a firm would presumably want to maximize the 
profitability of the Product during each month. The cell that measures profitability would 
be the target cell.

Changing Cells
Changing cells are those cells that can change or adjust to optimize the target cell. The 
production manager can adjust the amount produced for each product during a month. 
The cells in which these amounts are recorded are the changing cells.

Constraints
Constraints are restrictions/limitations that you apply on the changing cells. For example 
in the above scenario, the product manager can’t use more of any available resource (for 
example, raw material and labour) than the amount of the available resource.

That’s it, specify all of the above mentioned parameters as per your spreadsheet. Set 
Objectives represents the target cell, By changing Variable Cells represents the Changing 
cells and you can add the constraint by hitting the Add button.
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Once done with the entire configuration, hit the Solve button to run the solver on your 
Excel spreadsheet.

Creating Simple Macros
With Excel VBA you can automate tasks in Excel by writing so called macros. In this 
chapter, learn how to create a simple macro which will be executed after clicking on a 
command button. First, turn on the Developer tab.

Developer Tab
To turn on the Developer tab, execute the following steps.

•	 Right click anywhere on the ribbon, and then click Customize the Ribbon.

•	 Under Customize the Ribbon, on the right side of the dialog box, select Main tabs 
(if necessary).

•	 Check the Developer check box.

•	 Click OK.
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•	 You can find the Developer tab next to the View tab.

Command Button
To place a command button on your worksheet, execute the following steps.

•	 On the Developer tab, click Insert.

•	 In the ActiveX Controls group, click Command Button.

•	 Drag a command button on your worksheet.

Assign a Macro
To assign a macro (one or more code lines) to the command button, execute the following 
steps.

•	 Right click Command Button (make sure Design Mode is selected).
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•	 Place your cursor between Private Sub Command Buttonl_Click() and End Sub.

Microsoft Visual Basic for Applications - create-a-macro.xls - [Sheet l (Code)]

Note: the window on the left with the names Sheetl, Sheet2 and Sheet3 is called the Project 
Explorer. If the Project Explorer is not visible, click View, Project Explorer. To add the 
Code window for the first sheet, click Sheetl (Sheetl).

•	 Close the Visual Basic Editor. 

•	 Click the command button on the sheet (make sure Design Mode is deselected).

Result:

Congratulations. You’ve just created a macro in Excel!

5.5 MULTIMEDIA

Definition
In simple words, multimedia means multi (many) and media refers to communication/ 
transfer medium. Multimedia is any combination of text, graphics art, sound, animation 
and video elements delivered to you by your computer or any other electronic means. A 
computer s encyclopedia containing images, audio and video effects along with the content 
is a simple example of a multimedia application. Although the definition of multimedia 
is fairly simple, making it work can be quite complicated. You would need to understand 
the importance of each individual’s element and also have knowledge about the usage of 
multimedia tools and technologies, to weave the element of multimedia are a meaningful 
manner.

Human interactivity forms the core of any multimedia application. This includes response 
to the commands (clicking on buttons, icon, menu items etc.) dictated by the end user. This ADVANCED EXCEL 
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NOTES type of multimedia- where a user to controls what and when the elements are delivered-is 
referred to as Interactive Multimedia. When users are given navigational controls so that 
they are navigational control so that they can navigate from one element to another in a 
non-linear fashion, interactive multimedia becomes Hypermedia.

Importance of Multimedia
•	 Multimedia is characterized by an audio-visual interface, which provides an excellent 

medium for user interactivity. It improves information retention. (According to a 
research conducted by computer technology, people only retain 20% of what they 
see and 30% of what they hear. But they remember 50% of what they see and hear, 
and as much as 80% of what they see, hear, and do simultaneously.)

•	 Computer games are the most common application of multimedia. Other widely 
used application includes education CDs (CBT) and promotional information.

•	 Multimedia has also become an integral part of the internet. Webpages can contain 
animated images, videos and sound effects, in additional to text, to make them 
more appealing and interactive.

Multimedia Tools

Authoring Tools
The key to successful multimedia production is a seamless integration of multimedia 
element for graphic design, content management, production and packaging. The whole 
process of developing a multimedia package is called Authoring. An authoring system 
is a collection of software tools that help in various aspects of multimedia production. 
Multimedia elements are woven together using authoring tools. These tools are designed 
to manage individual multimedia element and provide user interaction. Multimedia 
authoring software can be used to make:
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NOTES•	 Video productions

•	 Animations

•	 Games

•	 Presentations

•	 Interactive kiosk applications

•	 Interactive training

•	 Simulations, prototypes and technical visualisation

Steps in multimedia production
Media capture: Multimedia authoring systems streamline data capture by providing 
interface to a range of images and data capture devices.

Media conversion: Images, audio clips, animation, sequences and video clips exit in a 
variety of formats. A well-equipped multimedia authoring system will include a set of 
utilities for converting between many of the commonly used formats.

Media editing: After data has been captured and converted to the native format of the 
authoring system, it may need some polishing before it is suitable for presentation. For 
instance, ‘noise ‘can be removed from audio clips, images can be touched up, and etc. 
Multimedia authoring system provides media-specific editors for these operations.

Media composition: The core of a multimedia authoring system includes a tool for 
combining media and specifying their spatial and temporal relationships.

Elements of Multimedia

Text
Text, containing words and symbols, is the most common form of communication. It 
is one of the popularly used mediums of appearance that is used to deliver information 
accurately and in detail. Usually text provides the core structure to the package. Words are 
vital elements of multimedia that can appear in the titles, menus, navigation aids and in 
the content of a multimedia application or project. It is most essential to use words that 
have the most precise and powerful meanings to express what you need to convey.

A major drawback of using text is that it is not user-friendly as compared to the other 
element of multimedia. For example: it is harder to read from a screen for long, as it tires 
the eyes more than w.-ding it in its print version.

Designing with text: from a design perspective, the choice of font size, style and other text 
attributes needs to be related both to the complexity of the message and to its venue.

Some useful tips for designing the text in your multimedia application:
•	 Use legible fonts that can be easily read.

•	 Vary the font size and style according to the importance of your message.
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•	 Indent your paragraphs wherever required.

•	 Explore the effects of different colours and shadows to add depth to your application.

•	 Use menus for easy navigation and meaningful words for menu item.

•	 Use buttons, icons or symbols for user interaction.

•	 You can also use stylish fonts for displaying attention- grabbing results.

Graphics
Pictures/graphics enhance the overall look of a multimedia package. Picture express more 
than normal texts are generally considered as the most important element of a multimedia 
application.

It is often noticed that a webpage containing numerous images taken longer to download 
than a simple text-based webpage. Images files are therefore compressed to save memory 
and disk space of your computer. GIF and PNG are examples of compressed image file 
format.

Pictures can be created using any of the following ways:
•	 You can use drawing tools like MS paint to create simple picture. Paint allows 

creating or assembling picture by drawing straight, ways or curved lines, using 
shapes like squares, circles and polygons, or simply by freehand drawing.

•	 You can insert images from the clipart gallery; a clipart collection typically contains 
a series of images for different categories. Clip art is available through CD-ROMs 
or from the internet.
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NOTES•	 You can use scanner or digital camera to capture original picture in digested from. 
You can also scan images, created using traditional methods like water colors, 
crayons etc.

•	 Do not overload your application with too many images. This would not only 
make your application look clumsy, but it would also consume excessive computer 
resources.

•	 Do not include heavy graphics.

•	 Use context-sensitive image.

Animation
Animation gives visual impact to your multimedia application. In simple terms, it can 
be defined as an entity moving across the screen. This entity could be a text object or an 
image. An animation consists of a series of rapidly changing objects, which when blended 
together gives an illusion of movement. The speed with which each object is replaced by 
the next one is so rapid that the eye perceives this as motion.

Sound
Sound is used to set the rhythm or a mood in a package. Speech gives an effect of a 
language for instance. Proper usages of sound can make all the different between ordinary 
multimedia presentations and professional one.

Creating sound: Sound can be recorded using microphone, a synthesizer, or any other 
medium like tape or cassette player and then be digested using audio digesting software. 
Therefore, sound may be digitized from any source - natural or pre-recorded. Digitized 
sounds are stored as wave (.WAV) file. These can be played using windows media player.

APPLICATION OF MULTIMEDIA

Multimedia in Education
As compared to traditional ‘stand and deliver’ teaching methodology, training imparted 
using animated, interactive and instrumental multimedia applications has proven to be 
more useful. Apart from making the subject interesting, it increases information retention 
and learning capacity of the users. The potential for students of all ages to author as part of 
a creative educational programme that focuses on achievement of goals and competencies 
rather than time served, will help educators to shift from teacher to facilitator and mentor. 
Some applications of multimedia in education are stated below.

•	 Computer encyclopedia has gained considerable popularity in recent years as they 
allow users a non-linear navigation of text; users can quickly access the desired 
topic.

ADVANCED EXCEL 
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NOTES •	 Multimedia-based presentation and tutorials provide an easy-to-learn environment 
for the young generations. Reading and retention skills grows when concept are 
explained using animated pictures. It can be a used as a homework helper or serve 
as a literature guide.

•	 Multimedia can be used for stimulating different types of environments used for 
training purposes.

•	 Multimedia can prove tremendously useful in the medical field. It gives an 
opportunity of in-depth, clear and interactive learning of new clinical advancement.

Multimedia in Entertainment
With the arrival of the CD-ROM and the internet, the entertainment industries made a 
huge leap into a new era with a winning car - multimedia. Armed with animated images, 
sounds, full-motion video and interactive capability, multimedia became a dominant 
factor in today’s information age. The fast but steady growth of electronic technology 
allowed multimedia to gain popularity within a short span of time. Some application of 
multimedia in the entertainment field is stated below:Games are the first things that come 
to mind when we talk about multimedia. Multimedia capabilities are used to develop 
interactive games with sophisticated animation, 3D and sound effect. These games can be 
played on the computer, mobile devices or on the internet.

•	 Another common application of multimedia is the advent of animated e-greeting 
card for different occasions.

•	 Wedding albums and family histories can be created on the World Wide Web 
using the power of multimedia.

•	 Multimedia has also found it’s applications in hotels, pubs, shopping malls, 
museums, cinema halls, where stand-alone terminals or kiosks are made available 
for guiding users.

•	 Printers are also usually attached so that users can walk away with a printed copy 
of the desired information.

Multimedia in Marketing
Advertising has become very prevalent in our daily surroundings, so for a product to stand 
apart, it is very essential to present in a dynamic, visually stimulating manner to grab 
attention of consumer. The business world is slowly rejecting run of the mill traditional 
methods and adopting solutions from the electronic era. Only companies with a nerve to 
radically change their marketing strategies for the new millennium will survive and be able 
to cater to the ever-changing customer’s mindset.

Application of multimedia in the marketing field includes:
•	 Presentation for launching the product of a company. Reaching the target audience 

with necessary technical services or products requires clear communications, stating 
the benefits and features, outlining its and any other products related details, all 
presented in a well- designed and interactive manner so that the users familiarize 
faster.
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NOTES•	 Multimedia to create interactive product catalogues, training tutorials, buyer 
guides, and information directories with adequate search and navigation facilities 
to guide the user easily trace the desired information. A buyer guides can list the 
nearby dealers, a comparison of the top brands, maps of the city and other helpful 
guest services.

•	 e-Mail advertising or placing banner ads on the Internet - an extremely cost-
effective method of launching a product, promoting an event or selling services. 
Effective use of multimedia in advertising can make potential clients sit up and 
make notice.

5.6 CHAPTER SUMMARY

Microsoft Excel  is a spreadsheet program used to record and analyze numerical and 
statistical data. Microsoft Excel provides multiple features to perform various operations 
like calculations, pivot tables, graph tools, macro programming, etc. It is compatible with 
multiple OS like Windows, mac OS, Android and iOS. 

Future value is one of the most important concepts in finance. Luckily, once you learn 
a few tricks, you can calculate it easily using Microsoft Excel or a financial calculator. 
In simple words, multimedia means multi (many) and media refers to communication/ 
transfer medium. Multimedia is any combination of text, graphics art, sound, animation 
and video elements delivered to you by your computer or any other electronic means. 
A computer s encyclopedia containing images, audio and video effects along with the 
content is a simple example of a multimedia application. As compared to traditional ‘stand 
and deliver’ teaching methodology, training imparted using animated, interactive and 
instrumental multimedia applications has proven to be more useful. Apart from making 
the subject interesting, it increases information retention and learning capacity of the users.

5.7 REVIEW QUESTIONS

SHORT ANSWER TYPE QUESTIONS

1.	 Explain in brief the various elements of multimedia.
2.	 Write short note on application of multimedia.
3.	 Discuss Hlookup and vlookup functions.
4.	 Discuss the Solver and Goal seek feature of MS EXCEL.
5.	 Explain the tools of multimedia.

LONG ANSWER TYPE QUESTIONS

1.	 Explain PMT function of MS Excel.
2.	 Explain the role of Multimedia in Entertainment and Marketing. 
3.	 Explain steps in multimedia production. 
4.	 Discuss various financial functions of MS-Excel.
5.	 Discuss various Data Analysis features of Excel. ADVANCED EXCEL 
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NOTES
5.8 MULTIPLE CHOICE QUESTIONS

1.	 ______ is a spreadsheet program used to record and analyze numerical and 
statistical data.
a)	 Microsoft Excel

b)	 Microsoft Office

c)	 Microsoft PowerPoint

d)	 Microsoft Spreadsheet

2. 	 ______value is one of the most important concepts in finance.
a)	 Money

b)	 Current

c)	 Next

d)	 Future

3. 	 The ______ function, one of Excel’s financial functions, can be used to 
calculate the payments for a loan or the future value of an investment.
a)	 PMT

b)	 NV

c)	 IPMT

d)	 FV

4. 	 Returns the payment on the principal for a given period for an investment 
based on periodic, constant payments and a constant interest rate.
a)	 PV

b)	 IPMT

c)	 FV

d)	 PPMT

5.	 _________ that is also known as the discounted cash flow rate of return 
(DCFROR), is commonly used to evaluate the profitability of an investment.
a)	 PMT

b)	 PV

c)	 IRR

d)	 IPR

6. 	 The _____ function performs a vertical lookup by searching for a value in the 
left-most column of table array and returning the value in the same row in the 
index number position.
a)	 VLOOKUP

b)	 HLOOKUP
ADVANCED EXCEL 
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NOTESc)	 VERTICAL

d)	 SEARCH

7. 	 The Microsoft Excel ___function returns one value if a specified condition 
evaluates to TRUE, or another value if it evaluates to FALSE.
a)	 IF

b)	 SUM

c)	 COUNTIF

d)	 COUNTSUM

8. 	 If you know the result that you want from a formula, but are not sure what 
input value the formula needs to get that result, use the _______ feature.
a)	 Document

b)	 Goal Seek

c)	 Seeker

d)	 Auditing

9. 	 Goal Seek works only with one ______input value.
a)	 Variable

b)	 Constant

c)	 Static

d)	 many

10. 	 An authoring system is a collection of _______ tools that help in various 
aspects of multimedia production 
a)	 Hardware

b)	 Software

c)	 Freeware 

d)	 Spyware 

sssss
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NOTEUNIT-I

Ques. No. Answer Ques. No. Answer 
1. a) 6. b)
2. b) 7. b)
3. c) 8. c)
4. d) 9. a)
5. a) 10. b)

UNIT-II

Ques. No. Answer Ques. No. Answer 
1. a) 6. c)
2. b) 7. b)
3. c) 8. d)
4. d) 9. a)
5. a) 10. b)

UNIT-III

Ques. No. Answer Ques. No. Answer 
1. b) 6. c)
2. a) 7. a)
3. c) 8. d)
4. b) 9. a)
5. d) 10. b)

UNIT-IV

Ques. No. Answer Ques. No. Answer 
1. c) 6. a)
2. a) 7. d)
3. c) 8. b)
4. d) 9. a)
5. b) 10. b)

UNIT-V

Ques. No. Answer Ques. No. Answer 
1. a) 6. a)
2. d) 7. a)
3. a) 8. b)
4. d) 9. a)
5. c) 10. b)

Answer Key
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